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1 Introduction
Enjeux du système de vérification de fibres 
à distance

En raison de la grande capacité de transmission inhérente aux réseaux de 
fibres optiques, l’arrêt d’un système peut être désastreux, que vous 
travailliez sur un réseau international en DWDM ou sur un réseau longue 
distance pour une entreprise locale. Grâce à un système de vérification de 
fibres à distance (RFTS), il est possible de surveiller la performance du 
réseau en temps réel. Lorsqu’un bris ou un défaut survient, le RFTS 
déclenche un signal d’alarme qui avise l’équipe de réparation. Munis de 
données de réparation précises, l’équipe peut être envoyée 
immédiatement à l’endroit exact du problème.

Les éléments suivants sont essentiels lors de la gestion d’un réseau de 
fibres et ils sont au coeur de la solution RFTS :

Qualité du service

La qualité du service est l’un des éléments principaux recherchés par vos 
clients lorsqu’ils choisissent un fournisseur de services. Un réseau de fibres 
constamment surveillé est un avantage concurrentiel clé pour vous.

Coût d’une perte de service

La fiabilité d’un réseau optique est critique en télécommunications. La 
perte de service est tellement onéreuse que, dans la plupart des cas, le 
rendement du capital investi pour un RFTS est obtenu dès le premier bris 
de câble.

Efficacité d’un personnel hautement qualifié

Étant donné que le nombre de personnes qualifiées disponibles pour 
maintenir un réseau de fibres est limité, l’augmentation de la capacité et 
de la productivité ne peut être obtenue qu’à l’aide d’un système de 
test automatisé.
Système de vérification de fibres à distance 1
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Demande d’augmentation de la largeur de bande

Le temps de remise en état d’un réseau est un élément primordial. 
Étant donné la prolifération des nouvelles technologies, Internet génère une 
demande de largeur de bande sans précédent. Puisque les montants investis 
pour chaque fibre sont de plus en plus élevés, les systèmes plus rapides 
présentent plus de risques que seul un RFTS peut vous aider à gérer.

Caractéristiques clés de FiberVisor
FiberVisor, le RFTS d’EXFO, est un système de vérification de fibres à 
distance robuste, composé de matériel, de logiciels, d’instruments de test 
sur fibre optique, et de protocoles de communication conçus pour 
répondre à vos besoins. Ce système a été soigneusement défini pour 
procurer la meilleure solution de surveillance possible répondant à vos 
exigences précises.

EXFO a déterminé les spécifications exigées pour l’obtention d’une bonne 
surveillance du système : la topologie du réseau, le type de surveillance 
requis (fibre active ou inactive), la disponibilité des moyens de 
communications aux endroits où les unités de test sont déployées 
(Ethernet, PSTN, X.25, etc.) et plusieurs postes de travail de supervision.

Les pages suivantes vous fourniront une liste des caractéristiques clés de 
FiberVisor. Pour plus de renseignements sur l’architecture et les notions de 
FiberVisor, voir Aperçu de FiberVisor et de ses notions à la page 9.

Détection et localisation rapides et précises 
des problèmes 

Les unités de vérification à distance (RTU) du FiberVisor surveillent les 
fibres critiques d’un réseau, détectent et localisent rapidement les 
événements optiques causés par une dégradation, des coupures de fibres, 
etc. Les événements sont décelés en comparant la trace actuelle avec la 
trace de référence. Si la perte par événement est supérieure aux seuils 
définis auparavant, une alarme est automatiquement générée. 
2 FiberVisor 2.2
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La distance optique jusqu’au défaut est par la suite coordonnée à l’aide de 
données géographiques afin que des équipes de réparation puissent être 
envoyées à l’endroit exact du problème.

Fiabilité du réseau

Grâce à FiberVisor, il est possible de détecter des problèmes avant même 
qu’ils ne surviennent. FiberVisor génère des statistiques complètes sur les 
câbles et les fibres à des fins d’entretien préventif. Cela vous permet de 
détecter une dégradation actuelle et des défauts mineurs avant qu’ils ne 
compromettent le taux d’erreur sur les bits du signal, même si les pertes 
du signal transmis sont inférieures aux seuils minimums définis pour une 
génération d’alarmes.

Test de fibres actives sans intrusion

FiberVisor permet d’effectuer des tests sans intrusion sur n’importe quel 
lien de fibres et de sauvegarder des registres de configurations de test dans 
une base de données pour référence ultérieure. Cette méthode est idéale 
pour tester la fibre active en utilisant la technique du multiplexage spectral 
(WDM). La méthode EXFO vous permet de tester toutes les fibres critiques 
d’un réseau.

Gestion des alarmes

Lorsqu’une alarme est générée, elle est automatiquement acheminée au 
serveur ou à la station centrale de surveillance, où elle est consignée dans 
une base de données, réacheminée aux différents systèmes et affichée 
précisément sur une carte.

➤ Les alarmes sont simultanément transmises aux téléavertisseurs 
(TAP), aux adresses de courriels (SMTP) ou aux moniteurs à l’aide de 
protocoles standard (SNMP).

➤ Les listes de distribution pour chaque alarme peuvent être spécifiées 
par l’utilisateur.
Système de vérification de fibres à distance 3
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➤ L’information complète sur les alarmes est sauvegardée dans une base 
de données du serveur central.

Solution de surveillance de systèmes 
de transmission

L’ajout d’instruments de mesures spectrales aux unités de vérification à 
distance (RTU) et à un RFTS permet une surveillance des systèmes de 
transmission plus complète. À l’aide d’un analyseur de spectre optique 
(OSA), les unités de vérification à distance peuvent facilement détecter un 
canal défectueux dans un système en DWDM.

Vous pouvez ainsi diagnostiquer les causes possibles du problème, telles 
que la dérive en longueur d’onde du canal, la puissance du pic et le 
rapport signal sur bruit. Par la suite, vous pouvez immédiatement corriger 
le signal de transmission.

Surveillance spectrale : canaux en dérangement

En cas d’arrêt complet d’un canal en dérangement, un aperçu de l’état des 
autres canaux DWDM peut fournir de l’information essentielle au sujet de 
toute dégradation potentielle d’autres canaux. Celle-ci est souvent causée 
par le rapport d’équilibre des amplificateurs à fibres dopées à l’erbium 
(ils partagent leur puissance optique avec les canaux actifs).

Surveillance spectrale : entretien préventif

Les systèmes de transmission peuvent bénéficier d’une surveillance 
spectrale pour des besoins d’entretien préventif. Bien que les lasers à 
rétroaction répartie soient très stables en fonction du temps, ils sont 
considérés par la plupart des fournisseurs de systèmes comme étant le 
problème clé de la performance d’un système à moyen terme (un an).

Compte tenu de l’étroitesse de la largeur de bande des canaux 
(0,1 à 0,2 nm) dans la plupart des systèmes avancés actuels, il s’agit d’un 
défi considérable que de conserver la même région spectrale pendant 
toute la durée de vie d’un système.
4 FiberVisor 2.2



Introduction
Caractéristiques clés de FiberVisor

A
p

er
çu
Grâce à son excellente exactitude en longueur d’onde 
(0,005 nm ±0,05 nm), l’analyseur de spectre optique intégré (OSA) est 
l’instrument idéal pour accomplir des mesures de dérive à long terme sur 
des lasers à rétroaction répartie et pour mettre en évidence des dérives 
potentielles en longueur d’onde.

Vue linéaire des liens optiques

Cette caractéristique vous procure une meilleure visualisation des liens 
optiques surveillés grâce à une corrélation entre les points de repère, les 
traces OTDR et les cartes du système d’information géographique (SIG). 
Pour plus de renseignements sur les liens optiques, voir Compréhension de 
la visualisation d’un lien optique à la page 52.

Test complet sur demande

Vous pouvez accomplir des tests sur demande sur des fibres optiques en 
utilisant un OTDR et un OSA depuis le contrôleur du système de test (TSC) 
ou directement à partir du centre de gestion du réseau (OSS). Pour plus de 
renseignements sur les tests sur demande, voir Test sur demande à la 
page 90.

Requêtes rapides et faciles

Des requêtes SQL et des assistants complets sont disponibles pour 
effectuer une recherche dans des bases de données. Pour plus de 
renseignements sur les requêtes, consulter la section Recherche 
d’éléments par des requêtes à la page 76.

Protocoles supportés

FiberVisor supporte l’interface SNMP v3 avec l’OSS.
Système de vérification de fibres à distance 5
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Utilisation du manuel d’instructions
Le manuel d’instructions de FiberVisor est conçu pour aider tous les 
utilisateurs à tirer le meilleur parti du système. Il contient toute 
l’information dont vous avez besoin concernant les composants du 
système et la façon de les utiliser.

Le manuel d’instructions de FiberVisor est divisé comme suit :

➤ Les sections 1 et 2 fournissent de l’information de référence sur le 
système FiberVisor, incluant les notions sur le RFTS et le SIG qui vous 
aideront à comprendre et à utiliser votre système.

➤ La section 3 fournit des détails afin que vous soyez apte à travailler 
avec FiberVisor et ses composants. Cette section inclut les exigences 
et les instructions concernant le démarrage de l’unité du système avec 
laquelle vous travaillez.

➤ Les sections 4 à 8 présentent les fonctionnalités de base de FiberVisor 
spécifiques aux opérateurs de systèmes. Vous apprendrez comment 
recevoir et traiter des alarmes ainsi qu’explorer l’information 
présentée selon différents modes de visualisation du système.

➤ Les sections 9 à 11 présentent les fonctionnalités de FiberVisor 
spécifiques aux gestionnaires de systèmes. Vous apprendrez à 
configurer les éléments du réseau et à surveiller les opérations.

➤ Les sections 12 à 21 sont conçues pour les administrateurs de 
systèmes et décrivent en détail la gestion de la sécurité du réseau, 
le SIG, les éléments du réseau et l’acheminement des alarmes.

➤ La section 22 fournit l’information sur l’entretien et aide à identifier et 
à résoudre des problèmes pouvant survenir lors de l’utilisation 
de FiberVisor.

➤ La section 23 concerne l’information sur la garantie.

➤ L’annexe comprend la liste des types d’événements OTDR, 
pour référence.
6 FiberVisor 2.2
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Niveaux d’accès et fonctions restrictives
FiberVisor comprend trois niveaux d’accès : opérateurs, gestionnaires et 
administrateurs. Lorsqu’une section du manuel est destinée à des 
utilisateurs particuliers, elle est clairement identifiée à l’aide d’onglets 
situés sur le côté des pages. Vous pouvez également utiliser ces onglets 
pour passer rapidement d’une section spécifique du manuel à une autre.

Certaines fonctions de FiberVisor présentent un accès limité. Voir le tableau 
ci-dessous pour les opérations permises ou interdites, selon le niveau d’accès.

Nota : Si une session a été ouverte à l’aide d’un compte administrateur RFTS_ADMIN, 
il est possible d’accomplir TOUTES les opérations mentionnées ci-dessous.

Opérations Compte opérateur Compte gestionnaire

Désactiver un RTU Non Selon le RTU

Contrôler un RTU à distance Non Selon le RTU

Évaluer un test de 
communication

Selon le RTU Selon le RTU

Visualiser l’activité d’un RTU Selon le RTU Oui

Configurer la sécurité du réseau Non Non

Répartir la configuration à un 
nouveau RTU

Non Selon le RTU

Configurer un nouveau RTU Non Selon le RTU

Accomplir un test sur demande Selon le RTU Selon le RTU

Accuser réception d’une alarme Selon le RTU Selon le RTU

Archiver une alarme Non Selon le RTU

Gérer un réseau de fibres 
(géomatique)

Non Non
Système de vérification de fibres à distance 7
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Conventions de sécurité
Les symboles suivants sont utilisés dans le présent manuel. S’assurer de bien 
comprendre leur signification avant d’utiliser FiberVisor et ses composants.

AVERTISSEMENT
Met l’utilisateur en garde contre un danger inhérent à 
l’utilisateur lui-même. Le fait d’ignorer les conseils qui 
s’y rattachent peut occasionner des dommages 
corporels ou des blessures. Avant de passer aux 
étapes suivantes, s’assurer de bien comprendre les 
consignes et de bien suivre les recommandations qui 
se trouvent sous le titre AVERTISSEMENT.

ATTENTION
Met l’utilisateur en garde contre un danger inhérent à 
l’appareil. Le fait d’ignorer les conseils qui s’y rattachent 
peut occasionner des dommages à l’appareil ou même 
sa destruction. Avant de passer aux étapes suivantes, 
s’assurer de comprendre et de suivre les consignes qui 
se trouvent sous le titre ATTENTION.

IMPORTANT
Met en évidence certains renseignements concernant 
l’utilisation de l’appareil.
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2 Aperçu de FiberVisor et de 
ses notions
Aperçu de RFTS FiberVisor

Un système de surveillance de fibres à distance (RFTS) est un système de 
vérification installé en permanence qui utilise des commutateurs optiques 
pour brancher des équipements de test à un réseau. FiberVisor, le RFTS 
d’EXFO, comprend un logiciel spécifique, des données cartographiques et 
des capacités de contrôle à distance pour créer un système qui surveille 
constamment les problèmes et qui facilite leur résolution.

Le diagramme fonctionnel suivant illustre l’architecture d’un système RFTS :

RTU (unité de vérification 
à distance)

LAN/WAN

SGBD

ONC (contrôleur du réseau optique)
poste de travail Windows NT

TSC (contrôleur du système de test)
serveurs Windows NT

RTU (unité de 
vérification à distance)

IQ-203/IQ-206

Commutateur à 
distance
Système de vérification de fibres à distance 9
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Unités de vérification à distance (RTU)

Les unités de vérification à distance (RTU) sont déployées à des endroits 
stratégiques sur le terrain pour surveiller les fibres optiques critiques du 
réseau. Ces unités sont basées sur le système optique de test IQ-200 et 
comprennent habituellement des réflectomètres (OTDR) avancés ainsi 
que des commutateurs optiques pour maximiser l’utilisation des OTDR.

Chaque fibre branchée à un port du commutateur optique est surveillée en 
continu ou selon un horaire établi. FiberVisor compare les acquisitions de 
réflectométrie avec les réponses standard de réflectométrie, également 
appelées traces de référence.

L’utilisateur détermine plusieurs limites ou seuils pour chaque fibre 
surveillée. Si une acquisition de réflectométrie excède les seuils, 
FiberVisor génère automatiquement une alarme.

Contrôleur du système de test (TSC)

Les RTU déployés stratégiquement se rapportent à un serveur central 
appelé contrôleur du système de test (TSC). Toute l’information envoyée 
par les RTU (statistiques, traces de référence, alarmes, information 
cartographique, etc.) est sauvegardée dans des bases de données 
relationnelles pour le traitement et pour des requêtes SQL de tout type. 
Le TSC gère également toutes les communications entre les RTU et les 
utilisateurs à distance répartis sur le terrain.

Contrôleur du réseau optique (ONC)

Un poste de travail du contrôleur du réseau optique (ONC) est utilisé pour 
contrôler globalement le réseau, configurer les RTU et visualiser l’état du 
réseau à l’aide d’une interface graphique (GUI) conviviale et intuitive. Il est 
également utilisé pour effectuer une surveillance à distance complète des 
RTU et accomplir des tests sur demande avec un des modules optiques 
localisés à un endroit éloigné.
10 FiberVisor 2.2
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Logiciel FiberVisor

Le logiciel FiberVisor a été conçu avec une architecture client/serveur 
compatible avec les normes du réseau de gestion des 
télécommunications. Ses bases de données relationnelles ainsi que son 
système d’information géographique (SIG) intègrent et synchronisent 
facilement vos systèmes existants.

Compréhension des notions RFTS

Fibres inactives et actives

Il est possible de tester des fibres inactives et actives. Une fibre inactive est 
une fibre de rechange qui n’est pas utilisée pour la transmission, tandis 
qu’une fibre active est couramment utilisée pour la transmission.

OTDR

Le réflectomètre (OTDR) est un appareil de mesure qui vous permet 
d’identifier les défauts et les événements, tels que les connecteurs ou les 
épissures. Pour plus de renseignements sur les événements de 
réflectométrie, voir Description des types d’événements OTDR à la 
page 239.

Tx

Coupleur

OTDR SW

IQ-200

Câbles et fibres

Rx

Filtre

λ1

λ1+λ2

λ1

λ2
λ2

Test d’une fibre inactive

Test d’une fibre active

λ1

λ1+λ2
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Analyseur de spectre optique (OSA)

L’analyseur de spectre optique (OSA) divise un signal d’ondes lumineuses 
en ses longueurs d’onde constituantes, permettant à l’utilisateur de 
visualiser le profil du spectre du signal sur une plage de longueurs d’onde 
spécifique. L’OSA mesure et surveille également les paramètres dans le 
système DWDM afin de vérifier la stabilité du système. 

Commutateurs optiques

FiberVisor permet d’utiliser différent types de commutateurs. Le tableau 
suivant résume les types de commutateurs et leur localisation respective 
selon un RTU.

Puisqu’un commutateur interne est limité à 32 ports, le commutateur 
externe est utilisé pour augmenter la capacité de fibres dans un réseau en 
permettant de brancher jusqu’à 96 fibres.

Le commutateur à distance fonctionne de la même façon qu’un 
commutateur externe, sauf qu’il est éloigné physiquement du RTU, 
permettant ainsi de couvrir une région plus vaste.

Interne 
(dans le IQ-200)

Externe
(hors du IQ-200)

Commutateur local
(situé près d’un RTU)

Commutateur 
optique IQ-91xx

Commutateur optique GP700 
branché au RTU à l’aide de 

l’interface RS-232

Commutateur à 
distance WAN (IQ-200 
contrôlé par IP)

Commutateur 
optique IQ-91xx

Commutateur optique GP700 
branché au IQ-200 à l’aide de 

l’interface RS-232

Commutateur à 
distance RTPC 
(basé sur le GP700)

— Commutateur optique GP700 
branché au RTPC à l’aide 

d’un modem
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Câbles, chemins, points de mesure et 
liens optiques

➤ Un chemin RFTS est formé d’une ou de plusieurs fibres appartenant à 
différent câbles qui sont liées ensemble à l’aide d’un connecteur ou 
d’une épissure. Le chemin commence soit au port de sortie du module 
OTDR, soit à l’un des ports de sortie d’un commutateur branché au 
module OTDR.

➤ Un lien optique est une entité logique définissant des liens de 
communication entre des points dans un réseau. Cette entité est 
associée à plusieurs chemins et points de mesure qui caractérisent 
le lien.

Compréhension des notions du SIG
Le système d’information géographique (SIG) dépend de plusieurs éléments 
et aide à localiser et à gérer des alarmes. Le SIG est composé de différentes 
couches, chacune offre une application spécifique.

Les couches du SIG comprennent une variété de données, réparties en 
quatre catégories :

➤ Descriptive : caractéristiques d’une entité ou d’un rapport 
(ex. : noms des objets).

➤ Géographique : données sur la position ou le format des entités 
géographiques (ex. : position de segments de câbles).

➤ Vectorielle : données géographiques composées de groupes de 
vecteurs (ex. : points, lignes, polygones et texte).

➤ Rastrée : données géographiques qui constituent une image 
matricielle de pixels (ex. : photo prise par un satellite et utilisée en tant 
que couche de référence d’arrière-plan).

Pour plus de renseignements sur l’utilisation du SIG dans FiberVisor et sur 
sa configuration, voir Exploration du mode de visualisation géographique à 
la page 55 et Configuration du SIG à la page 171.
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3 Lancement de FiberVisor
Nota : La documentation de FiberVisor tient compte du fait que FiberVisor a été 

installé et configuré par le personnel qualifié d’EXFO, et que l’utilisateur est 
familier avec l’utilisation de Microsoft Windows.

Initialisation à l’aide du ONC
Le contrôleur du réseau optique (ONC) sert à gérer un réseau de fibres. 
Le ONC permet à l’utilisateur de configurer les unités de vérification à 
distance (RTU), de visualiser la carte géographique avec des données 
RFTS, de visualiser et de localiser des alarmes, d’analyser la performance 
d’un réseau et de surveiller à distance les RTU et les modules de test.

Tout ordinateur de bureau ou ordinateur portatif fonctionnant sous 
Microsoft Windows NT et comprenant le logiciel FiberVisor Console et les 
autres applications requises peut servir d’ONC.

Mise sous tension d’un ONC

Lors de la mise sous tension d’un poste de travail ONC, l’utilisateur doit 
suivre toute la procédure d’ouverture de session de Windows NT. Pour plus 
de renseignements, voir Gestion de la sécurité du réseau et des niveaux 
d’accès à la page 219.

Une fois que l’utilisateur a fourni l’information sur l’ouverture de session, le 
bureau Windows NT s’affiche.
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Lancement de FiberVisor Console

L’accès à FiberVisor Console dépend du profil de l’utilisateur de 
Windows NT et du nombre de licences disponibles du contrôleur du 
réseau optique, tel qu’il est expliqué ci-dessous :

➤ Profil de l’utilisateur NT : la sécurité de FiberVisor est totalement 
intégrée à celle de Windows NT. Le lancement de FiberVisor Console 
requiert seulement que l’utilisateur ouvre une session sur le ONC avec 
un compte faisant partie d’un groupe d’utilisateurs autorisés 
(RFTS_OPERATORS, RFTS_MANAGERS ou RFTS_ADMIN).

Pour plus de renseigements sur la sécurité, voir Gestion de la sécurité 
du réseau et des niveaux d’accès à la page 219.

➤ Licences ONC : le nombre de branchements simultanés du ONC au TSC 
est limité et contrôlé par une clé électronique Aladdin HASP. Il n’y a 
aucune limite au nombre de copies installées sur FiberVisor Console.

Pour plus de renseignements, voir Clés électroniques et gestion des 
licences EXFO à la page 224.

Pour lancer FiberVisor Console :

1. Depuis le menu Start de Windows, sélectionner Programs.

2. Depuis le sous-menu de FiberVisor, sélectionner FiberVisor Console.

L’utilisateur peut également cliquer deux fois sur l’icône FiberVisor située 
sur le bureau Windows. Lors du démarrage de FiberVisor Console, les 
situations suivantes peuvent se produire :

➤ L’utilisateur est invité à entrer l’adresse IP du TSC.

Cela est le cas lorsqu’un utilisateur lance pour la première fois FiberVisor 
Console. L’administrateur du réseau fournira l’adresse IP à l’utilisateur.

➤ L’utilisateur reçoit un message « Acces denied ».

L’utilisateur n’est pas autorisé à accéder à FiberVisor Console parce 
que son compte ne fait pas partie d’un groupe d’utilisateurs RFTS, tel 
que RFTS_OPERATORS.
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➤ Un utlisateur RFTS_ADMIN utilise déjà FiberVisor Console.

Puisque deux utilisateurs de ce groupe ne peuvent pas travailler sur 
FiberVisor Console simultanément, l’utilisateur se verra attribuer 
automatiquement un accès au groupe RFTS_MANAGERS. Pour plus de 
renseignements sur les opérations qu’il est possible d’accomplir en tant 
que gestionnaire, voir Niveaux d’accès et fonctions restrictives à la page 7.

Si une licence ONC est disponible et que l’utilisateur est branché à l’aide 
d’un profil d’utilisateur NT valide, la fenêtre principale de FiberVisor 
Console s’affiche.

Les menus changeront selon :

➤ les droits d’accès de l’utilisateur aux RTU

➤ le profil de l’utilisateur (administrateur, gestionnaire ou opérateur)

➤ le mode de visualisation affiché

➤ la source des données de câbles (propre à FiberVisor ou à un tiers)

Titre et barre de
menus

Barre d’outils

Barre d’état

Vue actuelle
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Visualisations possibles depuis FiberVisor Console

Trois modes de visualisation sont possibles depuis FiberVisor Console :

➤ Current Alarms : pour visualiser les alarmes actuelles et accomplir des 
opérations liées à ces alarmes. Pour plus de renseignements, voir 
Visualisation des alarmes actuelles sur un ONC à la page 33.

➤ Network Browser : pour visualiser la topologie du réseau, l’historique 
et des liens optiques et effectuer des opérations liées aux éléments du 
réseau. Pour plus de renseignements, voir Exploration des vues 
d’arborescence du réseau à la page 43.

➤ Geographical : pour visualiser et modifier le réseau de fibres ainsi que 
visualiser des événements de la région surveillée sur une carte 
géographique. Pour plus de renseignements, voir Exploration du mode 
de visualisation géographique à la page 55.

Pour afficher un de ces modes de visualisation :

➤ Appuyer sur l’icône  située à gauche dans la barre d’outils.

OU

➤ Sélectionner l’un des trois éléments disponibles dans le menu View.

Modes de visualisation
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Sortie de FiberVisor Console

Pour quitter FiberVisor Console, sélectionner Quit depuis le menu File. 
Si un fichier-contexte a été chargé, il sera possible de le sauvegarder avant 
de quitter FiberVisor Console.

Nota : Lorsque l’utilisateur quitte FiberVisor Console, la session d’utilisation de 
Windows NT demeure ouverte. Cela permet seulement de libérer une 
licence ONC pour qu’un autre utilisateur puisse lancer FiberVisor Console.

Mise hors tension du ONC

Puisqu’un ONC ne contient aucune donnée FiberVisor et n’accomplit 
aucune surveillance, il est possible de le mettre hors tension en tout 
temps, tout comme un PC régulier.

Initialisation d’un RTU
Chaque unité de vérification à distance (RTU) accomplit des opérations de 
surveillance sur une partie du réseau. Elle est également utilisée pour 
acquérir et sauvegarder des traces de référence et des statistiques.

Les RTU tournent sur Microsoft Windows et fonctionnent sur un système 
optique de test IQ-200. Pour plus de renseignements sur cette plateforme, 
se référer au manuel d’instructions du système optique de test IQ-200.

IMPORTANT
EXFO ne fournira aucun soutien technique si un logiciel ou du 
matériel d’un tiers est installé sur une unité de vérification à distance.

Mise sous tension et accès à un RTU

Un RTU est conçu pour accomplir plusieurs opérations en arrière-plan sans 
l’intervention d’un utilisateur. Une fois mis sous tension, le RTU cherche les 
composants installés et active des services en arrière-plan qui permettront 
la surveillance et le contrôle à distance.
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Lorsqu’il se branche à un RTU, l’utilisateur peut le configurer, visualiser des 
alarmes et des statistiques et acquérir manuellement des traces 
de référence.

IMPORTANT
Le RTU doit être sous tension afin d’effectuer une surveillance 
continue et de permettre un contrôle à distance, même si aucun 
utilisateur n’a ouvert de session.

Pour activer un RTU :

1. S’assurer que tous les modules de test (OTDR, OSA, commutateurs, 
etc.) soient correctement installés dans le RTU. Pour plus de 
renseignements sur l’installation de modules, se référer au manuel 
d’instructions qui correspond au module à installer.

2. Mettre sous tension l’unité de contrôle IQ-203 ainsi que toute unité 
d’expansion IQ-206 ou commutateur externe branché au RTU, dans le 
bon ordre, tel qu’il est expliqué dans le manuel d’instructions du 
système optique de test IQ-200.

Les composants et les applications de service démarrent et 
fonctionnent en arrière-plan tandis que la fenêtre sur l’information 
d’ouverture de session s’affiche.

État de surveillance actuel
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3. Taper le nom d’utilisateur (ouverture de session) et le mot de passe.

4. Sélectionner le type de validation du compte.

➤ Local : il peut être validé par le RTU. En choisissant cette option, il 
est impossible d’accéder aux ressources du réseau.

➤ TSC Validation : les comptes utilisateurs NT doivent être validés par 
le TSC. Sélectionner cette option pour accéder à toutes les 
ressources du réseau et obtenir tous les privilèges habituels 
du réseau.

5. Appuyer sur OK pour ouvrir une session d’un RTU et afficher le 
bureau Windows.

Nota : Deux utilisateurs ne peuvent pas se brancher simultanément à un RTU.

Pour plus de renseignements sur les niveaux d’accès et la sécurité du 
réseau, voir Gestion de la sécurité du réseau et des niveaux d’accès à la 
page 219.

Applications de démarrage d’un RTU

Lorsque l’utilisateur est branché à un RTU, il est possible d’accéder aux 
applications FiberVisor suivantes à partir du bureau Windows.

➤ Viewer : pour visualiser des données de surveillance, des statistiques 
et des alarmes en temps réel. Pour plus de renseignements, voir 
Visualisation de l’activité d’un RTU à la page 86.

➤ Alarm Viewer : pour visualiser des alarmes d’un RTU spécifique. Pour 
plus de renseignements, voir Visualisation des alarmes sur un RTU à la 
page 32.

➤ Configure : pour configurer le matériel, les tâches de surveillance et les 
seuils de test. Pour plus de renseignements, voir Configuration d’un 
RTU à la page 119.
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➤ View RTU Parameters : pour visualiser l’information complète du RTU 
sur les détails liés aux configurations locales, du serveur, de FiberVisor 
et du logiciel.

➤ Service Manager : pour contrôler FiberVisor Client, la surveillance de 
l’OTDR et de l’ondemètre multi-longueurs d’onde. Pour plus de 
renseignements, voir Utilisation de Service Manager à la page 85.

➤ OTDR Viewer : pour visualiser des acquisitions ou effectuer des 
mesures manuelles. Pour plus de renseignements, se référer au 
manuel d’instructions inclus avec l’OTDR.

➤ OTDR Controller : pour démarrer l’application complète OTDR. 
Pour plus de renseignements, se référer au manuel d’instructions 
inclus avec l’OTDR.

➤ OSA Viewer : pour visualiser les acquisitions de l’OSA. Pour plus de 
renseignements, se référer au manuel d’instructions inclus avec l’OSA

➤ OSA Controller : pour commencer l’application complète de l’OSA. 
Pour plus de renseignements, se référer au manuel d’instructions 
inclus avec l’OSA.

➤ Switch Controller (commutateurs à distance seulement) : pour associer 
un commutateur à un port spécifique. Pour plus de renseignements, 
voir Utilisation du Switch Controller à la page 135.

Fermeture de session et mise sous tension du RTU

Lorsqu’un accès physique au RTU et à son logiciel n’est pas nécessaire, il 
serait préférable de fermer la session afin que d’autres utilisateurs locaux 
ou à distance puissent accéder au RTU.

Une fermeture de session ne nuira pas aux opérations de surveillance 
continue. Par contre, pour accéder au bureau Windows et à ses 
applications, une ouverture de session est requise.
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IMPORTANT
Lors de la fermeture de Windows et de la mise hors tension du RTU, 
toutes les opérations de surveillance et les activités à distance 
seront interrompues.

Nota : Si le RTU est mis hors tension ou redémarré accidentellement, FiberVisor 
essayera de le redémarrer correctement.

Pour fermer la session d’un RTU :

1. Depuis le menu Start de Windows, sélectionner Shut Down... La 
fenêtre Shut Down apparaît.

2. Trois choix s’offrent à l’utilisateur : fermer le RTU, redémarrer le RTU 
ou ouvrir une session à l’aide d’un autre compte utilisateur. Si cette 
dernière option est choisie, une fenêtre plein écran s’affiche pour la 
prochaine opération d’ouverture de session.

Configuration ou réinstallation d’un RTU

Dans certains cas (voir ci-dessous), l’utilisateur devra effectuer toutes les 
étapes du programme d’installation du FiberVisor Client sur le RTU :

➤ pour se débarrasser d’une installation altérée

➤ pour modifier le nom du RTU ou l’adresse IP
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IMPORTANT
Le changement de nom d’un RTU (nom Bios) exige de créer de 
nouveau le RTU dans FiberVisor Console et de réinstaller FiberVisor 
Client. La configuration du RTU sera perdue.

Il est possible de changer l’adresse IP d’un RTU, mais celle-ci doit 
demeurer une adresse statique.

Pour réinstaller FiberVisor Client sur un RTU ou sur un commutateur à 
distance, sélectionner parmi les options suivantes :

➤ nouveau RTU (avec perte des données de l’utilisateur)

➤ nouveau RS (avec perte des données de l’utilisateur)

➤ rafraîchir l’installation antérieure (nouvelle installation sans perte 
de données)

➤ modifier le nom du RTU/RS (rafraîchir sans changer de nom)

Initialisation du contrôleur du système 
de test (TSC)

Le contrôleur du système de test (TSC) enregistre toute l’information 
envoyée par les RTU (statistiques, traces de référence, alarmes, etc.) dans 
des bases de données relationnelles pour le traitement et pour les 
requêtes SQL ultérieures de tout genre. Le TSC gère également toute la 
communications entre les RTU et les utilisateurs à distance situés sur 
le terrain.

Le TSC est un ordinateur Compaq Proliant 800 fonctionnant sous 
Windows NT. Il comprend le logiciel FiberVisor Server d’EXFO, les 
utilitaires Microsoft BackOffice et le logiciel LogCaster de RippleTech.
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Mise sous tension ou hors tension du TSC

Le TSC est configuré pour redémarrer automatiquement une fois par 
semaine (généralement chaque dimanche, à minuit). Cela est essentiel 
pour effectuer les tâches de nettoyage de la mémoire.

IMPORTANT
À l’exclusion du redémarrage automatique, le TSC doit toujours 
demeurer sous tension pour assurer un fonctionnement adéquat 
de FiberVisor.

Pour plus de renseignements sur les autres tâches planifiées pour le TSC, 
voir Hébergement de contenu avec l’agent SQL à la page 225.

Configuration des paramètres TSC

FiberVisor permet de configurer plusieurs paramètres sur le TSC, tels que 
les chemins de la base de données. Pour ce faire, sélectionner TSC 
Parameters depuis le menu Tools.

Nota : Cette fonction devrait seulement être employée par des utilisateurs 
expérimentés. Elle est réservée au profil d’utilisateur RFTS_ADMIN.
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L’onglet GIS permet d’entrer l’information liée aux bases de données, incluant 
le tableau sur des câbles, le champ d’identification et le facteur de tolérance, 
exprimé en mètres.
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L’onglet System permet de saisir l’information liée aux délais de 
renotification des alarmes, au chemin pour les résultats de synchronisation 
de la base de données ainsi qu’au délai des alarmes du vérificateur 
du RTU.

L’utilisateur doit choisir un délai de renotification d’au moins 60 minutes. 
L’opération est réglée par défaut pour être effectuée à toutes les 
30 minutes. Ainsi, un délai plus court ne fournira pas de résultats plus 
rapides, puisque l’opération se répétera à chaque 30 minutes. Pour 
modifier le délai de l’opération, veuillez communiquer avec EXFO.

L’onglet Server Parameters permet de saisir l’information liée aux serveurs, 
telle que l’adresse TCP/IP, l’espace qui doit demeurer disponible sur 
chaque lecteur et le nombre de jours de sauvegarde des fichiers sur 
le serveur.

IMPORTANT
La modification de l’adresse IP du TSC nécessitera l’actualisation de 
l’installation de tous les RTU (voir Configuration ou réinstallation d’un 
RTU à la page 23) sur un réseau FiberVisor. L’adresse IP du TSC doit 
toujours demeurer une adresse statique.
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IMPORTANT
Si le nom du TSC est modifié, l’utilisateur devra réinstaller le logiciel 
du TSC, incluant FiberVisor Server. Communiquer avec EXFO avant 
d’accomplir une telle opération, puisque cela peut engendrer des 
conséquences importantes.
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4 Réception et traitement 
des alarmes
Aperçu des catégories et du débit d’alarmes

Lorsqu’un événement survient sur un réseau optique, il est identifié à 
l’aide de FiberVisor et signalé par une alarme.

Débit de la génération d’alarmes

Le diagramme suivant illustre le processus de génération d’alarmes :

La personne qui gère les alarmes générées par FiberVisor doit être avisée 
afin de les résoudre éventuellement. Lorsqu’une alarme est générée, un 
tableau d’indicatifs détermine qui doit être avisé.

Il est possible de personnaliser la façon dont FiberVisor avise les personnes 
concernées lorsqu’une alarme est générée. Pour plus de renseignements, 
voir Configuration de la notification d’alarmes à la page 31.

Le TSC génère 
une alarme

Défaut détecté sur un TSC

Le RTU avise 
le TSC

Le RTU envoie un message 
au téléavertisseur de réserve

Le TSC envoie 
une notification 

par courriel

Le TSC envoie une 
notification par 
téléavertisseur

Le TSC avise les 
utilisateurs de 

FiberVisor Console

L’utilisateur répond aux alarmes et 
les archive

Réussites

Échecs

Défaut détecté sur un RTU
Système de vérification de fibres à distance 29



Réception et traitement des alarmes
Aperçu des catégories et du débit d’alarmes

O
p

ér
at

eu
r

L’alarme sera configurée selon l’un des états suivants, dépendamment de 
l’utilisation qu’on en fait :

➤ New (lorsque l’alarme est générée par FiberVisor)

➤ Acknowledged (lorsqu’un utilisateur a sélectionné 
l’option Acknowledge)

➤ Archived (lorsqu’un utilisateur a sélectionné l’option Archive)

Après une période par défaut d’un an, l’alarme est retirée de la base de 
données de FiberVisor et est sauvegardée dans une base de données 
Microsoft Access autonome. La période de temps après laquelle les 
alarmes sont sauvegardées peut seulement être configurée par EXFO lors 
de l’installation du système.

Défauts et catégories d’alarmes

Les défauts détectés par FiberVisor appartiennent à l’une des trois 
catégories suivantes. Ces dernières sont définies par la norme du réseau 
de gestion des télécommunications (TMN).

➤ Erreur de traitement : ces défauts se rattachent au logiciel FiberVisor. 
Par exemple, un défaut peut survenir lorsqu’un signal actif est détecté 
sur une fibre, puisque pour la surveillance de fibres actives, des 
équipements particuliers sont requis (coupleurs et filtres).

➤ Erreur d’équipement : ces défauts sont liés au matériel FiberVisor ou 
au réseau. Par exemple, le défaut peut être causé par un module 
OTDR défectueux.

➤ Erreur de la qualité du service : ces défauts sont détectés par les 
modules de test et ils sont liés à une diminution de la qualité du lien 
surveillé. Par exemple, un défaut survient lorsqu’un seuil de test 
est dépassé.

Pour plus de renseignements sur les défauts OTDR possibles, voir 
Description des types d’événements OTDR à la page 239. Pour plus de 
renseignements sur le module OTDR, consulter le manuel 
d’instructions fourni avec ce dernier.
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Configuration de la notification d’alarmes
Si FiberVisor Console est activé, il peut aviser l’utilisateur (ou toute autre 
personne concernée) des nouvelles alarmes ou des événements dès leur 
apparition. L’utilisateur est avisé par l’une des méthodes suivantes :

➤ notification sonore (en option)

➤ notification visuelle (boîte de dialogue éclair illustrée ci-dessous)

Activation ou désactivation du signal sonore

Il est possible d’activer ou de désactiver la notification sonore, toutefois la 
notification visuelle sera activée en permanence.

Nota : Si l’utilisateur choisi de ne pas être avisé, cela n’aura aucun effet sur la liste 
des alarmes en mode de visualisation Alarm.

Pour activer le signal sonore :

1. Depuis le menu Tools, sélectionner Options.

2. Si l’option Audible Acknowledge n’est pas cochée, la sélectionner dans 
le menu pour l’activer. Pour la désactiver lorsqu’elle est cochée, 
resélectionner l’option dans le menu.

Met en évidence l’alarme en
mode de visualisation Alarm

Affiche l’alarme
sur la carte

géographique

Ferme la boîte de dialogue actuelle

Ferme toutes les 
boîtes de dialogue 
de notification 
d’alarmes
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Personnalisation des notifications sonore 
et visuelle

Pour définir le son qu’émettra FiberVisor lorsqu’une alarme sera générée 
et pour configurer la boîte de notification visuelle :

1. Depuis le menu Tools, sélectionner Options, puis ONC Options.

2. Appuyer sur l’onglet Alarm Option.

3. Configurer les notifications sonore et visuelle, tel qu’il est illustré 
ci-dessus.

4. Appuyer sur OK pour fermer la boîte de dialogue ONC Option.

Nota : Lorsque FiberVisor a affiché le nombre maximal de boîtes de notification, 
une boîte de notification globale des alarmes apparaît.

Visualisation des alarmes sur un RTU
En travaillant localement sur un RTU, il est possible de visualiser l’activité 
actuelle de celui-ci et l’historique des alarmes à l’aide de l’application 
Viewer. Pour plus de renseignements, voir Visualisation de l’activité d’un 
RTU à la page 86.

Définir la localisation des 
fichiers sonores WAV

Définir les couleurs à 
utiliser pour chaque 
catégorie d’alarme

Déterminer le nombre 
maximal de boîtes de 
notification à afficher

Sélectionner quel niveau
de gravité des alarmes

sera notifié
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Visualisation des alarmes actuelles sur un ONC
FiberVisor Console permet à l’utilisateur de visualiser des alarmes de 
différentes façons et d’effectuer des opérations les impliquant, telles qu’en 
accuser réception ou les visualiser sur des cartes.

Nota : Il est possible de visualiser des alarmes sur un RTU dès qu’elles 
apparaissent. Toutefois, il est impossible d’en accuser réception ou de les 
traiter, sauf si l’utilisateur emploie un système autonome.

Pour visualiser la liste des alarmes actuelles (les alarmes qui n’ont pas 
été archivées) :

1. Depuis FiberVisor Console, afficher le mode de visualisation Alarms en 
utilisant l’une des méthodes suivantes :

➤ Depuis le menu View, sélectionner Alarms.

➤ Depuis la barre d’outils, appuyer sur l’icône à l’extrême gauche, 
puis sélectionner Alarms dans le menu déroulant.

Boutons
d’opération

Onglet Details

Liste des alarmes
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Par défaut, les alarmes actuelles sont triées selon la date et l’heure 
auxquelles elles sont générées, de la plus récente à la plus ancienne.

Nota : Dans la colonne Date/ONC Time, les dates et les heures sont affichées 
selon le fuseau horaire où se situe le ONC. La date et l’heure locales 
(fuseau horaire du RTU) auxquelles l’alarme survient sont affichées dans 
la colonne Network Element Time.

Les détails au sujet de la première alarme dans la liste (ou concernant 
l’alarme sélectionnée) sont illustrés dans la partie inférieure, tel qu’il est 
expliqué ci-dessous :

➤ Onglet Message : message d’alarme complet et actions recommandées.

➤ Onglet Details : nom de la fibre, du câble, du chemin ou du lien 
optique ainsi que la distance (optique et géographique). Si l’alarme est 
apparentée à l’OTDR et est liée à une section (plutôt qu’à un point), les 
colonnes Start et End seront remplies. Pour d’autres alarmes, seule la 
colonne Start contiendra de l’information.

➤ Onglet Comments : boîte de texte permettant de saisir tout 
commentaire au sujet de l’alarme.

Nota : En cas d’une alarme se produisant en aval d’un commutateur, le nom du 
commutateur est également fourni.

Triage de la liste des alarmes

Pour trier la liste des alarmes en ordre alphabétique (de 1 à 9, et de A à Z) :

1. Sélectionner l’en-tête de la colonne désirée (par exemple, appuyer sur 
Acknowledged By pour trier les alarmes selon le nom de l’utilisateur 
de FiberVisor).

La liste est triée selon le critère sélectionné et la section inférieure 
affiche les détails au sujet de la première alarme dans la liste. 
Les éléments sélectionnés le demeureront.
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2. Appuyer de nouveau sur le même en-tête de colonne pour trier les 
alarmes en ordre alphabétique inversée (A à Z devient Z à A).

Rafraîchissement du contenu de la liste

FiberVisor avisera l’utilisateur de toute nouvelle alarme seulement si 
l’acheminement est configuré à cet effet. Autrement dit, la seule façon de 
visualiser les nouvelles alarmes est de mettre à jour le contenu de la liste.

Pour rafraîchir le contenu de la liste des alarmes, appuyer sur Refresh.

Sélection des alarmes dans le liste
Il est possible de sélectionner une ou plusieurs alarmes dans la liste et de 
les traiter.

Nota : Lors de la sélection de deux ou de plusieurs alarmes, il est seulement 
possible d’en accuser réception ou de les archiver (voir Réponse aux 
alarmes à la page 39). Les autres opérations du menu contextuel sont 
permises seulement lorsqu’une seule alarme est sélectionnée.

Sélection de toutes les alarmes

Pour sélectionner toutes les alarmes dans la liste, appuyer sur Select All.

Sélection d’alarmes spécifiques

1. Sélectionner une alarme en appuyant peu importe où sur la ligne. 
Il est possible de visualiser des détails au sujet de l’alarme 
sélectionnée dans la section inférieure de l’écran.
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2. Pour sélectionner plus d’une alarme simultanément, utiliser les 
méthodes suivantes individuellement ou conjointement :

➤ Après la sélection de la première alarme, maintenir la touche Shift 
enfoncée tout en appuyant sur une autre ligne ou utiliser les 
flèches du clavier. Le système sélectionne toutes les lignes se 
situant entre la première et la dernière sélection (incluant 
la dernière).

➤ Après la sélection de la première alarme, maintenir la touche Ctrl 
enfoncée tout en appuyant sur une autre ligne. Le système ajoute 
l’autre ligne à la sélection. Il est possible de répéter cette opération 
autant de fois que désiré.

Lors de la sélection d’alarmes multiples, les sections inférieures incluent 
seulement l’information au sujet de la dernière alarme sélectionnée.

Inversion de la sélection

Pour passer des alarmes sélectionnées à celles non sélectionnées, appuyer 
sur Invert Selection.

Visualisation des alarmes sur la carte 
géographique

Il est possible de visualiser sur la carte géographique des alarmes 
provenant de défauts identifiés lors de la surveillance. Les alarmes sont 
représentées par des étoiles (les couleurs représentent le degré de gravité) 
et sont situées à l’endroit où les problèmes sont localisés. Par défaut, le 
texte de l’alarme est affiché dans un rectangle rouge et jaune.

Nota : Cette option est seulement disponible lorsqu’une seule alarme 
est sélectionnée.
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Pour visualiser une alarme sur une carte géographique :

1. Depuis la liste des alarmes, sélectionner l’alarme à visualiser sur 
la carte.

2. Depuis la liste des alarmes, cliquer à l’aide du bouton de droite de la 
souris pour ouvrir le menu contextuel.

3. Sélectionner Show on Map.

Pour plus de renseignements sur la visualisation de données sur la carte 
géographique, voir Exploration du mode de visualisation géographique à la 
page 55.

Visualisation des alarmes sur une 
carte linéaire

Il est possible d’afficher la position optique et géographique d’une alarme 
sur un plan spécial à une seule dimension appelé carte linéaire. Pour plus 
de renseignements sur la carte linéaire, voir Utilisation d’une carte linéaire 
à la page 159.

Nota : Cette option est seulement disponible lorsqu’une seule alarme 
est sélectionnée.

Pour visualiser une alarme sur une carte linéaire :

1. Depuis la liste des alarmes, sélectionner l’alarme à visualiser sur 
la carte.

2. Pour ouvrir le menu contextuel, cliquer à l’aide du bouton de droite de 
la souris, peut importe où dans la liste des alarmes.

3. Sélectionner Show on Linear Map.
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Lancement d’un outil d’analyse externe
Pour chaque type d’alarme, il est possible de lancer une application externe 
qui permet d’analyser l’événement ayant provoqué l’alarme. Habituellement, 
les applications suivantes correspondent aux traces RFTS :

➤ Surveillance OTDR : l’application ToolBox OTDR.

➤ Surveillance WDM : l’application ToolBox OSA.

Nota : Cette option est seulement disponible lorsqu’une seule alarme 
est sélectionnée.

Pour analyser une alarme à l’aide de l’outil d’analyse approprié :

1. Depuis la liste des alarmes, sélectionner l’alarme à analyser.

2. Cliquer à l’aide du bouton de droite de la souris dans la liste et 
sélectionner Launch Related Analysis Tool... depuis le menu 
contextuel.
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Réponse aux alarmes
Les alarmes générées par FiberVisor nécessitent presque toujours une 
intervention humaine. Que l’utilisateur soit avisé d’une nouvelle alarme ou 
qu’il navigue à travers la liste des alarmes, deux choix s’offrent à lui : 
accuser réception de l’alarme ou l’archiver.

IMPORTANT
La reconnaissance ou l’archivage d’une alarme peut avoir différentes 
significations, selon le type d’utilisateur. FiberVisor ne tient pas 
compte des politiques de toute entreprise au sujet des personnes 
responsables de résoudre les alarmes générées. S’assurer de bien 
comprendre ce que chacune de ces opérations signifient.

Reconnaissance d’une alarme

Lorsqu’un utilisateur reconnaît une alarme, les autres utilisateurs ONC 
seront avisés qu’il l’a constatée. Habituellement, la reconnaissance d’une 
alarme signifie également que l’utilisateur résout le problème lié à celle-ci.

Nota : Si une alarme n’est pas reconnue après une période spécifique, le TSC 
enverra une nouvelle notification d’alarme à TOUS les utilisateurs 
FiberVisor. Pour modifier cette période, ouvrir le menu Tools et sélectionner 
Administration, puis configurer les paramètres TSC (TSC Parameters).

Pour reconnaître une alarme en mode de visualisation Alarm :

1. Depuis la liste des alarmes, sélectionner une ou plusieurs alarmes 
à reconnaître.

2. Cliquer à l’aide du bouton de droite de la souris dans la liste et 
sélectionner Acknowledge depuis le menu contextuel.

OU

Appuyer sur Acknowledge au bas du mode de visualisation Alarm.
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3. Depuis la boîte de dialogue, appuyer sur Yes pour confirmer la 
reconnaissance des alarmes sélectionnées. Appuyer sur No pour 
laisser les alarmes telles quelles.

FiberVisor sauvegardera sur le TSC le nom de l’utilisateur, la date et 
l’heure. La liste des alarmes sera également rafraîchie lors d’un prochain 
accès par un utilisateur ONC. La reconnaissance d’alarmes demeure 
visible depuis la liste et sur la carte géographique.

Archivage de données sur les alarmes

L’archivage de données sur les alarmes permet de libérer le mode de 
visualisation des alarmes courantes et le mode de visualisation géographique 
d’alarmes reconnues et de conserver ces données pour référence future. 

Pour archiver des alarmes en mode de visualisation Alarm :

1. Depuis la liste des alarmes, sélectionner une ou plusieurs alarmes 
à archiver.

2. Cliquer à l’aide du bouton de droite de la souris dans la liste et 
sélectionner Archive depuis le menu contextuel.

OU

Appuyer sur Archive au bas du mode de visualisation Alarm.

3. Dans la boîte de dialogue, appuyer sur Yes pour confirmer l’archivage 
des alarmes sélectionnées. Appuyer sur No pour ne pas 
archiver l’alarme.

Une fois l’opération d’archivage complétée, FiberVisor sauvegarde le nom 
de l’utilisateur, la date et l’heure sur un TSC. Tous les utilisateurs ONC sont 
avisés que les alarmes sont archivées et que la liste des alarmes sera 
rafraîchie lors d’un prochain accès par un utilisateur ONC. Les alarmes 
archivées sont retirées de la liste et ne sont pas visibles sur la 
carte géographique.

Nota : Les alarmes archivées sont automatiquement considérées comme 
étant reconnues.
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Visualisation de l’historique des alarmes sur 
le ONC

Il est possible d’utiliser l’asistant de l’historique des alarmes pour visualiser 
des détails au sujet des alarmes (incluant des alarmes reconnues et 
archivées) générées par FiberVisor depuis son installation.

Il est possible de choisir d’afficher des alarmes :

➤ associées à un élément du réseau particulier (RTU ou commutateur 
à distance)

➤ d’une catégorie spécifique

➤ en ordre chronologique

Pour plus de renseignement sur l’assistant de l’historique des alarmes, voir 
Exploration de l’historique des alarmes à la page 95.
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5 Exploration des vues 
d’arborescence du réseau

FiberVisor Console permet d’utiliser les modes de visualisation de 
l’explorateur du réseau pour afficher la structure du RFTS. Dans ces modes 
de visualisation, les éléments du réseau (RTU, commutateurs à distance, 
modules de test, etc.) et les chemins sont présentés telles des branches 
d’un arbre qu’il est possible d’explorer.

Cette section apporte des détails au sujet de l’information disponible et des 
opérations pour chacun des modes de visualisation de l’arborescence 
du réseau.

➤ Topologie du réseau : les éléments d’un réseau actif et les chemins.

➤ Historique du réseau : tous les éléments, incluant les 
données historiques.

➤ Lien optique : tous les chemins possibles entre deux points sur 
un réseau.

Panneau
d’arborescence

Barre de menu

Barre d’état

Panneau
d’information
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Nota : L’état actif des éléments du réseau peut dépendre des éléments externes : 
un RTU sera actif seulement s’il est associé à une licence valide. 
Un commutateur à distance sera actif seulement si son RTU l’est. Les 
chemins seront actifs seulement s’ils sont utilisés dans une configuration.

Accès aux modes de visualisation de 
l’explorateur du réseau

Pour afficher un mode de visualisation de l’explorateur du réseau dans 
FiberVisor Console :

➤ Depuis le menu View, sélectionner Browser, puis l’un des modes de 
visualisation disponibles.

OU

➤ Dans la barre d’outils, appuyer sur l’icône à l’extrême gauche, puis sur 
Browser dans le menu déroulant.

Modes de visualisation de la topologie du 
réseau et de l’historique du réseau

Les modes de visualisation de la topologie du réseau et de l’historique du 
réseau comprennent de l’information similaire. Toutefois, le dernier mode 
inclut des éléments archivés et des données historiques.

Les deux modes permettent d’explorer l’arborescence du réseau dans 
lequel sont listés les éléments du réseau et les chemins. Voir l’exemple de 
topologie du réseau à la page 43.
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Utiliser les deux modes de visualisation pour :

➤ sélectionner un élément dans la liste afin de visualiser ses 
caractéristiques dans la section droite de l’écran (panneau 
de l’information).

➤ consulter les appellations dans l’arborescence du système afin 
d’obtenir de l’information au sujet des connexions entre les éléments 
du réseau.

➤ cliquer à à l’aide du bouton de droite de la souris sur un élément de 
l’arborescence du système et sélectionner une option du menu 
contextuel pour accomplir une tâche liée à l’élément. Les actions 
possibles sont expliquées ultérieurement dans cette section.

Exploration du contrôleur du système de test

Le contrôleur du système de test (TSC) se situe à la tête de l’arborescence. 
Il s’agit du point central du système. Le TSC loge des bases de données et 
gère la communication avec les RTU et les postes de surveillance.

Caractéristiques 
du TSC
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Les actions suivantes sont disponibles dans le menu contextuel pour 
le TSC :

➤ test de communication avec les RTU

➤ lancement de LogCaster Console

➤ lancement du SMS Console Administration

➤ lancement de SMS Remote Control

➤ lancement du SQL Agent

➤ lancement de Windows NT User Manager

➤ révision des propriétés du TSC

Exploration des unités de vérification à distance

En arborisant l’élément TSC, il est possible de visualiser les unités de 
vérification à distance (RTU) et les commutateurs à distance (RS). 
Ces unités de vérification du réseau sont listées en ordre alphabétique.

Caractéristiques 
du RTU
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Les actions suivantes sont disponibles dans le menu contextuel du RTU :

➤ accès aux outils à distance (configuration du RTU, Service Manager, 
Viewer, test de communication, SMS Remote Control)

➤ activation ou désactivation du RTU

➤ affiche le RTU sur la carte géographique

➤ modifie les propriétés du RTU

➤ retire le RTU

➤ affiche les chemins inutilisés

➤ affiche les autres fichiers

Exploration des commutateurs à distance

En arborisant l’élément TSC, il est possible de visualiser les unités de 
vérification à distance (RTU) et les commutateurs à distance (RS). 
Ces unités de vérification du réseau sont listées en ordre alphabétique.

Caractéristiques 
du commutateur 
à distance
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Les actions suivantes sont disponibles dans le menu contextuel pour le 
commutateur à distance :

➤ accède aux outils à distance (configuration du RS, Service Manager, 
Viewer, test de communication, SMS Remote Control) pour les 
commutateurs à distance WAN seulement

➤ affiche le commutateur à distance sur la carte géographique

➤ modifie les propriétés du commutateur à distance

➤ retire le commutateur à distance

➤ illustre les chemins inutilisés

➤ affiche les autres fichiers (commutateurs à distance WAN seulement)

Exploration des modules de test

En arborisant un élément du RTU ou d’un commutateur à distance, il est 
possible de visualiser les modules (ex. : OTDR) liés à celui-ci. Ils sont listés 
en ordre alphabétique.

Il est impossible d’appliquer une action du menu contextuel pour un 
module OTDR.

Caractéristiques 
de l’OTDR
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Exploration des ports du module

En arborisant un module OTDR, OSA ou commutateur optique, il est 
possible de visualiser ses ports listés en numéro ascendant.

La seule action possible pour un port depuis le menu contextuel est 
d’explorer l’arborescence jusqu’à l’autre extrémité du câble branché à ce 
port, le cas échéant.

Caractéristiques 
du port
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Exploration des chemins

Si le chemin est défini pour un port sélectionné, il est possible de le 
visualiser en arborisant l’élément du port. S’il y a plus d’un chemin, 
ils seront affichés en ordre ascendant.

Les actions suivantes sont disponibles dans le menu contextuel du chemin :

➤ modifie les propriétés du chemin

➤ supprime le chemin

➤ affiche le chemin en tant que carte linéaire

➤ affiche le chemin sur une carte géographique

Caractéristiques 
du chemin
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Exploration des traces et des listes de câbles

En arborisant l’élément du chemin, il est possible de visualiser la liste de 
câbles et les catégories de traces suivantes :

➤ Reference : traces de référence pour ce port

➤ Alarm-Related : traces acquises durant la détection des alarmes

➤ Test on Demand Related : traces acquises durant les tests sur demande

➤ Sampling : traces définies lors de la configuration du RTU et acquises 
périodiquement lorsque le port est branché

Les actions suivantes sont disponibles dans le menu contextuel des traces :

➤ modifie les propriétés de la trace (commentaires)

➤ donne un aperçu préliminaire de la trace

➤ exécute l’outil d’analyse externe (ex. : application OTDR)

➤ supprime la trace

Les câbles sont listés par ordre de chemin du RTU approprié. La seule 
action possible pour un port depuis le menu contextuel est de modifier les 
propriétés d’un câble.

Caractéristiques de 
la trace ou de la 
liste de câbles
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Compréhension de la visualisation d’un 
lien optique

Le mode de visualisation d’un lien optique est semblable aux modes de 
visualisation de la topologie du réseau ou de l’historique, mais il est surtout 
utile pour fournir de l’information sur les liens de communication entre 
des points d’un réseau optique.

Utiliser le mode de visualisation d’un lien optique selon l’une des 
méthodes suivantes :

➤ sélectionner un élément dans la liste pour visualiser ses 
caractéristiques dans la section droite de l’écran 
(panneau d’information)

➤ consulter les appellations dans l’arborescence pour obtenir de 
l’information sur les connexions entre les éléments du réseau

Panneau
d’arborescence

Barre de menus

Barre d’état

Panneau
d’information
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➤ cliquer à l’aide du bouton de droite de la souris sur un élément de 
l’arborescence du système et sélectionner une option du menu 
contextuel pour accomplir une tâche liée à l’élément. Les actions 
possibles sont expliquées ultérieurement dans cette section.

Exploration des liens optiques

En arborisant l’élément TSC, il est possible de visualiser des liens optiques 
dont le nom est affiché en ordre alphabétique. 

Les actions suivantes sont disponibles dans le menu contextuel du 
lien optique :

➤ modifie les propriétés du lien

➤ modifie la liste des éléments dans le lien optique

➤ supprime le lien optique
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Exploration des chemins

En arborisant l’élément des liens optiques, il est possible de visualiser 
l’arborescence des chemins; les noms sont affichés par ordre 
alphabétique. Les chemins et tous les éléments qui leur sont rattachés 
dans l’arborescence incluent la même information que dans le mode de 
visualisation de la topologie du réseau.

Pour plus de renseignements sur des chemins, des traces, des listes de 
câbles et leurs actions respectives, voir Modes de visualisation de la 
topologie du réseau et de l’historique du réseau à la page 44.
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6 Exploration du mode de 
visualisation géographique

FiberVisor Console permet d’utiliser le mode de visualisation 
géographique pour afficher le réseau de fibres entier sur une carte. 
Ce mode de visualisation divise par couches plusieurs entités (rivières, 
rues, voies ferrées, éléments du réseau, fibres optiques et alarmes) afin de 
fournir une vue complète et précise du réseau.

Une légende, affichée à la gauche dans le mode de visualisation 
géographique, permet de définir la division par couches sur la carte et la 
façon dont les élément sont illustrés.

Les autres éléments d’exploration, tels que la flèche indiquant le nord, 
l’échelle ou la légende, peuvent être affichés ou masqués au choix, tel qu’il 
est expliqué dans Affichage ou masquage de la légende et des autres 
éléments d’exploration à la page 63.

Légende

Flèche 
indiquant
le nord

Barre
d’outils

Échelle

Barre
d’état

Carte
divisée

par
couche

(éléments)
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Lors de la définition des paramètres exactes d’une carte, il est possible de 
sauvegarder cette configuration de paramètres dans un fichier-contexte. 
Cela simplifiera ultérieurement le travail, puisque la sauvegarde permettra 
d’afficher rapidement les données exactes et de les disposer de la façon 
désirée. Pour plus de renseignements, voir Sauvegarde de l’environnement 
de travail à l’aide de contextes à la page 59.

Cette section donne des détails sur les entités, les légendes et les contextes 
et explique comment explorer et personnaliser le mode de visualisation 
géographique. Pour plus de renseignements sur la configuration du 
système d’information géographique (SIG) ou sur les entités disponibles, 
voir Configuration du SIG à la page 171.

Accès au mode de visualisation géographique
Dans FiberVisor Console, afficher le mode de visualisation géographique 
en utilisant l’une des méthodes suivantes :

➤ Depuis le menu View, sélectionner Geographical.

OU

➤ Dans la barre d’outils, cliquer sur l’icône à l’extrême gauche, puis 
sélectionner Geographical dans le menu déroulant.

Voir l’exemple du mode de visualisation géographique illustré à la page 55.
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Le tableau suivant décrit la fonction des boutons de la barre d’outils. 
La plupart de ces boutons sont seulement disponibles depuis le mode de 
visualisation géographique.

Boutons Fonctions

Select Active la sélection du curseur. Pour plus de 
renseignements, voir Sélection et désélection d’éléments sur 
la carte à la page 67.

Unselect Désélectionne tous les éléments sélectionnés. 
Pour plus de renseignements, voir Sélection et désélection 
d’éléments sur la carte à la page 67.

Fit all Ajuste les configurations du zoom afin que tous les 
éléments sur la carte soient visibles dans l’espace de travail. 
Pour plus de renseignements, voir Ajustement de 
l’information à l’écran à la page 71.

Fit selected Ajuste les configurations du zoom afin que les 
éléments sélectionnés sur la carte soient visibles dans 
l’espace de travail. Pour plus de renseignements, voir 
Ajustement de l’information à l’écran à la page 71.

Fit Entity Ajuste les configurations du zoom afin que tous 
les éléments sur la carte qui appartiennent à l’entité 
sélectionnée dans la légende soient visibles dans l’espace de 
travail. Pour plus de renseignements, voir Ajustement de 
l’information à l’écran à la page 71.

Zoom In Effectue un zoom avant de la section de la carte 
qui a été sélectionnée. Pour plus de renseignements, voir 
Zoom avant à la page 70.

Zoom Out Effectue un zoom arrière de la section de la carte 
qui a été sélectionnée. Pour plus de renseignements, voir 
Zoom arrière à la page 70.

Pan Permet de faire dérouler la carte affichée dans l’espace 
de travail. Pour plus de renseignements, voir Déplacements 
sur la carte (Pan) à la page 72.
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Refresh View Rafraîchit le mode de visualisation affiché. 
Pour plus de renseignements, voir Rafraîchissement de la 
fenêtre principale à la page 73. Ce bouton est aussi disponible 
dans les modes de visualisation de l’explorateur.

Search on Map Permet de trouver et de sélectionner une entité 
spécifique ou un élément du réseau. Ce bouton équivaut à celui 
de l’option du menu Quick Search. Pour plus de renseignements, 
voir Recherche d’éléments par des requêtes à la page 76.

Show Geographical Properties Affiche les propriétés des 
éléments sélectionnés. 

New Annotation Ajoute une annotation au point 
sélectionné sur la carte. Pour plus de renseignements, voir 
Création d’une annotation à la page 201.

New Cable Annotation Ajoute une annotation au câble 
sélectionné. Pour plus de renseignements, voir Création 
d’une annotation à la page 201.

New Cable Active l’outil New Cable. Pour plus de renseignements, 
voir Ajout d’un câble dans FiberVisor à la page 185.

New Infrastructure Active l’outil New Infrastructure. Pour plus de 
renseignements, voir Création d’une infrastructure à la page 199.

New Measurement Point Active l’outil New Measurement 
Point. Pour plus de renseignements, voir Gestion des chemins 
et des points de mesure à la page 193.

New Path Ajoute un chemin au RTU et au câble 
sélectionnés. Pour plus de renseignements, voir Gestion des 
chemins et des points de mesure à la page 193.

New Remote Switch Active l’outil New Remote Switch. Pour plus 
de renseignements, voir Utilisation du Switch Controller à la 
page 135.

New RTU Active l’outil New RTU. Pour plus de 
renseignements, voir Création d’un RTU dans FiberVisor à la 
page 165.

Boutons Fonctions
58 FiberVisor 2.2



Exploration du mode de visualisation géographique
Sauvegarde de l’environnement de travail à l’aide de contextes

O
p

ér
at

eu
r

Sauvegarde de l’environnement de travail à 
l’aide de contextes

Un contexte est un fichier qui contient toute l’information requise pour 
afficher une portion spécifique de la carte géographique ainsi qu’un 
ensemble d’éléments prédéfinis.

Si les configurations actuelles du mode de visualisation géographique 
seront utilisées ultérieurement dans une autre séance FiberVisor Console, 
les sauvegarder dans un fichier-contexte sur le disque dur ou sur une unité 
de réseau partagée. Les contextes peuvent même être copiés ou envoyés 
par courriel aux autres utilisateurs ONC.

Nota : Les fichiers de contexte FiberVisor supportent l’extension « .GVS » 
(format privatif).

Un contexte inclut les éléments suivants :

➤ les entités affichées en mode de visualisation géographique

➤ une portion de la carte géographique affichée et le facteur zoom utilisé

➤ les propriétés de la légende

➤ les couleurs de la carte, le format du curseur et les guides apparents 
(flèche indiquant le nord, échelle, etc.)

Lors du lancement de FiberVisor Console, il est essentiel de choisir entre 
charger un contexte existant, un contexte vide ou un contexte par défaut.

Personnalisation du contexte par défaut

Pour un utilisateur de niveau d’accès RFTS_ADMIN, il est possible de 
personnaliser les paramètres du contexte par défaut. Pour plus de 
renseignements à ce sujet, voir Configuration du SIG à la page 171.
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Chargement d’un contexte existant

Les fichiers-contextes possèdent l’extension « .GVS » et peuvent être 
localisés sur n’importe quel disque dur local ou sur un réseau. Par défaut, 
les contextes sont sauvegardés dans le répertoire de l’application.

IMPORTANT
Si un fichier-contexte réfère à de l’information sauvegardée sur un 
disque dur local (ex. : fichiers d’images), il se peut qu’il ne fonctionne 
pas correctement sur un autre ONC.

Il est possible d’ouvrir un seul fichier-contexte à la fois. Lors de l’ouverture 
d’un deuxième fichier-contexte dans une séance FiberVisor Console, le 
logiciel ferme le premier qui était ouvert.

Pour ouvrir un fichier-contexte FiberVisor :

1. Depuis le menu File, sélectionner Open Context...

2. Choisir l’un des fichiers dont le nom est suivi de l’extension « .GVS ».

3. Appuyer sur OK pour ouvrir un fichier.

Création et sauvegarde d’un nouveau 
fichier-contexte

Les fichiers-contextes doivent posséder l’extension « .GVS » et sont 
sauvegardés par défaut dans un répertoire d’application. Il est possible de 
sélectionner tout autre répertoire lors de la sauvegarde d’un fichier.

Pour créer un nouveau fichier-contexte FiberVisor :

1. Pour le nouveau fichier-contexte, déterminer s’il doit être basé sur le 
contexte par défaut ou sur tout autre contexte existant.

➤ Pour débuter avec le fichier-contexte par défaut, sélectionner New 
Context... depuis le menu File.
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➤ Pour débuter avec un fichier-contexte défini par l’utilisateur, ouvrir 
le fichier, tel qu’il est expliqué dans Chargement d’un contexte 
existant à la page 60.

2. Charger les entités requises. Pour plus de renseignements, voir Ajout 
de données géographiques (entités) à la carte à la page 64.

3. Configurer l’affichage de la carte géographique. Les possibilités sont 
présentées ultérieurement dans ce chapitre.

4. Sauvegarder tous les paramètres actuels du mode de visualisation 
géographique.

4a. Sélectionner Save Context As... depuis le menu File.

4b. Attribuer un nom au nouveau fichier-contexte et sélectionner le 
répertoire de sauvegarde.

4c. Appuyer sur OK pour sauvegarder le fichier.

Pour conserver le nom de fichier actuel ou pour sauvegarder en tout temps 
les derniers changements au contexte ouvert, sélectionner Save Context 
dans le menu File.

IMPORTANT
Si un fichier-contexte ouvert est sauvegardé sous un nouveau nom, les 
derniers changements ne seront PAS mis à jour dans le fichier original. 
Afin de s’assurer que les deux fichiers soient identiques, sauvegarder 
tout d’abord les changements dans le fichier original, puis sauvegarder 
le fichier en lui attribuant le nouveau nom.

Affichage de données à l’aide de la légende
Dans la plupart des cas, l’utilisateur définit le contenu et le design de la 
carte à l’aide de la légende. Une légende conventionnelle reflète 
simplement ce qui est affiché sur une carte. Utiliser la légende de 
FiberVisor Console pour surveiller et visualiser l’affichage.
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La légende peut contenir les éléments suivants :

La légende comprend une entrée séparée pour chaque couche de la carte. 
Chaque entrée peut comprendre un titre, des sous-titres et des en-têtes. 
Utiliser ces entrées pour contrôler l’affichage d’objets en mode de 
visualisation géographique. Pour modifier une entité, cliquer à l’aide du 
bouton de droite de la souris sur l’entité et sélectionner Properties.

➤ Si les statistiques concernant la légende sont activées, l’entrée affiche 
le décompte des objets entre parenthèses devant le titre.

➤ Si une couche est affichée selon une échelle, une petite icône 
représentant une échelle sera affichée devant le titre.

Titre d’entrée

Flèche de localisation

Catégorie de style
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Affichage ou masquage de la légende et des 
autres éléments d’exploration

Pour afficher la légende ou d’autres éléments d’exploration (s’ils ne sont 
pas actuellement affichés) :

1. Depuis le menu Tools, sélectionner Options, puis ONC Options.

2. Cocher la case Legend, North Arrow ou Scale Bar dans la section View 
de l’onglet Context Option.

3. Appuyer sur OK.

Nota : Il est possible de déplacer la légende à n’importe quel endroit sur la carte 
en la glissant. La flèche indiquant le nord et l’échelle ne peuvent pas 
être déplacées.

Pour masquer la légende, la flèche indiquant le nord ou l’échelle :

1. Cliquer à l’aide du bouton de droite de la souris sur la légende.

2. Désélectionner Legend, North Arrow ou Scale Bar dans le menu éclair.
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OU

1. Depuis le menu Tools, sélectionner Options, puis ONC Options.

2. Désélectionner la case Legend de la section View.

3. Appuyer sur OK.

Ajout de données géographiques (entités) à 
la carte

En ajoutant un élément à la légende, il s’affiche également sur la carte. 
Il existe un lien entre l’entrée de la légende et la carte pour que l’affichage 
sur la carte soit modifié en manipulant l’entrée de la légende.

Pour ajouter des entrées à la légende :

1. Depuis le menu View, sélectionner Load Entities...

2. Cocher les cases devant les entités à charger. Les cases sont cochées 
pour les entités déjà chargées.
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3. Appuyer sur OK pour charger les entités sélectionnées, ou sur Cancel 
pour retourner au mode de visualisation géographique.

Suppression d’entrées de la légende ou d’entités 
de la carte

Pour supprimer une entité d’une carte :

➤ Supprimer son entrée de la légende en utilisant la boîte de dialogue 
Legend Properties, tel qu’il est expliqué dans les pages suivantes.

➤ Désactiver la case devant l’entité dans la fenêtre Loader Tool.

Personnalisation de l’affichage de la légende

Pour personnaliser l’affichage de la légende :

1. Cliquer à l’aide du bouton de droite de la souris dans la légende, puis 
sélectionner Properties.

2. Configurer les options générales, telles que la couleur et l’affichage de 
statistiques, de la barre du titre et des info-bulles.
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3. Sélectionner l’onglet Entries.

4. Configurer l’affichage de chaque entrée dans la légende, tel qu’il est 
expliqué ci-dessous :

➤ Style : il s’agit de l’icône correspondante dans la légende.

➤ Title : modifie l’appellation de l’entité qui apparaît dans la légende. 
Il peut être utile d’attribuer un nom plus convivial à l’entité.

➤ Subtitle : il est possible d’ajouter dans ce champ de l’information 
plus précise sur l’entité.

➤ Display : en configurant cette propriété à Off, l’entrée n’apparaîtra 
pas dans la légende, mais elle sera tout de même chargée avec 
le contexte.

➤ Locatable : une entité localisable en est une dont les éléments 
peuvent être facilement sélectionnés et modifiés sur une carte.

➤ Entry : si cette propriété est désélectionnée, l’entité sera chargée, 
mais elle n’apparaîtra pas dans la légende.

Nota : Si plusieurs entités sont affichées simultanément sur la carte, il est 
recommandé de configurer seulement quelques-unes d’entre elles, afin 
qu’elles soient localisables. Autrement, il sera très difficile de sélectionner 
précisément les éléments avec la souris.
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5. Placer les entités par ordre ascendant à l’aide des flèches 
de défilement.

IMPORTANT
Les entités sont affichées l’une par dessus l’autre, ce qui signifie que 
les éléments d’une entité peuvent complètement chevaucher et 
cacher des éléments d’une autre entité. S’assurer que les entités 
importantes (telles que les alarmes) soient affichées au-dessus, en les 
déplaçant au sommet de la légende.

6. Appuyer sur OK pour accepter les nouvelles propriétés de la légende.

Sélection et désélection d’éléments sur 
la carte

Pour visualiser et modifier les propriétés des éléments cartographiés ou 
pour utiliser certaines fonctions, il est essentiel de mettre en évidence et 
de sélectionner tout d’abord ces éléments.

Mise en évidence des éléments

Pour mettre en évidence un ou plusieurs éléments cartographiés :

1. Activer le curseur de sélection en utilisant l’une des 
méthodes suivantes :

➤ Appuyer sur le bouton  dans la barre d’outils. Pour plus de 
renseignements sur les boutons de la barre d’outils, voir à la 
page 57.

➤ Choisir Select depuis le menu Navigate.

2. Positionner le curseur de sélection sur un élément de la carte. 
L’élément sera maintenant de couleur différente.
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3. Pour mettre en évidence plus d’un élément en même temps 
(ex. : le câble entrant dans un RTU, le RTU lui-même et le câble sortant 
du RTU), déplacer le curseur le long des éléments adjacents. Lorsque 
le curseur est bien positionné, tous les éléments sont mis en 
évidence simultanément.

Nota : Il est possible de configurer les couleurs dans la boîte de dialogue ONC 
Options. Pour plus de renseignements, voir Personnalisation du mode de 
visualisation géographique à la page 80.

Sélection d’éléments sur la carte

Un objet sur une carte doit être localisable pour être sélectionné avec le 
curseur. Une flèche à côté de l’entrée de la légende indique qu’un objet est 
localisable. Il est possible de le contrôler en cliquant à l’aide du bouton de 
droite de la souris sur l’entrée de la légende et en cochant Locatable. Pour 
plus de renseignements sur la fenêtre Legend, voir Affichage de données à 
l’aide de la légende à la page 61.

Pour sélectionner des objets non localisables, utiliser la méthode de 
recherche rapide. Pour plus de renseignements sur la recherche rapide, 
voir Recherche rapide à la page 76.

Pour sélectionner un seul élément ou des éléments adjacents sur la carte :

1. Mettre en évidence les éléments à sélectionner.

2. Cliquer sur l’un des éléments.

Pour sélectionner des éléments non adjacents sur la carte :

1. Sélectionner le premier élément.

2. Appuyer sur la touches Shift ou Ctrl et la maintenir enfoncée tout en 
sélectionnant les autres éléments dans la séquence.

Pour sélectionner tous les éléments d’une région sur la carte, il suffit de 
cliquer à l’aide du bouton de gauche de la souris, de le maintenir enfoncé 
et de faire glisser le curseur Select sur la région comprenant les éléments à 
sélectionner, tel qu’il est illustré à la page suivante.
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Tous les éléments qui sont entièrement compris à l’intérieur des limites du 
cadre de sélection seront sélectionnés. En maintenant enfoncée la touche 
Ctrl, les éléments qui sont partiellement compris seront également inclus.

Désélection des éléments sur la carte

Pour désélectionner des éléments :

1. Activer le curseur de désélection en utilisant l’une des méthodes suivantes :

➤ Appuyer sur le bouton  depuis la barre d’outils. Pour plus de 
renseignements sur les boutons de la barre d’outils, voir à la 
page 57.

➤ Choisir UnSelect All depuis le menu Navigate.

IMPORTANT
En appuyant sur l’arrière-plan, tous les éléments APPARAISSENT 
désélectionnés, mais en réalité, toute la carte a été sélectionnée. 
La seule méthode fiable pour tout désélectionner est celle expliquée 
ci-dessus.

Affichage de régions plus grandes ou plus 
petites sur la carte

Grâce aux fonctions zoom, il est possible de spécifier très précisément 
(à l’intérieur de 10 cm, selon l’échelle de l’entité) la région à visualiser sur 
la carte.

RTU

RTU

Région de sélection

Câble
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Nota : Pour basculer entre le facteur de zoom actuel et le dernier niveau de zoom 
utilisé, cliquer à l’aide du bouton de droite de la souris sur la carte lorsque 
rien n’est surligné ou sélectionné.

Zoom avant

Pour agrandir une région sur la carte :

1. Activer le curseur du zoom avant (la loupe avec le signe +) en utilisant 
l’une des méthodes suivantes :

➤ Appuyer sur le bouton  depuis la barre d’outils. Pour plus de 
renseignements sur les boutons de la barre d’outils, voir à la 
page 57.

➤ Choisir Zoom, puis sélectionner In depuis le menu Navigate.

2. Appuyer sur la région où effectuer un zoom avant. La région est 
agrandie et il est possible de la voir de façon plus détaillée.

Il est également possible de maintenir le bouton de gauche de la souris 
enfoncé et de le glisser sur la région à agrandir. Tous les éléments compris 
dans les limites du cadre de sélection seront visibles en mode de 
visualisation agrandi.

Zoom arrière

Pour réduire une région sur la carte :

1. Activer le curseur du zoom arrière (loupe avec le signe -) en utilisant 
l’une des méthodes suivantes :

➤ Appuyer sur le bouton depuis la barre d’outils. Pour plus de 
renseignements sur les boutons de la barre d’outils, voir à la 
page 57.

➤ Choisir Zoom, puis sélectionner Out depuis le menu Navigate.

2. Appuyer sur la région où effectuer un zoom arrière. La région est 
réduite et il est possible de la visualiser de façon moins détaillée.
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Il est également possible de maintenir le bouton de gauche de la souris 
enfoncé et de le glisser sur la région à réduire. Une ligne indiquant la 
proportion du zoom apparaîtra. Déplacer le curseur pour sélectionner la 
proportion du zoom désirée et relâcher le bouton de la souris pour activer 
le mode de visualisation réduit sélectionné.

Ajustement de l’information à l’écran
FiberVisor Console permet d’afficher des éléments en utilisant tout 
l’espace de l’écran. Il ajuste automatiquement le facteur zoom pour 
assurer que tous les éléments désirés prendront tout l’espace disponible à 
l’écran.

Ajustement de tous les éléments

Pour ajuster les configurations du zoom afin que tous les éléments sur la 
carte soient visibles à l’écran :

➤ Appuyer sur depuis la barre d’outils. Pour plus de renseignements 
sur les boutons de la barre d’outils, voir à la page 57.

OU

➤ Depuis le menu Navigate, sélectionner Fit, puis All.

Ajustement des éléments sélectionnés

Pour ajuster les configurations du zoom afin que les éléments sélectionnés 
de la carte soient visibles à l’écran :

➤ Appuyer sur depuis la barre d’outils. Pour plus de renseignements 
sur les boutons de la barre d’outils, voir à la page 57.

OU

➤ Depuis le menu Navigate, sélectionner Fit, puis Selected.
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Ajustement des éléments d’une entité

Pour ajuster les configurations du zoom afin que tous les éléments de la 
carte appartenant à l’entité sélectionnée dans la légende soient visibles 
à l’écran :

➤ Appuyer sur depuis la barre d’outils. Pour plus de renseignements 
sur les boutons de la barre d’outils, voir à la page 57.

OU

➤ Depuis le menu Navigate, sélectionner Fit, puis Entity.

Déplacements sur la carte (Pan)
Quelquefois, un élément à visualiser à l’écran est masqué par une palette 
ou il se trouve simplement hors de la région à visualiser. Pour le visualiser, 
il est possible d’effectuer un zoom arrière pour visualiser la carte plus 
complètement, mais de cette façon la carte est moins détaillée.

Il est également possible d’explorer la carte (une fonction nommée 
panoramique (panning)) pour trouver l’élément sans perdre aucun détail.

Pour utiliser la fonction panoramique :

1. Activer le curseur panoramique (main) en utilisant l’une des méthode 
suivantes :

➤ Appuyer sur le bouton depuis la barre d’outils. Pour plus de 
renseignements sur les boutons de la barre d’outils, voir à la 
page 57.

➤ Choisir Pan depuis le menu Navigate.

2. Appuyer sur le bouton de gauche de la souris, le maintenir enfoncé et 
le glisser sur la carte. La carte se déplacera dans la direction vers 
laquelle elle est glissée. Déplacer la carte jusqu’à l’obtention de 
l’élément recherché.

3. Une fois l’élément trouvé, relâcher le bouton de la souris.
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Rafraîchissement de la fenêtre principale
Il peut s’avérer essentiel d’afficher en mode de visualisation géographique 
avec la plus récente information du TSC ou des RTU. Par exemple, lors de 
la réception d’une notification d’alarme qui n’est pas encore apparue dans 
la fenêtre principale.

Pour rafraîchir le contenu de la fenêtre principale, utiliser l’une des 
méthodes suivantes :

➤ Depuis la barre d’outils, appuyer sur le bouton . Pour plus de 
reseignements sur les boutons de la barre d’outils, voir à la page 58.

➤ Depuis le menu Navigate, choisir Refresh Map.

Affichage ou masquage des événements 
optiques sur la carte

Les événements optiques sont ceux détectés par la surveillance OTDR sur 
un réseau optique. Ces événements seront localisés et affichés sur le 
segment de câble approprié selon leur distance optique.

Nota : Les événements optiques demeureront sur la carte jusqu’à ce qu’ils soient 
effacés ou que d’autres événements soient sélectionnés.

Les événements optiques les plus communs sont listés dans Description 
des types d’événements OTDR à la page 239.
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Affichage des événements optiques sur une carte

Pour afficher des événements optiques sur des câbles ou des éléments 
de réseau :

1. Sélectionner sur la carte un ou plusieurs câbles ou des éléments de 
réseau. Pour obtenir de l’aide concernant les éléments sélectionnés, 
voir Sélection et désélection d’éléments sur la carte à la page 67.

2. Depuis le menu View, sélectionner Optical Events.

3. Dans la liste Path, sélectionner un chemin. Une liste des traces 
disponibles pour ce chemin sera affichée dans la section Traces.

4. Sélectionner la trace contenant les événements optiques désirés.

5. Appuyer sur OK. Les événements optiques sont affichés sur la carte.

Retrait d’événements optiques de la carte

Pour supprimer des événements optiques actuellement affichés, depuis le 
menu View, sélectionner Clear Optical Events.
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Mesure de la distance entre des points
Pour mesurer la distance linéaire entre deux points ou la distance totale 
entre deux ou plusieurs localisations géographiques sur la carte :

1. Sélectionner Measure Distance depuis le menu Navigate. La boîte de 
dialogue Measure Distance est affichée dans la fenêtre principale.

2. Mesurer la distance du premier segment.

2a. Appuyer sur le point de départ (A) du premier segment.

2a. Appuyer sur le point d’arrivée (B) du premier segment.

Une ligne pointillée indique la distance sur la carte. La distance entre 
les points A et B est déterminée dans le champ de texte Distance. La 
distance cumulative totale est affichée dans le champ de texte Total.

Nota : La distance et la distance totale sont identiques pour le premier segment. 
Toutefois, la distance totale augmentera à l’ajout de segments 
additionnels.

1er 
segment

2e segment

3e segment

Boîte de 
dialogue 
Measure 
distance

A

B

C
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3. Mesurer, au besoin, la distance d’un deuxième segment. Puisque le 
point de départ de ce segment est le point d’arrivée du premier segment 
(point B), appuyer simplement sur le nouveau point d’arrivée (C).

La ligne pointillée affiche maintenant la nouvelle mesure sur la carte. 
La distance entre les points B et C est affichée dans le champ de texte 
Distance. La distance totale entre les points A et C est affichée dans le 
champ de texte Total.

4. Poursuivre jusqu’à l’obtention de la mesure désirée.

5. Appuyer sur X dans la barre de titre de la boîte de dialogue Measure 
Distance afin de la fermer. Il est également possible de laisser cette 
boîte de dialogue affichée lors de l’accomplissement d’autres tâches.

Nota : Pour reconfigurer les mesures en tout temps, cliquer à l’aide du bouton de 
droite de la souris sur la carte.

Recherche d’éléments par des requêtes
Des recherches spécifiques permettent d’économiser du temps, plutôt que 
d’effectuer un balayage de la carte pour trouver l’élément recherché.

Recherche rapide

La méthode de recherche rapide permet d’accomplir des requêtes 
simples sur un seul attribut. Pour plus de renseignements sur les attributs, 
voir Configuration du SIG à la page 171.

IMPORTANT
Pour effectuer une recherche rapide sur des entités, celles-ci doivent 
être chargées.
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Pour effectuer une recherche rapide depuis le mode de 
visualisation géographique :

1. Depuis le menu Tools, sélectionner Quick Search...

2. Dans la section Search, entrer les paramètres de recherche.

➤ Field : nom de champ de la base de données prédéfini. Les noms 
disponibles doivent être configurés avec le Data Manager.

➤ Value : le texte ou la valeur numérique recherchée.

3. Cocher la case Exact search pour trouver seulement les éléments qui 
correspondent exactement à la valeur spécifiée. Si la case n’est pas 
cochée, FiberVisor trouvera les éléments qui contiennent la valeur.

Par exemple, lors d’une recherche du terme « RTU », sans utiliser la 
recherche exacte, le terme trouvé sera « RTU », mais également 
« RTU_cable » et « MyRTU ».

Nota : La recherche exacte s’applique aux valeurs de texte seulement.

4. Pour que FiberVisor ajoute une entrée de légende des résultats de la 
recherche, cocher la case Add in Legend. Ainsi, les résultats seront 
également sauvegardés avec le contexte actuel.

5. Pour ajouter les éléments résultants à la sélection courante, cocher la 
case Add in Select Set.
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6. Appuyer sur Select pour effectuer une recherche rapide ou appuyer sur 
Close pour retourner à la fenêtre principale de FiberVisor.

Recherche avancée

La méthode de recherche avancée (langage relationnel SQL ) permet de 
créer des requêtes complexes avec plusieurs critères de sélection de tous 
les attributs d’éléments sur la carte.

Pour utiliser la recherche avancée, il est essentiel de connaître :

➤ les fonctions de base SQL 

➤ les couches principales d’une base de données géomatique

IMPORTANT
Pour effectuer une recherche avancée (SQL) sur des entités, celles-ci 
doivent être chargées.

Pour effectuer une recherche avancée en mode de visualisation 
géographique :

1. Depuis le menu Tools, sélectionner SQL Search...

Boîte SQL

Flèches d’activation

Liste des champs Liste des valeurs

Suppression de la boîte SQL

Retour à la recherche
précédente
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2. Depuis la liste Feature name, sélectionner une couche de données où 
accomplir la recherche. Les mêmes noms apparaissent également 
dans la légende.

Lorsqu’un nom est sélectionné, tous les champs liés à cette couche 
apparaissent dans la liste au-dessous.

3. Pour créer une requête SQL :

3a. Sélectionner un champ dans la liste à l’extrême gauche et 
appuyer sur sa flèche d’activation. Le nom du champ sélectionné 
apparaît dans la boîte SQL.

3b. Pour obtenir la liste des valeurs possibles pour ce champ, appuyer 
sur Show Values. Cela peut prendre quelques minutes pour une 
base de données imposante.

3c. Appuyer sur l’un des boutons de la section Operators, située 
au centre.

3d. Sélectionner une valeur dans la liste à l’extrême droite et appuyer 
sur sa flèche d’activation, située sous la liste. La valeur 
sélectionnée apparaît dans la boîte SQL, située sous les flèches.

4. Depuis la liste Query name, attribuer un nom à la recherche. Ce nom 
sera utile pour la légende.
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5. Afin que FiberVisor ajoute une entrée de légende pour les résultats de 
la recherche, cocher la case Add in Legend. Le nom attribué dans la 
liste Query name apparaîtra dans la légende. Le cas échéant, les 
résultats seront également sauvegardés dans le contexte courant.

6. Pour ajouter les éléments résultants à la sélection courante, cocher la 
case Add in Selection.

7. Appuyer sur OK pour accomplir une recherche SQL ou appuyer sur 
Cancel pour retourner à la fenêtre principale de FiberVisor.

Personnalisation du mode de 
visualisation géographique

FiberVisor Console permet de configurer de nombreux éléments 
d’exploration sur la carte et de modifier certaines options d’exploration 
et d’affichage.

Pour configurer les paramètres du mode de visualisation géographique :

1. Sélectionner Tools > Options > ONC Options, puis cliquer sur l’onglet 
Context Option.

2. Sélectionner les couleurs pour les éléments du mode de 
visualisation géographique.
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2a. Dans la section Color, appuyer sur le bouton juxtaposant 
l’élément dont la couleur doit être modifiée.

2b. Sélectionner une couleur et appuyer sur OK. La nouvelle couleur 
sera appliquée la prochaine fois qu’un élément le requière, sauf 
pour la couleur d’arrière-plan qui est immédiatement appliquée.

Pour plus de renseignements sur le choix de couleurs, se référer à la 
documentation de Microsoft Windows.

3. Afficher ou masquer les éléments d’exploration. Depuis la section 
View, cocher les cases des éléments à afficher en mode de 
visualisation géographique. Pour plus de renseignements, voir 
Affichage ou masquage de la légende et des autres éléments 
d’exploration à la page 63.

Nota : Par défaut, tous les éléments d’exploration sont affichés. Le flèche 
indiquant le nord et l’échelle de distance ne peuvent pas être déplacées.

4. Modifier le format du curseur de la souris. Dans la section Cursor Size, 
glisser le curseur le long de l’échelle pour sélectionner le format désiré.

Le nouveau format du curseur sera appliqué dès la 
prochaine utilisation.

5. Sélectionner le répertoire dans lequel les fichiers de liaisons 
dynamiques seront sauvegardés.

6. Appuyer sur OK.
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7 Test des éléments du réseau et 
des chemins
Tests de communication automatiques

Trois fois par jour, le RTU envoie un signal au TSC, indiquant qu’il est 
fontionnel. Si le TSC ne reçoit aucun signal au cours de la journée, il 
génère une alarme.

Le RTU synchronise également son horloge à celle du TSC lorsque ce 
dernier reçoit le signal. Le TSC vérifie le fuseau horaire du RTU, puis 
sauvegarde le nouveau fuseau horaire dans sa base de données. L’heure 
indiquée sur le RTU est l’heure locale (et non celle du TSC).

Si le TSC détecte un élément du réseau qui ne fait pas partie des RTU qu’il 
gère, ou qu’un élément du réseau est inactif, il génère un avertissement.

Test de communication avec un RTU
Pour effectuer un test de communication, Client Manager envoie un signal 
(PING) vers les éléments de réseau sélectionnés. Il est essentiel de vérifier 
que la communication soit possible sur le réseau.
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Pour effectuer un test de communication :

1. Depuis le menu Tools, sélectionner Test, puis Communication...

OU

En mode de visualisation de navigation de réseau, cliquer à l’aide du 
bouton de droite de la souris sur un RTU, un commutateur à distance 
ou un TSC. Sélectionner Remote Tools, puis Communication...

2. Sélectionner les éléments à tester en cochant les cases 
correspondantes ou appuyer sur Select All. Il est également possible 
d’inverser la sélection courante.

3. Entrer ou sélectionner le nombre de fois que le système essayera 
d’envoyer un signal (PING) à l’élément. FiberVisor utilisera ce nombre 
pour chaque élément sélectionné.

4. Appuyer sur Start Test pour effectuer le test. Les résultats apparaîtront 
sous forme de liste déroulante dans la boîte Result.

5. Il est possible d’effectuer d’autres tests. Une fois que tous les tests sont 
accomplis, appuyer sur Close.
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Nota : Il est possible d’arrêter le test en tout temps en appuyant sur Stop Test.

Utilisation de Service Manager
Service Manager permet de visualiser l’état et l’option de démarrage des 
applications. Pour accéder au Service Manager, cliquer deux fois sur 
l’icône correspondante depuis le bureau Windows.

Pour démarrer une application, la sélectionner, puis appuyer sur Start.

Pour arrêter une application, la sélectionner, puis appuyer sur Stop.

Pour modifier le type de démarrage :

1. Sélectionner une application, puis appuyer sur Startup...
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2. Sélectionner le type de démarrage désiré pour l’application :

➤ Automatic : l’application démarrera automatiquement lors de la 
mise sous tension du RTU.

➤ Manual : il est nécessaire de démarrer l’application 
manuellement.

➤ Disabled : il est impossible de lancer cette application.

3. Appuyer sur OK pour confirmer le changement et retourner à la fenêtre 
Service Manager, ou sur Cancel pour retourner à cette fenêtre sans 
modifier le type de démarrage.

Visualisation de l’activité d’un RTU
Lorsque vous travaillez localement sur un RTU ou à distance sur un ONC, 
il est possible de surveiller l’activité courante sur le RTU, l’historique des 
alarmes générées par le RTU, ou les deux, en utilisant l’application Viewer.

Les événements locaux, les événements surveillés et les statistiques sont 
affichés dès qu’ils se présentent. Les événements qui se produisent avant 
de lancer l’application Viewer ne seront pas affichés. 

Nota : Il est essentiel d’utiliser le Viewer Console sur un RTU pour visualiser 
l’historique des alarmes ou pour accomplir des opérations liées 
aux événements.
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Nota : Les dates et les heures sont affichées dans le fuseau horaire du RTU local.

Nota : Lorsque l’utilisateur travaille à l’aide d’un commutateur à distance, il est 
seulement possible de visualiser l’onglet System. En effet, puisqu’un 
commutateur à distance ne comprend aucun module de test, il ne peut pas 
surveiller des câbles ou cumuler des statistiques.

Accès au Viewer du RTU depuis un ONC

Pour visualiser l’activité d’un RTU depuis FiberVisor Console :

1. Dans le menu Tools, sélectionner Current Activity.

OU

Dans le mode de visualisation de navigation de réseau, cliquer à l’aide 
du bouton de droite de la souris sur un RTU ou un commutateur à 
distance. Sélectionner Remote Tools, puis Viewer...

Onglets de 
l’application 
Viewer
Événements 
courants sur ce 
RTU (du plus 
récent au plus 
ancien)

Historique des 
alarmes pour ce 
RTU (de la plus 
récente à la plus 
ancienne)

Version du 
logiciel du RTU

Indication de l’état des 
opérations liées à l’onglet 
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2. Dans la boîte de dialogue Select RTU, sélectionner le RTU dont 
l’activité doit être visionnée.

Nota : Lorsque l’utilisateur n’a aucun droit d’accès à un RTU particulier, ce dernier 
n’apparaîtra pas dans la liste déroulante de la boîte de dialogue 
Select RTU.

3. Appuyer sur OK. Client Manager établit la communication avec le RTU 
et l’application Viewer s’affiche, de la même façon que lorsque 
l’utilisateur travaille directement avec le RTU.

Nota : Si le système ne peut pas être branché à un RTU, un message 
d’erreur apparaîtra.

4. Sélectionner l’onglet incluant l’information à visualiser.

➤ Onglet System : les événements du système seulement.

➤ Onglet OTDR Monitoring : l’activité de surveillance actuelle.

➤ Onglet WDM Monitoring : l’activité de surveillance actuelle.

➤ Onglet Statistics : disponibles seulement depuis le RTU.

5. Une fois la consultation pour l’activité de ce RTU effectuée, 
sélectionner Exit dans le menu File. L’utilisateur est ainsi débranché 
du RTU.

Si la connexion est interrompue à tout moment pendant que l’application 
Viewer est affichée, un message indiquera que le RTU n’est plus 
disponible. Deux choix s’offrent à l’utilisateur : essayer de joindre de 
nouveau le RTU ou annuler la commande.
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Accès local au Viewer du RTU

Pour visualiser l’activité actuelle du RTU sur lequel l’utilisateur 
travaille localement :

1. Cliquer deux fois sur l’icône Viewer depuis le bureau du RTU pour 
afficher l’application Viewer.

OU

Dans le menu Start, sélectionner Programs, FiberVisor Client, 
puis Viewer.

2. Sélectionner l’onglet incluant l’information à consulter.

➤ Onglet System : des événements et des défauts du système, tels 
que le traitement ou des erreurs d’équipements.

➤ Onglet OTDR Monitoring : l’activité et les erreurs de qualité du 
service liées à la surveillance actuelle de l’OTDR.

➤ Onglet WDM Monitoring : l’activité et les erreurs de qualité du 
service liées à la surveillance actuelle de l’OSA.

➤ Onglet Statistics : des statistiques de la surveillance de l’OTDR de 
chaque chemin configuré dans le RTU. Les statistiques sont tout 
d’abord triées par le nom de fichier de la trace de référence, puis 
par la date d’acquisition. Les statistiques incluent également le 
type d’événement, la distance à laquelle il est situé, tout 
commentaire lié à celui-ci, la perte moyenne, minimale et 
maximale ainsi que le seuil de référence.

3. Dans le menu View, choisir entre visualiser l’activité actuelle, 
l’historique des alarmes, ou les deux simultanément.

4. Une fois la consultation pour l’activité de ce RTU effectuée, 
sélectionner Exit dans le menu File.
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Suppression de l’information sur l’activité 
ou l’historique

Pour supprimer l’activité actuelle ou l’historique des alarmes dans 
n’importe quel des onglets, sélectionner l’élément correspondant dans le 
menu Edit.

Pour effacer toute activité courante et l’historique des alarmes, 
sélectionner Clear All dans le menu Edit.

Test sur demande
Afin d’effectuer un test sur demande (TOD), l’utilisateur doit avoir ouvert 
une session en tant qu’opérateur et avoir les droits d’accès au RTU sous 
test. La surveillance sur ce RTU doit être active.

IMPORTANT
Lors d’un test sur demande, le RTU arrête la séquence de surveillance 
courante. Il reprendra la surveillance une fois que le test sur demande 
sera terminé.

Pour effectuer un test sur demande :

1. Depuis le menu Tools, sélectionner Test, puis Test on demand... La 
boîte de dialogue Select RTU apparaît.

2. Sélectionner un RTU dans la liste déroulante, puis appuyer sur OK. La 
boîte de dialogue Select a Path apparaît.
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3. Sélectionner le chemin où effectuer le test, puis appuyer sur OK. 
La boîte de dialogue Test on Demand apparaît.

4. Sélectionner la trace de référence à utiliser comme base pour le test.

5. Attribuer un nom de fichier à la trace résultante.

6. Pour continuer de recevoir des notifications d’alarmes durant le test, 
cocher la case With Alarm Detection.

7. Appuyer sur Test On Demand. FiberVisor Console envoie la demande 
de test au RTU.
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Lorsque le RTU reçoit la demande de test :

➤ Il interrompt sa séquence de surveillance en cours aussi rapidement 
que possible, même si elle fait partie du processus d’itération.

➤ Il effectue le test requis et sauvegarde la trace résultante sur le RTU, 
sous le nom fourni par l’utilisateur.

➤ Il reprend la séquence de surveillance où elle avait été interrompue.

➤ La trace est envoyée au TSC et sauvegardée dans sa base de données. 
La trace est également supprimée du RTU.

➤ Une fois le test complété, FiberVisor envoie une notification à 
l’utilisateur. Une icône représentant un éclair clignotera au coin 
inférieur droit de la barre de tâches. Cliquer deux fois sur l’icône pour 
visualiser tout message de notification.

Visualisation des résultats d’un test sur demande

Pour visualiser la trace résultant d’un test sur demande d’un chemin testé :

1. En mode de visualisation de l’explorateur de réseau, sélectionner 
le chemin testé.

Fichier comprenant des traces 
d’un test sur demande
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2. Ouvrir le fichier Traces, puis le sous-répertoire Test on Demand 
Related. Ce dernier inclut toutes les traces acquises lors des tests sur 
demande du chemin sélectionné.

3. Sélectionner la trace à analyser, puis cliquer à l’aide du bouton de 
droite de la souris sur celle-ci pour ouvrir le menu contextuel. Il est 
possible de prévisualiser la trace ou d’y ajouter des commentaires.

Dépannage de tests sur demande

La tableau ci-dessous liste les problèmes courants liés à 
l’accomplissement d’un test sur demande.

Problèmes Causes Solutions

RTU non 
disponible

➤ Le RTU n’a pas commencé 
la surveillance.

➤ Un autre utilisateur 
effectue déjà un test sur 
demande avec le RTU.

Attendre et lancer le test 
sur demande plus tard.

Données de 
test sur 
demande 
erronées

La configuration du RTU a 
changé et les données ne 
correspondent pas à la 
configuration utilisée.

Attendre la nouvelle 
configuration du RTU et 
entrer de nouveau les 
données du test 
sur demande.

Le test sur 
demande 
a échoué

La surveillance a été arrêtée 
par un utilisateur du RTU local 
avant ou pendant que le test 
était effectué.

Refaire le test sur 
demande.

Une erreur est survenue 
durant le test sur demande.

Le TSC génère une 
alarme pour signaler un 
problème d’exécution si 
l’option With alarm 
detection a été 
sélectionnée dans la 
fenêtre Test on Demand.
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Si le RTU détecte une anomalie qui n’est pas liée au test sur demande et 
que la détection d’alarmes est activée, la surveillance sera accomplie avec 
les opérations planifiées.

Si cette anomalie se transforme en défaut, une alarme sera générée.

Impossible 
d’envoyer une 
trace du test 
sur demande 
au TSC

Le lien de communication 
entre le TSC et le RTU 
est rompu.

Le RTU transmettra les 
données de test 
ultérieurement, lorsque le 
lien sera rétabli.
Le TSC avisera 
l’utilisateur lorsque le test 
sur demande 
sera complété.

Problèmes Causes Solutions
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8 Exploration des données 
recueillies en utilisant 
les assistants (Wizards)
Exploration de l’historique des alarmes

Il est possible d’utiliser l’assistant Alarm History pour visualiser des détails 
au sujet de toutes les alarmes que FiberVisor a générées depuis 
son installation.

Il est possible de choisir d’afficher des alarmes :

➤ liées à des éléments particuliers du réseau (des RTU ou des 
commutateurs à distance)

➤ selon un type particulier

➤ en ordre chronologique

Nota : Les résultats de recherche des assistants sont utilisés à des fins de 
visualisation et d’analyse seulement.

Ouverture et fermeture de l’assistant Alarm 
History
Pour lancer l’assistant Alarm History, ouvrir le menu Tools, puis 
sélectionner Wizards et Alarm History. Dans l’assistant, il est essentiel de 
passer à travers une série d’étapes pour définir les alarmes à inclure et la 
façon dont elles seront affichées.
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Utiliser les boutons d’exploration pour passer d’une étape à une autre. 
Pour quitter l’assistant en tout temps, appuyer sur Cancel.

Sélection d’une méthode de recherche

À l’étape Choose an Option, sélectionner le type de recherche désiré.

➤ Network Element : pour trouver des alarmes liées à des éléments 
particuliers du réseau (des RTU ou des commutateurs à distance).

➤ Alarm Type : pour trouver des alarmes d’un type particulier.

➤ Chronological : pour afficher des alarmes en ordre chronologique. 

Boutons 
d’exploration
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Nota : La recherche chronologique est celle utilisée pour visualiser simultanément 
chaque type d’alarme et d’événement du réseau.

Les trois sections suivantes aborderont les spécificités de chaque méthode 
de recherche. Des étapes de base pour compléter la recherche de 
l’assistant sont expliquées dans Sélection de critères de recherche et de 
sortie communs à la page 100.

Appuyer sur Next pour passer à l’étape suivante.

Recherche d’alarmes pour des éléments 
particuliers de réseau

1. À l’étape Select Network Elements, depuis la liste des 
éléments disponibles, choisir les éléments de réseau pour lesquels 
une historique d’alarmes est requise.

Pour inclure des éléments de réseau dans les résultats, les déplacer 
vers la liste de droite en utilisant les boutons >, >> ou <, <<.

Appuyer sur Next pour passer à l’étape suivante.

2. À l’étape Select Network Element Options, choisir entre visualiser des 
alarmes qui sont liées à un chemin ou à des points de mesure et des 
alarmes qui ne le sont pas.
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➤ Relative to Path or Measurement Point : pour visualiser seulement 
des alarmes liées à un chemin particulier ou à un point de mesure.

➤ Non-Relative to Path or Measurement Point : pour visualiser 
seulement des alarmes qui ne sont pas liées à un chemin 
particulier ou à un point de mesure.

Appuyer sur Next pour passer à l’étape suivante.

3. À l’étape Select Paths and Measurement Points, sélectionner les éléments 
dont les alarmes correspondantes doivent être visualisées. Cette étape est 
présentée seulement si Path and Measurement Point a été 
sélectionné auparavant.

Pour spécifier les chemins ou les points de mesure à considérer, les 
déplacer vers la liste de droite en utilisant les boutons >, >> 
ou <, <<.
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4. Appuyer sur Next pour définir les critères de recherche génériques et la 
méthode de sortie.

Recherche de messages d’alarmes spécifiques

1. À l’étape Select Alarm Type, sélectionner les messages d’alarmes à 
inclure dans la liste à gauche des types de messages possibles.

Pour inclure des messages d’alarmes dans les résultats, les déplacer 
vers la liste de droite en utilisant les boutons >, >> ou <, <<.

2. Appuyer sur Next pour définir les critères de recherche génériques et la 
méthode de sortie.

Affichage de toutes les alarmes par 
ordre chronologique

Aucune opération spécifique ne doit être effectuée pour cette méthode de 
recherche. Il s’agit seulement de définir les critères de recherche 
spécifiques et la méthode de sortie, tel qu’il est expliqué dans la section 
suivante.
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Sélection de critères de recherche et de 
sortie communs

Les étapes suivantes sont communes à toutes les méthodes de recherche. 
Pour plus de renseignements sur chaque méthode de recherche, consulter 
les sections précédentes.

1. À l’étape Select Dates, sélectionner la période de temps de 
visualisation de l’historique des alarmes. La période par défaut 
consiste aux 30 derniers jours.

1a. Depuis la liste From, sélectionner ou entrer la date à laquelle la 
recherche doit commencer.

1b. Depuis la liste To, sélectionner ou entrer la date à laquelle la 
recherche doit se terminer.

1c. Appuyer sur Next pour passer à l’étape suivante.

2. À l’étape Select Severity, sélectionner les niveaux de gravité des 
alarmes à inclure dans l’historique des alarmes.
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2a. Dans la section Type, cocher les cases désirées. Il est possible 
d’en sélectionner une, plusieurs ou toutes.

2b. Appuyer sur Next pour passer à l’étape suivante.

3. À l’étape Select Action, sélectionner la méthode de sortie à utiliser pour 
visualiser les résultats de recherche d’alarmes.

➤ View : pour visualiser l’historique des alarmes à l’écran, tel qu’il est 
illustré à la figure de la page suivante. Pour plus de renseignements 
sur le contenu de cette fenêtre, voir Visualisation des alarmes 
actuelles sur un ONC à la page 33.

➤ Print : pour imprimer l’historique des alarmes à l’aide de 
l’imprimante désirée. L’utilisateur devra sélectionner 
une imprimante.

➤ Print to file : pour exporter et sauvegarder des résultats de 
recherche dans le fichier désiré. L’utilisateur devra spécifier un 
nom de fichier. Le fichier sera exporté en format Standard 
Delimited (.TXT) et pourra être ouvert dans d’autres applications 
de gestionnaire de tableaux ou de traitement de texte. Chaque 
colonne du fichier en format texte sera séparée par une 
barre verticale (|).
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4. Appuyer sur Next pour passer à l’étape suivante ou appuyer sur Finish 
une fois toutes les opérations terminées.

Exploration de l’inventaire matériel et logiciel
Il est possible d’utiliser l’assistant Inventory (inventaire) pour obtenir 
l’information au sujet de tous les modules logiciels et le matériel installés 
sur les composants de FiberVisor.

Cette inventaire comprend ce qui suit :

➤ le nom, le no de version et la date d’installation du logiciel

➤ le nom, la description, la connexion et la date d’installation du matériel

Nota : Les résultats de recherche des assistants sont utilisés à des fins de 
visualisation et d’analyse seulement.
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Ouverture et fermeture de l’assistant Inventory 
Pour lancer l’assistant Inventory, ouvrir le menu Tools, puis sélectionner 
Wizards et Inventory. Dans l’assistant, il est essentiel de passer à travers 
une série d’étapes pour sélectionner des éléments de réseau à inventorier 
et la façon dont les résultats seront affichés.

Utiliser les boutons d’exploration pour passer d’une étape à une autre. 
Pour quitter l’assistant en tout temps, appuyer sur Cancel.

Boutons 
d’exploration
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Sélection d’éléments de réseau et d’une méthode 
de visualisation

1. À l’étape Select Network Elements, depuis la liste des éléments 
disponibles, choisir ceux dont l’inventaire est requis.

Pour inclure des éléments de réseau dans les résultats, les déplacer 
vers la liste de droite en utilisant les boutons >, >> ou <, <<.

Appuyer sur Next pour passer à l’étape suivante.

2. À l’étape Select Action, sélectionner la méthode de sortie à utiliser pour 
visualiser des résultats de l’inventaire.

➤ View : pour visualiser l’inventaire à l’écran, tel qu’il est illustré à la 
figure suivante.
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➤ Print (hardware/software) : pour imprimer l’inventaire matériel 
OU logiciel à l’aide de l’imprimante désirée. L’utilisateur devra 
sélectionner une imprimante.

➤ Print to file (hardware/software) : pour exporter et sauvegarder 
l’inventaire du matériel OU du logiciel dans le fichier sélectionné. 
L’utilisateur devra spécifier un nom de fichier. Le fichier sera 
exporté en format Standard Delimited (.TXT) et pourra être ouvert 
dans d’autres applications de gestionnaire de tableaux ou de 
traitement de texte. Chaque colonne du fichier en format texte 
sera séparée par une barre verticale (|).

3. Appuyer sur Finish une fois les opérations terminées.

Exploration des statistiques de réseau
Il est possible d’utiliser l’assistant Statistics pour visualiser des statistiques 
au sujet d’un chemin particulier ou d’un point de mesure. Ces statistiques 
incluent les événements OTDR, la perte pour chaque événement, une 
perte moyenne et une perte totale.

Nota : Les résultats de recherche des assistants sont utilisés à des fins de 
visualisation et d’analyse seulement.

Système opérationnel 
installé sur cet élément 
de réseau

Logiciel tournant sur 
cet élément de réseau

Matériel installé sur 
cet élément de réseau

Liste des éléments de
réseau sélectionnés à

la première étape
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Ouverture et fermeture de l’assistant Statistics
Pour lancer l’assistant Statistics, ouvrir le menu Tools, puis sélectionner 
Wizards et Statistics. Dans l’assistant, il est essentiel de passer à travers une 
série d’étapes pour définir les statistiques à inclure et la façon dont elles 
seront affichées.

Utiliser les boutons d’exploration pour passer d’une étape à une autre. 
Pour quitter l’assistant en tout temps, appuyer sur Cancel.

Boutons 
d’exploration
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Sélection des statistiques et de la méthode 
de visualisation

1. À l’étape Select Network Elements, depuis la liste des éléments de 
réseau disponibles, choisir ceux dont les statistiques sont requises.

Pour inclure un élément du réseau dans les résultats, le déplacer vers 
la liste de droite en utilisant les boutons >, >> ou <, <<.

Appuyer sur Next pour passer à l’étape suivante.

2. À l’étape Select Statistic Type, sélectionner entre visualiser des 
statistiques pour un test OTDR ou WDM.

Appuyer sur Next pour passer à l’étape suivante.
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3. À l’étape Select Path or Measurement Point, sélectionner, depuis la liste 
des chemins disponibles pour l’élément du réseau, le chemin ou le 
point de mesure dont les statistiques doivent être visualisées.

Appuyer sur Next pour passer à l’étape suivante.

4. À l’étape Select Dates, sélectionner la période de temps qui doit être 
couverte par les statistiques. La période par défaut consiste aux 30 
derniers jours.

4a. Depuis la liste From, sélectionner ou entrer la date à laquelle la 
recherche doit commencer.

4b. Depuis la liste To, sélectionner ou entrer la date à laquelle la 
recherche doit se terminer.

4c. Appuyer sur Next pour passer à l’étape suivante.
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5. À l’étape Select Option, sélectionner la trace de référence à utiliser en 
tant que base pour les statistiques, puis sélectionner l’intervalle 
de temps.

Appuyer sur Next pour passer à l’étape suivante.

6. À l’étape Select Output, sélectionner la méthode de sortie à utiliser 
pour visualiser les résultats.

➤ View : pour visualiser les statistiques à l’écran.
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➤ Print to files : pour exporter et sauvegarder les statistiques dans le 
fichier désiré. L’utilisateur devra spécifier un nom de fichier. Le 
fichier sera exporté en format Standard Delimited (.TXT) et pourra 
être ouvert dans d’autres applications de gestionnaire de tableaux 
ou de traitement de texte. Chaque colonne du fichier en format 
texte sera séparée par une barre verticale (|).

Appuyer sur Next pour visualiser ou imprimer des résultats.

7. Appuyer sur Finish, une fois les opérations terminées.

Exploration des traces acquises
Il est possible d’utiliser l’assistant Trace pour visualiser des traces acquises 
ou sauvegardées, ou d’autres types de fichiers depuis l’installation de 
FiberVisor.
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Il est possible d’afficher les types de traces suivantes générées par le RFTS :

➤ traces de référence (OTDR, OSA)

➤ traces générant des alarmes

➤ traces acquises par l’utilisateur à l’aide d’un test sur demande

➤ traces d’échantillonnage

Il est également possible d’afficher des fichiers non RFTS, tels que des 
traces OLTS (MultiTest) et d’autres fichiers d’applications Windows.

Nota : Les résultats de recherche des assistants sont pour des fins de visualisation 
et d’analyse seulement.

Ouverture et fermeture de l’assistant Trace
Pour lancer l’assistant Trace, ouvrir le menu Tools, puis sélectionner 
Wizards et Traces. Dans l’assistant, il est essentiel de passer à travers une 
série d’étapes pour définir les traces à inclure et la façon dont elles 
seront affichées.

Utiliser les boutons d’exploration pour passer d’une étape à une autre. 
Pour quitter l’assistant en tout temps, appuyer sur Cancel.

Boutons 
d’exploration
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Sélection des traces désirées

1. À l’étape Select Network Elements, choisir les éléments du réseau 
auxquels les traces désirées sont associées.

Pour inclure des éléments du réseau dans les résultats, les déplacer 
vers la liste de droite en utilisant les boutons >, >> ou <, <<.

Appuyer sur Next pour passer à l’étape suivante.

2. À l’étape Select an Option, choisir de visualiser des traces OTDR, OSA, 
OLTS ou autres (tout fichier de type BMP, JPG et HTML).

Appuyer sur Next pour passer à l’étape suivante.
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Nota : Si l’utilisateur a choisi les traces OTDR, suivre toutes les étapes. Sinon, 
sauter les étapes 3 à 5.

3. À l’étape Select Path, dans la liste de chemins de l’élément du réseau, 
choisir le chemin auquel les traces désirées sont associées.

Pour inclure des chemins dans les résultats, les déplacer vers la liste de 
droite en utilisant les boutons >, >> ou <, <<.

Appuyer sur Next pour passer à l’étape suivante.

4. À l’étape Select Trace Type, sélectionner les types de traces OTDR à 
inclure dans les résultats.

4a. À la section Type, cocher les cases désirées. Il est possible d’en 
sélectionner une, plusieurs ou toutes.

4b. Appuyer sur Next pour passer à l’étape suivante.
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5. À l’étape Apply Filter, définir un masque pour les noms et les 
extensions de fichiers de traces à inclure dans les résultats.

Appuyer sur Next pour passer à l’étape suivante.

6. À l’étape Select Dates, sélectionner la période de temps durant laquelle 
les traces auront été acquises. La période par défaut consiste aux 30 
derniers jours.

6a. Dans la liste From, sélectionner ou entrer la date à laquelle la 
recherche doit commencer.

6b. Dans la liste To, sélectionner ou entrer la date à laquelle la 
recherche doit se terminer.

6c. Appuyer sur Next pour passer à l’étape suivante.
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7. À l’étape View Result, le nombre de résultats correspondants aux 
descriptions prédéterminées par l’utilisateur sera affiché.

8. À l’étape Select Action, dans la section Actions, sélectionner l’action à 
effectuer sur les résultats de recherche de traces. 

➤ View : pour visualiser les traces à l’écran.

➤ Print : pour imprimer les traces à l’aide de l’imprimante désirée. 
L’utilisateur devra sélectionner une imprimante.

➤ Print to file : pour exporter ou sauvegarder des traces dans le 
fichier désiré. L’utilisateur devra spécifier un nom de fichier. Le 
fichier sera exporté en format Standard Delimited (.TXT) et pourra 
être ouvert dans d’autres applications de gestionnaire de tableaux 
ou de traitement de texte. Chaque colonne du fichier en format 
texte sera séparée par une barre verticale (|).
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9. À l’étape View Traces, faire défiler l’information sur les traces en 
utilisant la barre de défilement horizontale située au bas de l’écran 
(et à la droite si la liste comprend assez d’entrées). 

Le tableau affiche l’information suivante :

➤ nom de fichier

➤ nom de l’élément du réseau

➤ date et heure de l’élément du réseau

➤ type de trace

➤ type d’acquisition

➤ nom du chemin ou du point de mesure
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10. Appuyer sur Preview Trace pour visualiser la trace sélectionnée.

11. Appuyer sur Finish une fois les opérations terminées.
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9 Configuration d’un RTU
Configurer l’unité de vérification à distance (RTU) avant de l’utiliser pour 
l’acquisition de traces de référence et la surveillance d’une partie du 
réseau de fibres (ou tout changement qui doit être effectué au réseau ou 
au matériel).

Compréhension du processus de 
configuration

La configuration d’un RTU comprend les éléments suivants :

➤ matériel du RTU (modules de test, téléavertisseur de rechange et 
option Watchdog)

➤ ports RTU (chemins optiques, traces de référence et seuils 
de surveillance)

➤ tâches et séquence de surveillance 

➤ seuils de test par défaut

Il est possible de configurer ces éléments depuis le RTU ou à distance 
depuis un ONC. Le diagramme suivant représente les étapes de la 
configuration à distance d’un RTU.

RTU TSCWAN

ONC

Registre du 
RTU

Base de 
données sur 

le TSC1

23

4

5
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Lors de la configuration à distance d’un RTU , configurer les paramètres du 
RTU sur un ONC (1) à l’aide de FiberVisor Console. La configuration est par 
la suite envoyée au RTU (2), où elle est sauvegardée en tant que 
configuration locale (3).

Les configurations locales et à distance sont toujours envoyées au TSC (4) 
afin d’être sauvegardées dans une base de données centrale (5). Ainsi, les 
autres utilisateurs ONC peuvent y accéder.

IMPORTANT
Pour configurer un RTU localement ou à distance, l’utilisateur doit 
avoir ouvert une session en tant que gestionnaire ou administrateur 
et avoir les droits d’accès appropriés à ce RTU. Il est également 
possible d’ouvrir une session sur le RTU en tant qu’utilisateur local.

Pour plus de renseignements sur les droits d’accès au RTU, voir Niveaux 
d’accès et fonctions restrictives à la page 7.

Lors de la configuration d’un RTU, s’assurer que celui-ci satisfait aux 
conditions suivantes :

➤ le logiciel FiberVisor Client fonctionne en arrière-plan.

➤ le RTU est réservé pour l’utilisateur (voir la section ci-dessous).

➤ toutes les opérations de surveillance sont arrêtées.

➤ la communication avec le TSC est possible depuis le RTU. 

Réservation d’un RTU
Vous devez réserver un RTU lorsque vous le configurez. La réservation 
signifie que vous êtes le seul à configurer le RTU.

Si un utilisateur configure le RTU localement ou qu’un utilisateur ONC le 
configure à distance, il vous sera impossible de le faire.
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Lors d’une demande de configuration d’un RTU, FiberVisor essayera 
automatiquement de le réserver. Si la réservation réussit, le RTU sera 
accessible à l’utilisateur. Il peut ainsi bloquer les autres utilisateurs.

Accès local à la configuration du RTU
Il est possible de modifier directement la configuration d’un RTU si 
l’utilisateur a accès à la localisation physique du RTU. Pour plus de 
renseignements sur les tâches à accomplir avant de commencer le 
processus de configuration et les différentes étapes à suivre, voir 
Compréhension du processus de configuration à la page 119 et Réservation 
d’un RTU à la page 120.

Nota : Lors d’une configuration locale d’un RTU, l’accès à la configuration du RTU 
n’est pas permis à d’autres utilisateurs ONC.

Pour configurer localement les paramètres sur le RTU lui-même :

1. Cliquer deux fois sur l’icône Configure sur le bureau du RTU. La fenêtre 
FiberVisorClient Configuration apparaît.
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Nota : Si un utilisateur ONC configure à distance le RTU au même moment, vous 
devrez attendre que le RTU devienne disponible. Si une séquence de 
surveillance est en cours, vous devrez l’arrêter avant de procéder.

2. Configurer les paramètres RTU en suivant l’ordre ci-dessous. Les 
paramètres et les options de configuration sont expliqués dans les 
sections suivantes.

2a. Définir les seuils de test par défaut.

2b. Configurer le matériel du RTU (modules de test, téléavertisseur de 
rechange et option Watchdog).

2c. Associer manuellement les ports du RTU avec les chemins 
optiques à surveiller ainsi qu’avec les traces de référence à 
utiliser, et définir les seuils de surveillance pour ces ports.

2d. Définir les tâches de surveillance, les autres tâches et la séquence 
à laquelle toutes les tâches seront exécutées.

3. Une fois la configuration établie, appuyer sur Close pour confirmer que 
les nouvelles configurations seront sauvegardées dans le registre du 
RTU. Appuyer sur Cancel pour annuler les changements. Les autres 
utilisateurs pourront maintenant accéder au RTU.

4. Si les opérations de surveillance ont été arrêtées lors de l’accès à la 
configuration du RTU, dans la boîte de confirmation, appuyer sur Yes 
pour qu’elles reprennent leur cours.

Une fois que le RTU a sauvegardé les nouvelles configurations, il les envoie 
au TSC afin qu’elles soient sauvegardées sur la base de données centrale. 
Les utilisateurs de FiberVisor Console sont également avisés qu’une 
nouvelle configuration est maintenant utilisée.

Si le RTU ne peut pas communiquer avec le TSC, il enverra la configuration 
ultérieurement. Entre-temps, la configuration sera conservée localement 
sur le RTU.
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IMPORTANT
Le TSC ne peut pas accepter ou corriger une configuration 
partiellement valide. Si le TSC découvre un problème dans la nouvelle 
configuration, il générera un défaut. Par exemple, cela pourrait se 
produire lorsqu’un administrateur efface un chemin au moment où la 
configuration est envoyée.

Si l’utilisateur a spécifié que les traces de référence doivent être acquises 
en utilisant une configuration automatique, le RTU effectuera l’acquisition 
de ces traces, puis les enverra au TSC. Voir Définition des traces de 
référence pour un port à la page 143.

Accès à la configuration du RTU depuis un ONC
Il est possible de modifier la configuration d’un RTU en utilisant FiberVisor 
Console sur n’importe quel ONC. Toutefois, aucune donnée de 
configuration n’est sauvegardée sur le ONC. Pour plus de renseignements 
sur les tâches à accomplir avant de commencer le processus de 
configuration et sur les différentes étapes à suivre, voir Compréhension du 
processus de configuration à la page 119 et Réservation d’un RTU à la 
page 120.

Nota : Pendant que la configuration à distance d’un RTU s’effectue, l’accès à la 
configuration du RTU est refusé aux autres utilisateurs ONC ainsi qu’à 
l’utilisateur local du RTU.

Pour configurer à distance les paramètres du RTU depuis un ONC :

1. Dans le menu Tools, sélectionner Remote Configuration, puis choisir le 
RTU dans la liste de tous les RTU actifs pouvant être accédés avec 
votre profil d’utilisateur.
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Depuis l’un des modes de visualisation de l’explorateur (Network 
Topology, Network History ou Optical Link), cliquer à l’aide du bouton 
de droite de la souris sur le RTU, puis sélectionner Remote Tools et 
RTU Configuration dans le menu contextuel.

Si le RTU sélectionné est disponible, la fenêtre FiberVisorClient 
Configuration s’affichera.

Nota : Si un utilisateur RTU local ou un autre utilisateur ONC configure ce RTU au 
même moment, vous devrez attendre que le RTU devienne disponible. 
Si une séquence de surveillance est en cours, vous devrez l’arrêter avant 
de procéder.
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2. Configurer les paramètres du RTU selon l’ordre ci-dessous. Les 
paramètres et les options de configuration sont expliqués dans les 
sections suivantes.

2a. Définir les seuils de test par défaut.

2b. Configurer le matériel du RTU (modules de test, téléavertisseur de 
rechange et option Watchdog).

2c. Associer manuellement les ports du RTU avec les chemins 
optiques à surveiller ainsi qu’avec les traces de référence à 
utiliser, et définir les seuils de surveillance pour ces ports.

2d. Définir les tâches de surveillance, les autres tâches et la séquence 
à laquelle toutes les tâches doivent être exécutées.

3. Une fois la configuration établie, appuyer sur Close pour confirmer que 
les nouvelles configurations seront sauvegardées dans le registre du 
RTU. Appuyer sur Cancel pour annuler les changements. Les autres 
utilisateurs pourront maintenant accéder au RTU.

4. Si les opérations de surveillance ont été arrêtées lors de l’accès à la 
configuration du RTU, dans la boîte de confirmation, appuyer sur Yes 
pour qu’elles reprennent leur cours.

Une fois que le RTU a sauvegardé les nouvelles configurations, il les envoie 
au TSC afin qu’elles soient sauvegardées sur la base de données centrale. 
Les utilisateurs de FiberVisor Console sont également avisés qu’une 
nouvelle configuration est maintenant utilisée.

Si le RTU ne peut pas communiquer avec le TSC, il enverra la configuration 
ultérieurement. Entre-temps, la configuration sera conservée localement 
sur le RTU.
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IMPORTANT
Le TSC ne peut pas accepter ou corriger une configuration 
partiellement valide. Si le TSC découvre un problème dans la nouvelle 
configuration, il générera un défaut. Par exemple, cela pourrait se 
produire lorsqu’un administrateur efface un chemin au moment où la 
configuration est envoyée.

Si l’utilisateur a spécifié que les traces de référence doivent être acquises 
en utilisant une configuration automatique, le RTU effectuera l’acquisition 
de ces traces, puis les enverra au TSC. Voir Définition des traces de 
référence pour un port à la page 143.

Test du lien avec le TSC
Lorsqu’un RTU n’est pas configuré en tant qu’équipement autonome, 
l’utilisateur devra configurer et tester le lien avec le contrôleur du système 
de test (TSC) dans la boîte de dialogue TSC Properties.

Si le test n’est pas effectué ou s’il échoue, l’utilisateur ne pourra pas se 
brancher au TSC. Le test peut échouer pour les raisons suivantes :

➤ les câbles ne sont pas branchés correctement.

➤ le protocole TCP/IP n’est pas configuré correctement.

➤ l’adresse IP du TSC est erronée.

➤ l’identification interne du RTU est incorrecte dans la base de données 
(rafraîchir la configuration pour résoudre le problème).

➤ le RTU ou le commutateur à distance n’existe pas dans la base de 
données (utiliser FiberVisor Console sur un ONC pour la créer).

Pour tester un lien RTU-TSC :

1. Sélectionner l’onglet Hardware de la fenêtre RTU Configuration. 
La section TSC illustre les configurations du lien TSC.

2. Appuyer sur Test pour tester la communication entre le RTU et le TSC. 
Ce test vérifie si le RTU est actif et s’il est reconnu par le TSC.
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Configuration du Watchdog
Par défaut, le Watchdog n’est pas configuré et son port de communication 
est configuré à « None ».

Pour configurer et activer le Watchdog :

1. Depuis la fenêtre RTU Configuration, sélectionner l’onglet Hardware.

2. Depuis la section Peripheral, sélectionner Watchdog.

3. Appuyer sur Configure... pour afficher la boîte de dialogue 
Watchdog Properties.

4. Dans la liste Port, sélectionner le port de communication de série 
auquel le Watchdog est branché. Il est possible de choisir du port 
COM1 à COM4. S’assurer toutefois de ne pas sélectionner un port qui 
est déjà utilisé par le téléavertisseur de rechange ou par un 
commutateur externe.

5. Appuyer sur Test pour effectuer un test de communication entre le RTU 
et le Watchdog.

Nota : Si le test n’est pas effectué ou qu’il a échoué, il sera impossible d’activer le 
Watchdog et le bouton OK apparaîtra grisé.

6. Cocher la case Enabled pour activer le Watchdog. Si ce dernier est 
désactivé, il est possible de sauvegarder la configuration, même en 
omettant le test.

7. Appuyer sur OK pour accepter les modifications, ou sur Cancel pour 
rétablir la configuration initiale du Watchdog.
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Configuration du téléavertisseur de rechange
Lorsqu’il est impossible pour le RTU d’aviser les utilisateurs de la présence 
d’une alarme à l’aide des moyens de communication usuels (par exemple, 
étant donné un bris dans un lien de communication), il utilisera le 
téléavertisseur de rechange pour envoyer un message à un utilisateur 
prédéfini.

Par défaut, le téléavertisseur de rechange n’est pas configuré et son port de 
communication est configuré à « None ».

Pour configurer et activer le téléavertisseur de rechange :

1. Depuis la fenêtre RTU Configuration, sélectionner l’onglet Hardware.

2. Depuis la section Peripheral, sélectionner Pager.

3. Appuyer sur Configure... La boîte de dialogue 
Pager Properties s’affiche.

4. Dans la boîte de dialogue Pager Properties, configurer les 
paramètres suivants :

➤ le numéro de téléphone et le numéro d’identification du 
téléavertisseur (pourvus par le fournisseur du téléavertisseur)

➤ le mot de passe donné par le fournisseur du téléavertisseur 
(en option)

➤ le protocole de communication (TAP, SkyTel ou un 
protocole personnalisé)
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5. Dans la liste Modem, sélectionner le modem à utiliser pour établir la 
connexion avec le téléavertisseur de rechange. Dans le panneau de 
commande Windows, choisir parmi les modems disponibles non 
utilisés pour un commutateur optique.

S’assurer que le modem est configuré avec le bon port de 
communication et qu’il est correctement configuré. Pour ce faire, 
appuyer sur Modem Properties.

6. Appuyer sur Test pour effectuer un test de communication entre le RTU 
et le téléavertisseur de rechange. Le RTU enverra un message sans 
importance au téléavertisseur en utilisant le modem sélectionné. 
Si l’utilisateur confirme que le téléavertisseur de rechange a reçu le 
message, le test a réussi.

Nota : Si le test n’est pas effectué ou qu’il a échoué, il sera impossible d’activer le 
téléavertisseur de rechange et le bouton OK apparaîtra grisé.

7. Cocher la case Enabled pour activer le téléavertisseur de rechange. 
Si l’utilisateur désactive le téléavertisseur, il est possible de 
sauvegarder la configuration, même en omettant le test.

8. Appuyer sur OK pour accepter les modifications, ou sur Cancel, pour 
rétablir la configuration initiale du téléavertisseur.
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Sélection d’un module OTDR ou OSA pour 
un RTU

FiberVisor permet l’utilisation d’un seul module OTDR ou OSA pour des 
fins de surveillance dans un RTU. Si le RTU comprend plus d’un module 
OTDR ou OSA, l’utilisateur devra sélectionner lequel utiliser 
avec FiberVisor.

L’ajout et la configuration de modules du RTU sont effectués à l’aide de 
l’assistant de configuration de modules (Module Configuration Wizard).

Ajout d’un module OTDR ou OSA à la configuration 
du RTU

Pour ajouter un module OTDR ou OSA à la configuration du RTU :

1. Insérer le module dans un emplacement disponible du RTU et le 
redémarrer pour s’assurer que l’OTDR ou l’OSA soit détecté.

2. Depuis la fenêtre RTU Configuration, sélectionner l’onglet Hardware.

3. Dans la section Modules, sélectionner Add... La fenêtre Module 
Configuration Wizard s’affiche.

4. Sélectionner le type de module à ajouter et appuyer sur Next 
pour continuer.
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5. Sélectionner le module à utiliser avec FiberVisor (s’il y en a plus d’un).

5a. La liste comprend tous les modules OTDR et OSA détectés et 
compatibles, selon la sélection à l’étape 4. Sélectionner celui à 
utiliser (dans l’exemple : le FTB-7434B).

5b. Appuyer sur Next.

6. La dernière étape permet de confirmer la nouvelle sélection 
d’un module.

6a. S’assurer d’avoir sélectionné le module approprié. Si ce n’est pas 
le cas, appuyer sur Back pour retourner à l’étape précédente.

6b. Appuyer sur Finish pour ajouter le nouveau module à la 
configuration du RTU.
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Modification d’un emplacement d’un module 
OTDR ou OSA dans le RTU

Pour modifier la position (emplacement) des modules dans le RTU :

1. Mettre le RTU hors tension.

2. Retirer le module et l’insérer dans son nouvel emplacement du RTU et 
le redémarrer pour s’assurer que l’OTDR ou l’OSA soit détecté.

3. Depuis la fenêtre RTU Configuration, sélectionner l’onglet Hardware.

4. Depuis la section Modules, sélectionner Configure... La fenêtre Module 
Configuration s’affiche.

5. Sélectionner le nouvel emplacement et appuyer sur Apply. Cette 
opération permet une mise à jour de la configuration du RTU pour le 
nouvel emplacement du module.

6. Appuyer sur Next pour ajouter le nouveau emplacement du module à 
la configuration du RTU.
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Remplacement d’un module OTDR ou 
OSA sélectionné

La configuration ne sera pas compromise lors du remplacement d’un 
module OTDR ou OSA sélectionné par un autre de même modèle. Par 
contre, si le modèle diffère, toute la configuration sera perdue, comme si 
l’utilisateur avait effacé l’ancien module et ajouté un nouveau.

Pour remplacer le module OTDR ou OSA sélectionné par un nouveau :

1. Mettre le RTU hors tension.

2. Retirer l’ancien module, insérer le nouveau et démarrer le RTU afin 
que le nouveau module soit détecté par le système.

3. Depuis la fenêtre RTU Configuration, sélectionner l’onglet Hardware.

4. Dans la section Modules, sélectionner Configure... La fenêtre Module 
Configuration Wizard s’affiche.

5. Sélectionner le module et appuyer sur Apply. Cette opération permet 
une mise à jour de la configuration du RTU. L’utilisateur devra 
confirmer l’opération, puisque cette dernière concerne toute 
la configuration.

6. Appuyer sur Next pour ajouter le nouveau module à la configuration 
du RTU.
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Suppression d’un OTDR ou d’un OSA depuis la 
configuration du RTU

IMPORTANT
Lors de la suppression d’un module, TOUS les ports et les tâches 
associés à cet OTDR (et le module commutateur auquel il est branché) 
sont également supprimés de la configuration.

Pour supprimer un module depuis la configuration du RTU :

1. Depuis la fenêtre FiberVisorClient Configuration, sélectionner l’onglet 
Hardware.

2. Dans la section Modules, sélectionner le module à supprimer et 
appuyer sur Remove.

3. Appuyer sur Yes pour confirmer la suppression du module.
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Utilisation du Switch Controller
Le Switch Controller permet d’associer les commutateurs aux ports.

Pour associer un commutateur à un port :

1. Depuis le bureau de Windows, ouvrir le Switch Controller en appuyant 
à deux reprises sur l’icône correspondante.

2. Sélectionner le commutateur à utiliser en déroulant vers le haut ou 
vers le bas le menu correspondant.

3. Sélectionner le port à associer au commutateur en déroulant vers le 
haut ou vers le bas le menu correspondant.

4. Appuyer sur Execute pour confirmer l’association commutateur/port, 
ou appuyer sur Quit pour retourner au bureau de Windows.

IMPORTANT
Le commutateur à sélectionner doit déjà être installé dans la 
configuration, tel qu’il est expliqué aux pages suivantes. Autrement, il 
sera impossible de le visualiser dans la liste déroulante.
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Ajout d’un commutateur à la configuration
Les instructions ci-dessous peuvent ne pas s’appliquer directement, cela 
dépend du type de commutateur à ajouter. L’assistant Module 
Configuration devrait guider facilement l’utilisateur à travers le processus.

Nota : L’ajout d’un commutateur interne à un port configuré (par exemple, au 
port 0 de l’OTDR) a pour conséquence la perte de la configuration du port 
(chemins, traces, tâches, etc.). La configuration du port n’est pas perdue 
seulement lors de l’ajout d’un commutateur à distance, puisqu’il est 
possible de la surveiller sur un chemin, entre le port et le commutateur.

1. Insérer le module commutateur dans un emplacement du RTU 
disponible. Pour plus de renseignements sur l’insertion d’un module 
dans les unités IQ-203 ou IQ-206, se référer au manuel d’instructions 
IQ-200 Optical Test System.

2. Depuis la fenêtre RTU Configuration, dans la page Hardware, à la 
section Switch, appuyer sur Add. L’assistant Module Configuration 
s’ouvre.

3. À l’étape Module Configuration Wizard - Step 1, taper le nom du 
nouveau commutateur. S’assurer qu’aucun autre commutateur lié à ce 
RTU possède le même nom. Il est impossible de modifier le nom 
d’un commutateur.

4. À l’étape Module Configuration Wizard - Step 2, sélectionner le 
commutateur à ajouter.

Nota : Un commutateur à distance peut seulement être ajouté s’il a déjà été créé 
sur le ONC (mode de visualisation géographique), où il apparaît à la fin du 
dernier câble. Ainsi, il est impossible d’ajouter un commutateur à distance 
à la liste d’un RTU autonome.

5. À l’étape Module Configuration Wizard - Step 3, sélectionner le port 
COM auquel le module commutateur est branché (commutateur 
externe ou à distance).
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6. Appuyer sur Test pour effectuer un test de communication avec le 
module commutateur. Si le test de communication échoue, le Module 
Configuration Wizard sera immédiatement désactivé.

7. À l’étape Module Configuration Wizard - Step 4, sélectionner le 
commutateur local auquel le commutateur à distance ou externe 
est branché.

8. À l’étape Module Configuration Wizard - Finished!, appuyer sur Finish 
pour confirmer les nouveaux paramètres du commutateur.

Si un changement doit être apporté à la configuration, appuyer sur 
Back et suivre les instructions à l’écran.

Modification d’un commutateur dans 
la configuration du RTU

Pour modifier un commutateur :

1. Dans la page Hardware, de la fenêtre Configuration, sélectionner le 
commutateur à modifier dans la liste de la section Switch.

2. Depuis la fenêtre RTU Configuration, dans la page Hardware, à la 
section Switch, appuyer sur Modify. L’assistant Module 
Configuration s’ouvre.

3. Suivre les étapes 3 et 4 de la section Utilisation du Switch Controller à 
la page 135.

Suppression d’un commutateur depuis 
la configuration

La suppression d’un commutateur ne signifie pas que le module OTDR 
auquel il est branché sera supprimé. Toutefois tout commutateur à 
distance branché à celui-ci sera supprimé.
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IMPORTANT
Lors de la suppression d’un module commutateur, TOUS les ports et 
les tâches associés à ce commutateur (et les autres modules auxquels 
il est branché) sont également supprimés de la configuration.

Pour supprimer un module commutateur depuis la configuration du RTU :

1. Depuis la fenêtre RTU Configuration, sélectionner l’onglet Hardware.

2. À la section Modules, sélectionner le commutateur à supprimer et 
appuyer sur Remove.

3. Appuyer sur OK pour confirmer la suppression du commutateur.

Remplacement d’un commutateur
Le remplacement d’un module commutateur doit se faire selon la 
configuration du RTU. Pour ce faire, suivre les instructions dans 
Modification d’un commutateur dans la configuration du RTU à la 
page 137.

Si le nouveau commutateur possède moins de ports que l’ancien, il est 
possible de conserver les mêmes données de configuration (tâches, TR, 
etc.) pour les ports communs. Toutes les données de configuration pour 
les ports qui ne sont plus présents seront perdues.

Si le nouveau commutateur possède plus de ports que l’ancien, il est 
possible de conserver l’ancienne configuration pour les ports communs.

Pour configurer les ports, suivre les instructions dans la section ci-dessous.

Configuration de ports OTDR et commutateur

Nota : Lors de la configuration d’un commutateur à distance, il est impossible de 
configurer les ports (l’onglet Ports de la fenêtre RTU Configuration sera 
grisé). Configurer les ports du commutateur à distance depuis le RTU 
auquel le commutateur à distance est relié.
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Pour configurer un port lié à un OTDR, l’utilisateur doit :

➤ sélectionner un chemin qui provient du RTU courant

➤ synchroniser ce RTU avec le RTU à l’autre extrémité du chemin

➤ ajouter une ou plusieurs traces de référence

➤ définir les seuils de test

Association des ports avec des chemins

Pour associer des chemins aux ports qui assureront leur surveillance :

1. Sélectionner l’onglet Port de la fenêtre FiberVisorClient Configuration.

2. Dans la liste Current port de la section Port Info, sélectionner le port à 
configurer. Toute l’information affichée dans l’onglet Ports est liée au 
port sélectionné.

Habituellement, tous les ports disponibles sont listés, sauf lors des 
situations suivantes :

➤ la fibre qui lie le RTU au commutateur externe est trop courte pour 
être surveillée
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➤ si un commutateur interne ou externe se trouve sur le module 
OTDR, le port 0 ne sera pas listé

➤ si un commutateur externe se trouve sur le port X d’un 
commutateur interne, le port X ne sera pas listé

Toutefois, si un commutateur à distance est sur le port 0 du module 
OTDR ou sur le port X d’un commutateur interne, ce port sera listé, 
puisqu’il est possible de surveiller entre le port et le commutateur 
à distance.

Dans l’exemple illustré ci-dessous, la liste Current port listerait les ports 
nos 1, 3 et 4 du commutateur interne et les ports nos 1 et 2 du 
commutateur externe. Le port no 2 du commutateur interne ne serait 
pas listé.

Si le port sélectionné est lié (directement ou à l’aide d’un autre 
commutateur) à un OTDR, le message « linked to OTDR » apparaîtra à 
la suite de la liste Current port.

3. Associer un chemin avec le port sélectionné en appuyant sur 
Select Path.

RTU
Commutateur 
externe

Commutateur 
interne
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IMPORTANT
En modifiant le chemin associé avec un port ou en le configurant à 
« None », les tâches existantes, la liste des traces de référence et les 
fichier de traces de référence à configuration automatique sont 
supprimés. Par ailleurs, les seuils sont reconfigurés aux valeurs 
par défaut.

3a. Dans la liste des chemins qui ont été créés pour ce RTU, sélectionner 
un chemin à associer avec le port. Les chemins qui sont déjà 
associés à un autre port ne sont pas disponibles dans la liste.

3b. Appuyer sur OK pour accepter le nouveau chemin et pour 
retourner à la fenêtre RTU Configuration.

Synchronisation des tests sur des 
chemins sélectionnés

Advenant le cas où la longueur du chemin est plus grande que la plage 
d’acquisition de l’OTDR, un deuxième OTDR peut être installé à l’autre 
extrémité du chemin, tel qu’il est illustré ci-dessous.

Si les mesures sont prises à la même longueur d’onde pour les deux tests, 
les RTU doivent être synchronisés afin que les mesures ne soient pas 
effectuées simultanément.

Durant les opérations de surveillance, lors d’une requête de 
synchronisation du RTU A avec le RTU B, ce dernier suspend ses 
opérations pour tous les ports configurés pour une synchronisation avec 
le RTU A.

RTU A RTU B

285 km

Test OTDR no 1

Test OTDR no 2
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Nota : FiberVisor permet seulement de synchroniser les ports OTDR et les ports 
liés à un OTDR à l’aide du commutateur. Un chemin peut être synchronisé 
avec un seul RTU.

Pour synchroniser le RTU courant avec le deuxième RTU :

1. Depuis, la fenêtre FiberVisorClient Configuration, sélectionner 
l’onglet Port.

2. Dans la liste Current port de la section Port Info, sélectionner le port 
(pour le RTU courant) à synchroniser.

3. Appuyer sur Synch. Path pour afficher la fenêtre RTU Synchronization.

4. Cocher la case Synchronize with, puis entrer l’adresse IP du RTU à 
synchroniser avec le RTU courant.

5. Appuyer sur Test pour accomplir un test de synchronisation entre les 
deux RTU.

Nota : Si le test n’est pas effectué ou s’il a échoué, il sera impossible d’activer la 
synchronisation et le bouton OK sera grisé.

6. Appuyer sur OK pour accepter les changements et retourner à la 
fenêtre RTU Configuration. Appuyer sur Cancel pour rétablir l’état 
initial de la synchronisation.
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Définition des traces de référence pour un port

Il se peut que l’utilisateur désire surveiller un chemin en utilisant divers 
paramètres (impulsion, longueur d’onde et résolution). FiberVisor permet 
de définir plusieurs traces de référence optimisées pour le type 
d’acquisition à accomplir.

Nota : Pour qu’un port soit surveillé, il est essentiel de définir au moins une trace 
de référence.

1. Depuis la fenêtre FiberVisorClient Configuration, sélectionner l’onglet Ports.

2. Dans la liste Current port de la section Port Info, sélectionner le port 
dont les traces de référence doivent être configurées. Les traces 
existantes pour ce port sont listées dans la section Reference Traces.

3. Appuyer sur le bouton correspondant à l’opération à effectuer.

➤ Pour ajouter une nouvelle trace de référence à la liste, appuyer sur 
Add et entrer l’information dans la boîte de dialogue Reference 
Trace Configuration. Pour plus de renseignements sur les traces de 
référence, voir Acquisition de traces de référence manuellement 
sur un RTU à la page 155.
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➤ Pour visualiser la trace de référence, appuyer sur View.

➤ Pour mettre à jour la trace de référence sélectionnée, appuyer 
sur Renew.

➤ Pour sélectionner une trace par défaut, appuyer sur Default.

➤ Pour retirer la trace sélectionnée de la liste, appuyer sur Remove.

Définition des seuils de test pour le 
port sélectionné

Trois niveaux de seuils sont disponibles : mineur, majeur et critique.

Nota : Les seuils de test d’un nouveau port sont configurés aux valeurs du RTU 
par défaut. Pour plus de renseignements sur ces valeurs, voir Définition des 
seuils par défaut du RTU à la page 154.

Spécification des seuils manuellement
Pour définir les seuils de test manuellement selon les valeurs par défaut :

1. Sélectionner le port à configurer dans la liste Current port. Lorsque 
l’utilisateur sélectionne un port lié à un OTDR, les seuils OTDR suivants 
seront listés dans la section Thresholds de l’onglet Ports :

➤ New Event Detection (détection d’un nouvel événement)

➤ Reflective Event Loss Degradation (dégradation de la perte d’un 
événement réfléchissant)

➤ Non-Reflective Event Loss Degradation (dégradation de la perte 
d’un événement non réfléchissant)

➤ Section Attenuation (atténuation de la section)

➤ Launch Level Degradation (dégradation du niveau d’injection)

➤ Event Reflectance Degradation (dégradation de la réflectance d’un 
événement)

➤ Total Loss Degradation (dégradation de la perte totale)
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2. Dans la section Thresholds, appuyer sur Define... La fenêtre Tresholds 
apparaît.

3. Dans la section Which one, sélectionner un événement dont le seuil 
doit être modifié.

4. Dans les boîtes de texte Minor, Major et Critical de la section Values, 
entrer les trois seuils limites en dB.

5. Appuyer sur OK pour confirmer les nouvelles valeurs des seuils, ou 
appuyer sur Cancel pour rétablir les valeurs précédentes.

Nota : Lorsqu’un autre seuil est sélectionné dans la boîte Which one, les valeurs 
courantes seront sauvegardées, comme si l’utilisateur avait appuyé sur OK.

Copie de seuils depuis un autre port
Il est possible de configurer les seuils pour le port actuel afin qu’ils 
prennent automatiquement les valeurs d’un autre port ou les valeurs par 
défaut du RTU. Si les seuils du port de base sont modifiés par la suite, les 
seuils courants ne seront PAS changés.
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Pour copier les seuils d’un autre port vers le port courant :

1. Dans la section Threshold de l’onglet Ports, appuyer sur Copy From... 
La boîte de dialogue Copy Thresholds From s’affiche.

2. Dans la liste Port, sélectionner le port à utiliser en tant que référence 
pour les valeurs des seuils.

3. Appuyer sur OK pour accepter la nouvelle base, ou appuyer sur Cancel 
pour rétablir les valeurs précédentes des seuils.

Synchronisation des seuils avec les valeurs par défaut
Il est possible de configurer les seuils du port courant afin qu’ils prennent 
automatiquement les valeurs par défaut du RTU. Si les seuils par défaut du 
RTU sont changés par la suite, les seuils du port courant seront également 
modifiés.

Pour synchroniser les seuils avec les valeurs par défaut, dans la section 
Threshold de l’onglet Ports, appuyer sur Default.

Configuration des tâches de surveillance OTDR
Les tâches de surveillance OTDR sont listées dans l’onglet OTDR Jobs de la 
fenêtre RTU Configuration. Les ports listés sont ceux associés à un chemin 
et dont au moins une trace de référence est définie.
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Ajout d’une tâche OTDR

Pour ajouter une tâche OTDR à la séquence de tâches :

1. Depuis la fenêtre FiberVisorClient Configuration, sélectionner l’onglet 
OTDR Jobs.

2. Sélectionner la tâche sous laquelle apparaîtra une nouvelle tâche. 
Si aucune tâche n’est sélectionnée, la nouvelle tâche apparaîtra à la fin 
de la liste.

3. Appuyer sur Insert... La boîte de dialogue OTDR 
Jobs Configuration s’affiche.

4. Pour sélectionner le port et le chemin sur lesquels la nouvelle tâche 
sera accomplie, appuyer sur la ligne dans le tableau.
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5. Dans la liste Reference Traces, sélectionner une trace de référence à 
laquelle les résultats seront comparés. La trace de référence par 
défaut définie pour le port est la première de la liste.

6. Appuyer sur Add to List pour ajouter la tâche à la liste dans l’onglet 
OTDR Jobs. La boîte de dialogue demeure ouverte, au cas où d’autres 
tâches s’ajouteraient.

7. Lorsque toutes les tâches sont ajoutées, appuyer sur Close.

Modification d’une tâche OTDR

Une modification d’une tâche existante est similaire à l’ajout d’une 
nouvelle tâche, sauf que l’utilisateur ne choisit pas une combinaison 
port/chemin. 

Pour modifier une tâche :

1. Dans la fenêtre RTU Configuration, sélectionner l’onglet OTDR Jobs.

2. Sélectionner la tâche à modifier, puis appuyer sur Edit... La boîte de 
dialogue OTDR Jobs Configuration s’affiche.

3. Dans la liste Reference Traces, sélectionner une nouvelle trace de 
référence à l’aide de laquelle les résultats seront comparés.

4. Appuyer sur Save pour accepter les modifications et retourner à la 
fenêtre RTU Configuration.

Retrait d’une tâche OTDR de la liste

Pour retirer une tâche OTDR :

1. Dans la fenêtre RTU Configuration, sélectionner l’onglet OTDR Jobs.

2. Sélectionner la tâche à retirer, puis appuyer sur Remove.

3. Appuyer sur Yes pour confirmer l’opération.
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Modification de la séquence de tâches OTDR

Pour réarranger la séquence de tâches OTDR :

1. Dans la fenêtre RTU Configuration, sélectionner l’onglet OTDR Jobs.

2. Sélectionner une tâche et utiliser les boutons Up et Down pour 
déplacer la tâche à la position requise dans la liste.

3. Répéter l’étape précédente jusqu’à ce que toutes les tâches soient 
dans le bon ordre.

Définition de l’horaire de la séquence des 
tâches OTDR

Il est possible de définir un délai entre les séquences de tâches, soit pour 
permettre une période de refroidissement au RTU ou pour toute autre 
raison. Il est possible de configurer un délai entre 1 minute et 
1440 minutes.

Pour définir un délai entre les séquences de tâches :

1. Depuis la fenêtre RTU Configuration, sélectionner l’onglet OTDR Jobs.

2. Dans la section Sequence Schedule, appuyer sur Define... La boîte de 
dialogue Sequence Schedule s’affiche.

3. Pour recommencer aussitôt la dernière tâche de la séquence 
terminée, sélectionner Continuous. Il s’agit de l’option par défaut pour 
les tâches OTDR.
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Pour effectuer une pause avant de recommencer, afin que l’utilisateur 
définisse un délai, sélectionner Pause for... et configurer le délai (en 
minutes) dans le champ de texte. Il est possible de configurer un délai 
entre 1 minute et 1440 minutes.

4. Appuyer sur OK pour accepter l’horaire de la séquence et retourner à 
la fenêtre RTU Configuration.

Configuration des tâches de surveillance de 
l’ondemètre multi-longueurs d’onde

La configuration des tâches de surveillance de l’ondemètre 
multi-longueurs d’onde est semblable à celle des tâches OTDR. Pour plus 
de renseignements sur les procédures, voir Configuration des tâches de 
surveillance OTDR à la page 146 et suivantes, en utilisant l’onglet MWM 
Jobs, plutôt que l’onglet OTDR Jobs.

Configuration des acquisitions 
d’échantillonnage et de statistiques

Ajout d’une tâche d’échantillonnage

Pour ajouter une tâche d’échantillonnage :

1. Dans la fenêtre FiberVisor Client - Configuration, appuyer sur l’onglet 
Other Jobs. La page Other Jobs apparaît.

2. Appuyer sur Insert... La fenêtre Job Configuration apparaît.

3. Dans la liste Job Type, sélectionner Sampling.

4. Dans la liste Port de la section Port Parameters, sélectionner le port 
auquel la nouvelle tâche est liée. Tous les ports du RTU y sont listés.
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5. Dans la liste Reference Trace de la section Port Parameters, 
sélectionner la trace de référence à laquelle les résultats seront 
comparés.

6. Dans la liste Period de la section Job Schedule, sélectionner la période 
d’échantillonnage daily, weekly ou monthly (soit quotidienne, 
hebdomadaire ou mensuelle).

6a. Selon le choix effectué à l’étape 6, sélectionner le jour du mois 
dans la liste Day of Month ou le jour de la semaine dans la liste 
Day of Week.

6b. Dans la liste Hour of Day, configurer l’heure du jour.

Nota : Le RTU est configuré pour réserver deux heures (de minuit à 2 h) chaque 
jour afin qu’un entretien interne soit effectué et que des statistiques soient 
établies. Il sera impossible de planifier des tâches durant cette période.

7. Appuyer sur OK pour confirmer la configuration de la nouvelle 
tâche d’échantillonnage.

Modification d’une tâche d’échantillonnage

Pour modifier une tâche d’échantillonnage :

1. Dans la fenêtre FiberVisor Client - Configuration, appuyer sur l’onglet 
Other Jobs. La page Other Jobs apparaît.

2. Dans la page Other Jobs, sélectionner la tâche à modifier.

3. Appuyer sur Edit... La fenêtre Job Configuration s’ouvre.

4. Dans la liste Port de la section Port Parameters, sélectionner le port 
auquel la tâche est liée. Tous les ports du RTU y sont listés.

5. Dans la liste Reference Trace de la section Port Parameters, 
sélectionner la trace de référence à laquelle les résultats seront 
comparés.
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6. Dans la liste Period de la section Job Schedule, sélectionner la période 
d’échantillonnage daily, weekly, ou monthly (soit quotidienne, 
hebdomadaire ou mensuelle).

6a. Selon le choix effectué à l’étape 6, sélectionner le jour du mois 
dans la liste Day of Month, ou le jour de la semaine dans la liste 
Day of Week.

6b. Dans la liste Hour of Day, configurer l’heure du jour.

7. Appuyer sur OK pour confirmer la configuration de la tâche 
d’échantillonnage modifiée.

Ajout d’une tâche d’acquisition de statistiques

Pour ajouter une tâche d’acquisition de statistiques :

1. Dans la fenêtre FiberVisor Client - Configuration, appuyer sur l’onglet 
Other Jobs. La page Other Jobs apparaît.

2. Dans la page Other Jobs, sélectionner la tâche sous laquelle apparaîtra 
la nouvelle tâche. Si aucune tâche n’est sélectionnée, la nouvelle tâche 
apparaîtra à la fin de la liste.

3. Appuyer sur Insert... La fenêtre Job Configuration apparaît.

4. Dans la liste Job Type, sélectionner Statistic.

5. Dans la liste Port de la section Port Parameters, sélectionner le port 
auquel la nouvelle tâche est liée. Tous les ports du RTU y sont listés.

6. Dans la liste Reference Trace de la section Port Parameters, 
sélectionner la trace de référence à laquelle les résultats seront 
comparés.

7. Appuyer sur OK pour confirmer la configuration de la nouvelle tâche 
d’acquisition de statistiques.
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Modification d’une tâche d’acquisition 
de statistiques

Pour modififer une tâche d’acquisition de statistiques :

1. Dans la fenêtre FiberVisor Client - Configuration, appuyer sur l’onglet 
Other Jobs. La page Other Jobs apparaît.

2. Dans la page Other Jobs, sélectionner la tâche à modifier.

3. Appuyer sur Edit... La fenêtre Job Configuration apparaît.

4. Dans la liste Port de la section Port Parameters, sélectionner le port 
auquel la tâche est liée. Tous les ports du RTU y sont listés.

5. Dans la liste Reference Trace de la section Port Parameters, 
sélectionner la trace de référence à laquelle les résultats seront 
comparés.

6. Appuyer sur OK pour confirmer la configuration de la tâche 
d’acquisition de statistiques modifiée.

Suppression d’une tâche d’acquisition 
d’échantillonnage ou de statistiques

Pour supprimer une tâche d’échantillonnage ou de statistiques :

1. Dans la fenêtre FiberVisor Client - Configuration, appuyer sur l’onglet 
Other Jobs. La page Other Jobs apparaît.

2. Dans la page Other Jobs, sélectionner la tâche à supprimer.

3. Appuyer sur Remove... Une fenêtre de confirmation de 
FiberVisor apparaît.

4. Appuyer sur OK pour confirmer la suppression de la 
tâche d’échantillonnage.
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Définition des seuils par défaut du RTU
Les seuils par défaut du RTU sont appliqués dès qu’un nouveau port 
est créé. Pour économiser du temps lors de la configuration de nouveaux 
ports, configurer d’abord les seuils par défaut du RTU afin qu’ils puissent 
être appliqués au plus grand nombre de ports possible.

Trois niveaux de seuils sont disponibles : mineur, majeur et critique.

IMPORTANT
Tous les ports dont les seuils sont basés sur les valeurs par défaut 
prendront les nouvelles valeurs. Pour plus de renseignements, voir 
Synchronisation des seuils avec les valeurs par défaut à la page 146.

Pour configurer les seuils par défaut de l’OTDR pour ce RTU :

1. Dans la fenêtre RTU Configuration, sélectionner l’onglet Default.

2. Dans la section Thresholds (OTDR), appuyer sur Define... La boîte de 
dialogue Thresholds s’affiche.

3. Dans la liste Which one, sélectionner un événement OTDR pour lequel 
les seuils par défaut doivent être modifiés.

4. Dans les zones de texte Minor, Major et Critical de la section Values, 
entrer les trois limites de seuils en dB.

5. Appuyer sur OK pour confirmer les nouvelles valeurs des seuils, ou sur 
Cancel pour rétablir les valeurs précédentes.
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10 Acquisition de traces de 
référence manuellement sur 
un RTU

Grâce à l’application RTU de FiberVisor, il est possible d’optimiser les 
mesures selon la durée d’acquisition ou la résolution.

➤ Une mesure effectuée selon une durée d’acquisition spécifique fournit 
une évaluation rapide de la fibre sous test. Pour tester en ce mode, une 
plage dynamique et un rapport signal sur bruit élevés doivent déjà 
avoir été établis pour tout le lien de fibre sous test. 

➤ Une mesure effectuée selon la résolution fournit la meilleure 
résolution possible pour évaluer la fibre sous test aussi complètement 
que possible. Dans des mesures en fonction de la résolution, les zones 
mortes sont minimisées et il est ainsi possible de détecter un 
maximum d’événements. L’acquisition de la trace de référence doit 
être effectuée avec la configuration finale. Si une fibre doit être 
temporairement débranchée ou modifiée, il est fortement 
recommandé d’acquérir une nouvelle trace de référence.

Acquisition d’une trace de référence
Pour acquérir une trace de référence :

1. Brancher les fibres et mettre le RTU sous tension. Pour plus de 
renseignements sur la mise sous tension d’un RTU, voir Mise sous 
tension et accès à un RTU à la page 19.

2. Depuis l’application du commutateur à distance, sélectionner le port 
désiré et lancer l’application du contrôleur OTDR.

3. Effectuer une acquisition en appuyant sur Start. Si requis, configurer 
les paramètres et effectuer une autre acquisition. Lorsque la trace est 
acceptable, la sauvegarder sur le disque dur.

4. Accomplir cette procédure pour chaque port.
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Nota : Lorsque les fibres sont très similaires (du même câble), il serait préférable 
de valider d’abord deux traces. Une fois les traces acceptées, appliquer les 
mêmes paramètres aux autres ports. 

Application de la trace de référence 
dans FiberVisor

1. Lancer l’application Configure d’un RTU de FiberVisor.

2. Configurer les différent ports. Pour plus de renseignements sur la 
configuration de l’application RTU, voir Configuration d’un RTU à la 
page 119.

3. Commencer la surveillance. Les traces de référence sont acceptées. 
S’assurer que toutes les traces sont acceptées.

Nota : Lorsque la trace est acceptée par l’utilisateur, la surveillance peut 
commencer.

En cas de rejets ou d’avertissements, retourner au contrôleur du 
commutateur ou lancer l’application du contrôleur de l’OTDR (pour plus 
de renseignements sur le lancement de l’application OTDR, voir 
Applications de démarrage d’un RTU à la page 21) et suivre les instructions 
données durant la validation.

Dans certains cas, il se peut que plusieurs itérations soient requises pour 
obtenir une trace finale.

RTU : définir une trace de référence par port. Les acquisitions courantes 
seront alors comparées au tableau d’événements de la trace de référence. 
Afin d’obtenir une configuration valide pour un port spécifique, au moins 
une trace de référence doit avoir été définie.
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11 Utilisation d’une carte linéaire
La carte linéaire affiche dans une même fenêtre l’information 
géographique, les éléments du réseau, les chemins, une prévisualisation 
de la trace de référence et les événements. Cela donne un bon aperçu de 
toutes les données de FiberVisor.

La carte linéaire n’est pas considérée comme un mode de visualisation 
(contrairement aux modes de visualisation géographique ou des alarmes), 
parce qu’elle ne permet pas d’accomplir des actions ou de modifier 
des données.

Données
optiques

Données
géographiques

Prévisualisation
de la trace

Onglets des
propriétés
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Accès à la carte linéaire
Pour accéder à la carte linéaire depuis l’un des modes de visualisation 
de l’explorateur :

1. Cliquer à l’aide du bouton de droite de la souris sur le chemin ou 
l’alarme (dans le mode de visualisation Alarms).

2. Dans le menu contextuel, sélectionner Show on Linear Plan.

Dans cette section l’on retrouve : le nom du RTU, les numéros de chaque 
événement ainsi que les points du début, de la fin et de la segmentation 
sur les fibres.

Visualisation des traces
Il est essentiel d’avoir une trace de référence afin de visualiser la trace 
associée à la sélection (chemin ou objet). 

Le curseur d’exploration utilisé sur des éléments optiques et 
géographiques apparaît également sur la trace et illustre la localisation 
de l’événement.

Choix d’une trace
Pour visualiser le chemin à l’écran, il est essentiel de choisir une trace. 
Toutefois, cela n’est pas nécessaire lors de la sélection d’une alarme à 
visualiser sur la carte linéaire, puisque le chemin s’affiche instantanément.

Pour choisir une trace :

1. Une fois en mode de visualisation de la carte linéaire, sélectionner 
l’onglet Traces au coin inférieur droit de l’écran. Voir la figure à la page 
précédente.

2. Explorer l’arborisation et sélectionner la trace à visualiser.

Il est possible de modifier la visualisation à l’aide des boutons du zoom, 
situés sur le séparateur au milieu de l’écran. 
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Il est possible de se déplacer dans le mode de visualisation en utilisant le 
bouton Pan situé entre les boutons du zoom. Ce bouton active le curseur 
panoramique (main) qui permet de déplacer la carte jusqu’à la région 
à visualiser. 

Il est également possible d’utiliser les boutons panoramiques de droite et 
de gauche, << et >>, situés sur le séparateur du milieu de l’écran, ou de 
déplacer le mode de visualisation de gauche à droite ou vice versa.

Nota : Le curseur d’exploration passe d’un élément géographique ou optique à un 
autre. Il est impossible d’utiliser le curseur librement à l’écran, car il 
s’arrêtera automatiquement sur un événement. 

Pour déplacer le curseur sur des éléments optiques ou géographiques, 
utiliser les deux flèches situées dans la partie inférieure gauche de l’écran, 
depuis la liste.

Visualisation d’événements
La carte linéaire permet de visualiser de façon plus détaillée des 
événements géographiques ou optiques.

Visualisation d’événements géographiques

Pour visualiser un événement géographique spécifique et ses détails, le 
sélectionner sur la carte linéaire et appuyer sur l’onglet Geo. Events.
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L’onglet Geo. Events permet de visualiser :

➤ une description de l’événement

➤ sa distance sur le câble

➤ sa position géographique (longitude et latitude)

Les propriétés affichées dans l’onglet Geo. Events sont utilisées pour 
référence seulement. Il est impossible de les modifier dans ce mode 
de visualisation.
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Visualisation des événements optiques

Pour visualiser un événement optique spécifique et ses détails, le 
sélectionner sur la carte linéaire et appuyer sur l’onglet Optical Events.

L’onglet Optical Events permet de visualiser :

➤ le type d’événement

➤ son numéro dans la liste

➤ sa localisation

➤ la perte et la réflectance associées à cet événement

Cet onglet fournit également de l’information sur la section de fibre, soit sa 
longueur et le total de la perte et de l’atténuation. Les propriétés affichées 
dans l’onglet Optical Events sont utilisées pour référence seulement. Il est 
impossible de les modifier dans ce mode de visualisation.
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12 Gestion des éléments 
du réseau

FiberVisor Console permet d’ajouter et de retirer graphiquement des 
éléments de réseau (des RTU et des commutateurs optiques) d’un 
système RFTS.

Création d’un RTU dans FiberVisor
Pour ajouter un RTU dans FiberVisor :

1. Sélectionner Edit > RTU > New RTU. Le pointeur de la souris se 
transforme. L’utilisateur doit entrer des données pour la création d’un 
nouvel RTU.

2. Positionner le pointeur de la souris sur la carte et appuyer sur l’endroit 
où situer le RTU.

3. Remplir les champs, tel qu’il est expliqué ci-dessous :

➤ RTU Name : indiquer le nom attribué par Windows qu’il est 
possible de trouver dans le panneau de configuration (Control 
Panel), sous l’icône Network.

➤ Location (en option) : description de la localisation physique 
du RTU.

➤ Comments : commentaires sur le RTU en question (en option).

➤ Coordonnées du RTU : longitude et latitude précises.
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Les nouvelles coordonnées du RTU sont illustrées en utilisant le système 
interne de FiberVisor.

Un nouvel RTU est actif par défaut, sauf si aucune licence RTU n’est 
disponible au moment de l’ajout de celui-ci. Le cas échéant, un message 
d’avertissement apparaîtra. Le RTU sera tout de même créé, mais il 
apparaîtra comme étant inactif.

Modification de la configuration d’un RTU
Pour modifier la configuration d’un RTU :

1. Sélectionner un RTU sur la carte. Pour plus de renseignements sur la 
sélection d’éléments, voir Sélection et désélection d’éléments sur 
la carte à la page 67.

2. Sélectionner Edit > RTU > Modify RTU.

3. Changer la configuration au besoin :

➤ Lorsque l’utilisateur active un RTU qui était auparavant inactif, le 
système recherche une licence disponible. Si aucune licence n’est 
disponible, l’activation est interdite et un message 
d’erreur apparaît.

➤ Lorsque l’utilisateur désactive un RTU qui était activé auparavant, 
le système libère une licence RTU.
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Il sera possible d’accéder aux données historiques, telles que des alarmes, 
des statistiques ou des traces. Toutefois, l’utilisateur ne pourra pas 
effectuer une surveillance ou un test sur demande. Si le RTU essait 
d’envoyer des données au TSC, celles-ci seront refusées.

Suppression d’un RTU
Pour supprimer un RTU du réseau :

1. Sélectionner un RTU sur la carte. Pour plus de renseignements sur la 
sélection d’éléments, voir Sélection et désélection d’éléments sur 
la carte à la page 67.

OU

Sélectionner un RTU dans l’un des modes de visualisation de 
l’explorateur du réseau.

2. Sélectionner Edit > RTU > Delete RTU.

3. Confirmer l’opération.

Le RTU sera supprimé des bases de données. Tous les chemins associés à 
ce RTU seront automatiquement supprimés et une licence sera libérée.

Activation ou désactivation d’un RTU
Pour désactiver un RTU :

1. En mode de visualisation Network Topology, cliquer à l’aide du bouton 
de droite de la souris sur le RTU pour ouvrir le menu contextuel.

2. Sélectionner l’option Deactivate. Le RTU et ses commutateurs à 
distance sont désactivés et une licence RTU est libérée.

Le RTU n’est plus listé en mode de visualisation Network Topology, mais il 
est toujours présent en mode de visualisation Network History.
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Il sera possible d’accéder aux données historiques, telles que des alarmes, 
des statistiques ou des traces. Toutefois, l’utilisateur ne pourra pas 
effectuer une surveillance ou un test sur demande. Si le RTU essait 
d’envoyer des données au TSC, celles-ci seront refusées.

Pour activer le RTU, répéter les étapes précédentes, mais désélectionner 
l’option Deactivate.

Nota : Pour activer un RTU, il est nécessaire qu’une licence RTU soit disponible.

L’état d’un RTU (actif ou inactif) n’a pas d’impact sur le mode de 
visualisation géographique.

Création d’un commutateur à distance dans 
FiberVisor

Pour créer un commutateur à distance dans FiberVisor :

1. Sélectionner un RTU et les câbles qui le relient au commutateur à 
distance. Pour plus de renseignements sur la sélection d’éléments, voir 
Sélection et désélection d’éléments sur la carte à la page 67.

2. En cliquant sur le bouton de droite de la souris, sélectionner 
Edit >Remote Switch > New Remote Switch. Le pointeur de la souris 
se transforme. L’utilisateur doit entrer des données pour créer un 
nouvel événement géographique.

3. Cliquer à l’aide du bouton de gauche de la souris sur la carte à l’endroit 
où se situe le nouveau commutateur à distance. La fenêtre Add 
Remote Switch s’affiche.

4. Dans la fenêtre Add Remote Switch, configurer les éléments suivants :

➤ le nom du commutateur à distance

➤ sa localisation

➤ tout commentaire approprié

5. Appuyer sur Add.
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Modification de la configuration d’un 
commutateur à distance

1. Sélectionner le commutateur à distance à modifier sur la carte.

2. Sélectionner Edit > Remote Switch > Modify Remote Switch. 
La fenêtre Configure Remote Switch s’affiche.

3. Dans la fenêtre Configure Remote Switch, il est possible de modifier la 
localisation et les commentaires.

Suppression d’un commutateur optique

IMPORTANT
Il est impossible de supprimer un commutateur à distance référencé 
dans la configuration d’un RTU actif.

1. Sélectionner le commutateur à distance à supprimer sur la carte. 
Pour plus de renseignements sur la sélection d’éléments, voir Sélection 
et désélection d’éléments sur la carte à la page 67.

2. Sélectionner Edit > Remote Switch > Delete Remote Switch. Une 
fenêtre de confirmation de FiberVisor Console s’affiche.

3. Appuyer sur OK pour confirmer la suppression du commutateur à 
distance sélectionné.
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13 Configuration du SIG
Données et bases de données du SIG

FiberVisor gère toutes les données à l’aide de plusieurs bases de données. 
Les bases de données sont structurées pour prendre en considération le 
type et la source des données du SIG utilisé ainsi que les besoins de 
l’utilisateur quant à la performance et aux logiciels. Le tableau suivant 
donne un aperçu de la structure d’une base de données :

Base de 
données Contenu Source Localisation

Données 
géographiques

Rues, cours d’eau, 
voies ferrées, édifices, 

etc.

Achetée Externe

Câbles Câbles et segments Utilisateur 
RFTS

TSC ou externe

FiberVisor TSC (bdgc.mdb)

Données RFTS RTU, infrastructures, 
annotations, alarmes, 

etc.

FiberVisor TSC (ofn20.mdb)

Inventaire Composants du 
matériel et logiciel

FiberVisor/SMS TSC

Dictionnaire 
de données

Description des 
connexions et des 

données géomatiques

FiberVisor TSC (SQL)

Base de 
données 
descriptive 
FiberVisor

Câbles, fibres, fichiers, 
ports, défauts, 

alarmes, statistiques, 
chemins, RTU, liens 

optiques, 
commutateurs à 

distance, points de 
mesure, etc.

FiberVisor TSC (SQL)
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Base de données des câbles

La base de données des câbles (BDCG.mdb) contient de l’information 
géographique sur les câbles et les points de segmentation.

La configuration de la base de données varie selon le type de configuration 
et d’accès utilisés.

➤ L’utilisateur possède sa propre base de données avec de l’information 
en format exploitable. La base de données demeurera sur le SIG avec 
un accès au réseau. Par conséquent, l’utilisateur ne pourra pas 
modifier les données dans FiberVisor Console.

➤ Utiliser FiberVisor pour créer un réseau. La base de données sera 
sauvegardée dans le TSC.

Nota : Si l’utilisateur utilise sa propre base de données, celle-ci doit être conçue 
dans un système de coordonnées bien défini. Les câbles représentés dans 
la base de données doivent être isolés sur une seule couche, et il doit être 
possible d’attribuer une distance optique pour chacun des segments 
d’un câble. 

Base de données du RFTS (OFN20.mdb)

La base de données RFTS de FiberVisor (OFN20.mdb) comprend :

➤ la couche géographique des alarmes

➤ la couche géographique du RTU

➤ la couche géographique descriptive de l’infrastructure (câbles, trous 
d’homme, poteaux, édifices, etc.)

FiberVisor utilise un système de coordonnées géographiques 
(latitude/longitude) pour sauvegarder des données. 
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Base de données descriptive

La base de données descriptive est divisée en deux bases de données, soit 
GISD20.mdb et FiberVisor20.mdb.

La base de données GISD20.mdb comprend :

➤ des configurations des connexions de la base de 
données géographiques

➤ des éléments créés à l’aide de Data Manager, tels que des connexions, 
des entités, la couleur du symbole, la couleur du câble, etc.

La base de données FiberVisor20.mdb inclut :

➤ des données relationnelles et descriptives (chemin, câble, fibre, etc.)

➤ des données liées aux alarmes

➤ des données liées aux traces (sauf pour les points)

➤ des données liées au système

Configuration du SIG à l’aide du gestionnaire 
de données

Afin que n’importe quelle base de données SIG soit utilisable dans 
FiberVisor, la configurer dans le gestionnaire de données (Data Manager). 
Les configurations du SIG sont sauvegardées en format Microsoft SQL 
Server 7.0 et localisées sur le TSC.

Nota : Configurer les paramètres du SIG au moins une fois avant d’utiliser 
FiberVisor pour la première fois.

Voici le déroulement des opérations typiques pour configurer le SIG :

1. Définir une connexion à un fichier de la base de données.

2. Définir un ou plusieurs domaines pour catégoriser les entités.

3. Définir les entités (couches géométriques de la connexion).
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Ouverture et fermeture du gestionnaire de 
données (Data Manager)
Pour configurer les paramètres du SIG avec le gestionnaire de données, 
depuis le menu Tools sélectionner Administrator, puis Data Management.

Nota : Le panneau d’information s’adaptera à la sélection faite dans le panneau 
d’arborescence de données. Les champs de texte en jaune ne sont 
pas modifiables.

Pour fermer le gestionnaire de données :

➤ Depuis le menu File, sélectionner Quit .

OU

➤ Appuyer sur le bouton .

Barre de
menus

Barre
d’outils

Panneau d’arborescence de données Panneau d’information
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Arborisation ou regroupement de l’arborescence 
de données

Pour visualiser tous les éléments de l’arborescence :

➤ Depuis le menu View, sélectionner Expand All.

OU

➤ Appuyer sur le bouton .

Pour regrouper l’arborescence afin de visualiser seulement les éléments 
de niveau supérieur :

➤ Depuis le menu View, sélectionner Collapse All.

OU

➤ Appuyer sur le bouton .

Pour arboriser ou regrouper une seule branche de l’arborescence, appuyer 
sur le signe + ou sur le signe – , situés à la gauche du nom de l’élément.

Gestion des connexions de la base de données
Les données liées aux entités sont affichées sur la carte géographique, si 
une connexion a été définie avec un fichier de base de données. Gérer les 
connexions dans le Data Manager.

IMPORTANT
FiberVisor permet seulement de modifier les bases de données qu’il a 
créées. Il ne permet pas de modifier les bases de données fournies par 
l’utilisateur, peu importe le format.
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Création ou modification des connexions de base 
de données

Pour créer une nouvelle connexion de base de données ou pour modifier 
une connexion existante :

1. Dans la fenêtre principale du Gestionnaire de données (Data 
Manager), sélectionner Connection Manager depuis le menu File.

OU

Appuyer sur le bouton .

2. Lors de la création d’une connexion, appuyer sur le bouton . 
Lors de la modification d’une connexion existante, sélectionner son 
nom dans la liste des connexions.

3. Fournir ou modifier les paramètres de connexion dans le 
panneau d’information.

➤ Connection Name : entrer un nom qui identifiera la base de 
données de l’utilisateur lorsque l’utilisateur définira ultérieurement 
des entités. Ce nom apparaîtra également dans la liste 
des connexions.

➤ Connection Type : sélectionner le type de base de données à 
laquelle l’utilisateur désire se brancher. La liste offre un choix de 
formats usuels supportés.

Barre d’outils

Liste des connexions Panneau d’information
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➤ Connection Source : entrer le chemin et le nom du fichier de la 
base de données. Ce fichier ou dossier peut être localisé sur 
n’importe quel disque dur local ou de réseau.

➤ Access Mode : sélectionner un mode d’accès à la base de données. 
Les choix disponibles dépendent du type de connexion (les bases 
de données Access peuvent être lues en mode Read/Write, les 
autres bases de données sont en mode Read Only).

4. Appuyer sur le bouton  pour fermer la fenêtre Connection Manager.

Suppression de connexions existantes

Pour supprimer une connexion existante dans une base de données :

1. Dans la fenêtre principale Data Manager, sélectionner Connection 
Manager dans le menu File.

OU

Appuyer sur le bouton .

2. Dans le panneau d’arborescence de données (voir la figure à la page 
précédente), sélectionner le nom de la connexion à supprimer, puis 
appuyer sur le bouton .

IMPORTANT
Si une connexion est supprimée, toutes les entités reliées à cette 
connexion seront également supprimées.

3. Confirmer l’opération, puis appuyer sur le bouton  pour fermer la 
fenêtre Connection Manager.
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Gestion des domaines
Un domaine est l’emplacement où sera sauvegardé plusieurs entités 
apparentées. Il s’agit de l’élément de niveau supérieur dans le Data 
Manager. Son icône représente un petit dossier.

Ajout d’un domaine

Pour ajouter un nouveau domaine dans le panneau d’arborescence 
de données :

1. Dans la fenêtre principale Data Manager, sélectionner Add Domain 
dans le menu Edit.

OU

Cliquer à l’aide du bouton de droite de la souris dans le panneau 
d’arborescence de données, puis sélectionner Add Domain.

2. Attribuer un nom au nouveau domaine dans le panneau 
d’arborescence de données.

3. Définir des entités dans ce domaine, tel qu’il est expliqué dans Ajout 
d’une entité à la page 180.

Barre de
menus

Barre
d’outils

Panneau d’arborescence de données Panneau d’information
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Attribution d’un nouveau nom pour un domaine

Pour changer le nom d’un domaine :

1. Sélectionner le nom du domaine dans le panneau d’arborescence 
de données.

2. Attribuer le nouveau nom au domaine.

Suppression d’un domaine

Pour supprimer un domaine :

1. Dans le panneau d’arborescence de données (voir la figure à la page 
précédente), sélectionner le nom du domaine à supprimer.

2. Sélectionner Delete Domain dans le menu Edit.

OU

Cliquer à l’aide du bouton de droite de la souris sur le nom du 
domaine dans le panneau d’arborescence de données, puis 
sélectionner Delete Domain.

IMPORTANT
Si un domaine est supprimé, toutes les entités reliées à ce domaine 
seront également supprimées.

3. Confirmer l’opération, puis appuyer sur le bouton  pour fermer la 
fenêtre Data Manager.
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Gestion des entités
Les entités sont des éléments en mode de visualisation géographique qui 
facilitent la gestion d’un réseau de fibre optique. Elles peuvent prendre 
plusieurs formes.

Entités originales de FiberVisor

Les entités originales sont gérées par FiberVisor. Il s’agit des suivantes :

➤ éléments de réseau (des RTU ou des commutateurs à distance)

➤ alarmes

➤ annotations

➤ infrastructures

Câbles et segments

Les câbles et les segments sont gérés par FiberVisor ou par un SIG externe.

Thématique du SIG externe

FiberVisor peut visualiser la thématique du SIG externe en mode lecture 
seulement. La thématique du SIG externe peut être composée d’éléments 
géographiques, tels que des rues ou des voies ferrées.

Ajout d’une entité

Les entités sont des couches géométriques qu’il est possible de définir à 
l’intérieur d’une connexion. Elles doivent également être ajoutées à un 
domaine pour être utilisables.

Pour ajouter une entité à un domaine :

1. Dans le panneau d’arborescence de données de la fenêtre principale 
du Data Manager, sélectionner le domaine auquel une entité 
sera ajoutée.
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2. Sélectionner Add Entity dans le menu Edit.

OU

Cliquer à l’aide du bouton de droite de la souris sur le nom du 
domaine, puis sélectionner Add Entity.

3. Entrer les paramètres de l’entité dans la fenêtre Add Entity.

Paramètres Détails

Connexions Afficher les couches disponibles pour 
cette connexion.

Couches Les couches de données pour l’entité.

Géométrie Type de géométrie à afficher :
➤ Point (par point)

➤ Line (linéaire)

➤ Area (par région)

➤ Text (textuelle)

➤ All (tous les styles réunis)

Type de 
légende

Afficher la légende selon des critères spécifiques :
➤ Record : chaque catégorie de données est 

présentée de la même façon

➤ Unique Value : chaque élément peut être 
présenté différement selon le champ 
de distribution

➤ Label : (le type de géométrie doit être Text) 
le champ de distribution permet de choisir le 
texte à afficher

➤ Range : éléments groupés (ex. : câbles 
numérotés de 1 à 10, puis de 11 à 20, etc.)
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4. Appuyer sur Save Entity pour ajouter l’entité. Appuyer sur Close pour 
quitter sans sauvegarder les paramètres.

Champ de 
distribution 

Champ dans la classe de l’entité ou des 
caractéristiques définissant la clé de distribution.

Distribution Selon qu’il s’agisse d’un valeur ou d’une plage 
de valeurs.
La distribution pour une seule valeur peut être :
➤ Custom : personnalisée, telle que l’utilisateur l’a 

définie dans le champ Display

➤ Automatic : le système configurera les valeurs

La distribution pour une plage des valeurs peut être :
➤ Standard Deviation : calcule la déviation 

standard de toutes les valeurs et l’applique au 
nombre de plages

➤ Equal Range : divise trois plages de façon 
équivalente et distribue les valeurs dans 
chaque plage

➤ Equal Count : distribue le même nombre 
d’enregistrements pour chaque plage

Nombre de 
classes

Le nombre de classes dans l’entité.

Paramètres Détails
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5. Fournir ou modifier des paramètres de l’entité dans le 
panneau d’information.

➤ Entity Name : entrer un nom qui identifiera l’entité dans la légende 
du mode de visualisation géographique. Il est également possible 
de modifier le nom dans un panneau d’arborescence de données. 
De telles modifications seront sauvegardées dans les contextes, et 
non dans les bases de données.

➤ Layer : ce paramètre permet de visualiser la couche courante pour 
l’entité. Cette information est en mode lecture seulement.

➤ Geometry : ce paramètre permet de visualiser le type de géométrie utilisé 
pour cette entité. Cette information est en mode lecture seulement.

➤ Select Key : si plusieurs éléments sont sélectionnés conjointement, 
l’élément qui les regroupe sera le seul visible par l’utilisateur.

➤ Locatable by default : définit si l’utilisateur sera en mesure de 
sélectionner les éléments inclus dans cette entité.

➤ Startup display : définit si l’entité sera chargée ou non lors de la 
création d’un nouveau contexte.

➤ Display mode : définit si l’entité sera visible ou non lors de son 
chargement. Choisir By Scale permettra de configurer l’échelle à 
laquelle l’entité sera chargée.

Barre de
menus

Barre
d’outils

Panneau d’arborescence de données Panneau d’information
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6. Configurer les autres propriétés de l’entité en arborisant à l’aide du 
signe +.

7. Une fois que cela est effectué, appuyer sur le bouton  pour fermer 
le Data Manager.

Déplacement d’une entité vers un autre domaine

Il est possible de déplacer des entités d’un domaine vers un autre pour 
obtenir une meilleure gestion ou pour faciliter la visualisation.

Pour déplacer une entité d’un domaine vers un autre :

1. Sélectionner l’entité à déplacer dans le Data Manager en cliquant une 
fois sur celle-ci à l’aide du bouton de gauche de la souris et le 
maintenir enfoncé.

2. La déplacer vers son nouvel emplacement et relâcher le bouton de 
la souris.

Suppression d’une entité

Pour supprimer des entités non nécessaires :

1. Dans le Data Manager, sélectionner l’entité à supprimer en cliquant 
une fois sur celle-ci à l’aide du bouton de gauche de la souris.

2. Sélectionner Delete depuis le menu Edit.

OU

Cliquer à l’aide du bouton de droite de la souris sur la sélection pour 
accéder au menu contextuel et sélectionner Delete.

OU

Appuyer sur la touche Delete sur le clavier.

3. Appuyer sur Yes pour confirmer, ou sur No pour retourner au menu 
sans supprimer l’entité.
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14 Gestion de câbles et de fibres
Nota : Pour créer des câbles et des fibres dans FiberVisor, l’utilisateur doit être en 

mode de visualisation géographique.

Ajout d’un câble dans FiberVisor
Pour ajouter un câble dans FiberVisor :

1. Sélectionner Edit > Cable > New Cable.

2. Cliquer à l’aide du bouton de gauche de la souris sur l’endroit où 
commencera le câble.

3. Sur la carte, effectuer le tracé du câble en appuyant sur les 
localisations requises. Chaque clic consécutif sur la carte correspond à 
un point par lequel le câble passe.

4. Une fois le tracé du câble complété, cliquer sur le bouton de droite de 
la souris pour terminer le processus de création du câble et ouvrir la 
fenêtre Cable Parameters.

5. Suivre les instructions dans Configuration des paramètres d’un câble à 
la page 186.

Modification des paramètres d’un câble

Ouverture de la fenêtre Cable Configuration
Pour modifier des paramètres d’un câble existant :

1. Sélectionner un segment du câble sur la carte.

2. Sélectionner Edit > Modify. La fenêtre Cable Configuration s’affiche.
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Configuration des paramètres d’un câble

Dans la fenêtre Cable Configuration, configurer les paramètres suivants :

➤ Cable Name (nom du câble)

➤ Cable Type (type de câble)

➤ Manufacturer (fabricant du câble)

➤ Installation Date (date d’installation)

➤ Origin (point de départ)

➤ Destination (point d’arrivée)

➤ Fiber Used (nombre total de fibres utilisées)

➤ Fiber Unused (nombre total de fibre inutilisées)

➤ Optical Distance (distance optique totale du câble)

➤ Restoration Order (ordre de remise en état) 

➤ Comments (champ de commentaires)

➤ Custom Field 1 (champ disponible 1)

➤ Custom Field 2 (champ disponible 2)

➤ Custom Field 3 (champ disponible 3)

➤ lors de la création d’un câble, les coordonnées de chaque point du 
câble sélectionné sur la carte

➤ lors de la modification d’un câble, les coordonnées des segments du 
câble actuellement sélectionnés

Les coordonnées sont entrées dans le système de coordonnées de la 
fenêtre du graphique et elles sont modifiables.
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Suppression d’un câble

IMPORTANT
La suppression d’un câble élimine toutes les fibres qu’il contient et 
tous les chemins qui comprennent au moins une de ces fibres.

Pour supprimer un câble :

1. Sélectionner le câble à supprimer.

2. Sélectionner Edit > Delete. Une boîte de confirmation s’affiche.

3. Appuyer sur OK pour confirmer la suppression du câble. Le câble et 
toutes les fibres qu’il contient seront supprimés.

IMPORTANT
Si un câble est supprimé dans une base de données fournie par le 
client et que ce câble est utilisé dans la surveillance de FiberVisor, une 
alarme sera générée. Si le câble supprimé a été créé dans FiberVisor, le 
tout devrait être géré correctement.

Division d’un câble
La division d’un câble aura des impacts sur les autres câbles, les fibres et 
les chemins.

➤ La division d’un câble consiste tout simplement en la division d’un 
câble original en deux nouveaux câbles. Les deux nouveaux câbles 
posséderont les mêmes caractéristiques, mis à part leur nom et leur 
distance optique respectifs. Les nouveaux noms correspondront à 
celui du câble original, auquel les suffixes « 1 » et « 2 » seront ajoutés. 
La distance optique résulte de l’application du rapport des distances 
kilométriques de chacun des nouveaux câbles.

➤ Les fibres appartenant au câble original sont divisées et liées aux deux 
nouveaux câbles.
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➤ La liste des fibres de chaque chemin utilisant le câble original est 
modifiée afin d’intégrer de nouvelles fibres.

Pour diviser un câble en deux :

1. Sélectionner au moins un segment de câble d’un seul câble en 
utilisant l’outil de sélection graphique ou la fonction Find & Query.

2. Sélectionner Edit > Cable > Split Cable. Le pointeur de la souris se 
transforme. L’utilisateur doit indiquer la localisation du point de 
division dans le câble.

3. Cliquer à l’aide du bouton de gauche de la souris à l’endroit où le câble 
doit être divisé. Une fenêtre de confirmation s’affiche.

4. Appuyer sur OK pour confirmer la suppression du câble original et la 
création de deux nouveaux câbles.

Les coordonnées de ce point de division sont listées dans le système 
de coordonnées de la fenêtre du graphique. Ces coordonnées peuvent 
être modifiées. Une option de commutation permet d’afficher et de 
modifier les coordonnées du point de division en latitude et 
en longitude.

Configuration des paramètres pour les deux 
nouveaux câbles

Configurer les paramètres pour les deux nouveaux câbles, tel qu’il est 
expliqué dans Modification des paramètres d’un câble à la page 185.

Fusion de deux câbles
La fusion de deux câbles aura des impacts sur les autres câbles, les fibres 
et les chemins.

➤ Lorsque deux nouveaux câbles sont fusionnés en un nouveau câble, la 
segmentation des câbles sélectionnés sera perdue. 

En conservant l’un des câbles originaux, les câbles sont fusionnés en 
un câble et la segmentation des câbles est conservée.
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➤ Lors de la création d’un câble, les fibres appartenant aux câbles 
originaux sont détruites.

En conservant un des câbles sélectionnés, le nouveau câble aura les 
mêmes fibres que le câble sélectionné.

➤ Les chemins incorporant les fibres des câbles originaux sont détruits.

Pour fusionner des câbles :

1. Sélectionner au moins un segment de chacun des deux câbles 
adjacents à fusionner.

2. Sélectionner Edit > Cable > Merge Cables. La fenêtre Merge Cable 
s’affiche. 

3. Sélectionner Create a new cable pour fusionner les câbles 
préalablement identifiés en un nouveau câble.

OU

Sélectionner Keep one of the following cables pour utiliser 
l’information de l’un des câbles sélectionnés. Choisir le câble dont 
l’information doit être conservée dans la liste.

4. Appuyer sur OK pour confirmer la fusion des câbles sélectionnés.
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Création d’un événement géographique 
(segment de division) dans FiberVisor

Nota : Un câble non divisé (un câble n’ayant aucun événement autre que le début 
et la fin du câble) est traité en tant que segment dans le but de créer un 
événement géographique.

Pour créer un événement géographique :

1. Sélectionner au moins un segment du câble à segmenter, en utilisant 
l’un des outils de sélection. Pour ajouter un événement à un câble non 
segmenté, sélectionner le câble.

2. Sélectionner Edit > Segment Cable > Split Segment Cable. Le pointeur 
de la souris se transforme. L’utilisateur doit entrer la localisation du 
nouvel événement géographique.

3. Cliquer à l’aide du bouton de gauche de la souris sur la localisation du 
nouvel événement géographique du segment sélectionné. La fenêtre 
Geographical Event Parameters s’affiche.

4. Dans la fenêtre Geographical Event Parameters configurer :

➤ le type d’événement géographique

➤ les coordonnées de l’événement géographique

➤ la description de l’événement géographique

5. Appuyer sur OK pour confirmer la création du nouvel 
événement géographique.

Les coordonnées du nouvel événement géographique sont listées 
dans le système de coordonnées de la fenêtre du graphique. Ces 
coordonnées peuvent être modifiées. Une option de commutation 
permet d’afficher et de modifier des coordonnées de l’événement 
géographique en latitude et en longitude.
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Suppression d’un événement géographique 
(segment fusionné)

1. Sélectionner les segments du câble adjacent qui sont divisés par 
l’événement géographique à supprimer.

2. Sélectionner Edit > Segment Cable > Merge Segment. Une fenêtre de 
confirmation de FiberVisor Console s’affiche.

3. Appuyer sur OK pour confirmer la suppression de l’événement 
géographique. Les segments du câble original sélectionnés sont 
fusionnés en un seul segment.

Modification de la distribution des distances 
optiques le long d’un câble

IMPORTANT
La somme des distances optiques des segments qui composent le 
câble ne peut pas être modifiée et doit toujours équivaloir à la 
distance optique du câble. Pour modifier la distance optique d’un 
câble, voir Modification des paramètres d’un câble à la page 185.

Pour modifier la distribution des distances optiques le long d’un câble :

1. Sélectionner au moins un segment d’un seul câble.

2. Sélectionner Edit > Cable > Set Cable Segments OD. La fenêtre Set 
Cable Segments OD s’affiche.

3. Configurer les distances optiques associées à chaque segment du câble 
sélectionné.

4. Appuyer sur OK pour confirmer la nouvelle distribution de 
distances optiques.
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Création d’une fibre
Pour créer une fibre :

1. Sélectionner Edit> Fiber > Create Fiber. La fenêtre Create Fiber s’affiche.

2. Entrer le nom de la fibre.

3. Entrer le type de connecteur.

4. Ajouter des commentaires au besoin.

Sélectionner Add et l’information sur cette fibre sera ajoutée au tableau 
dans la partie droite de l’écran.

Création d’une série de fibres
Pour créer une série de fibres :

1. Sélectionner Edit > Fiber > Create a Series of Fibers. La fenêtre Create 
a Series of Fibers s’affiche.

2. Entrer le nom qui sera commun pour toutes les fibres, la première 
partie est composée de caractères alphabétiques fixes, suivie d’une 
incrémentation numérale.

3. Entrer le type de connecteur.

4. Ajouter des commentaires au besoin.

Sélectionner Create et la série de fibres sera ajoutée au tableau. 

Suppression d’une fibre
Pour supprimer une fibre, la sélectionner dans le tableau et appuyer sur Delete.
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15 Gestion des chemins et des 
points de mesure
Création d’un chemin

Pour créer un chemin en mode de visualisation géographique :

1. Sélectionner un RTU ou un commutateur à distance (en option) et un 
ou plusieurs segments de câble sur la carte.

2. Sélectionner Edit > Path > New Path. Les câbles qui incorporent les 
segments de câbles choisis sont automatiquement sélectionnés.

FiberVisor valide les deux conditions suivantes :

➤ un chemin provient toujours d’un RTU ou d’un commutateur 
à distance

➤ un chemin est conçu de fibres appartenant aux câbles adjacents

Un message est affiché si l’une de ces conditions n’est pas respectée. 
Toutefois, si la validation topologique est discutable, il est possible de 
passer outre cette validation et de forcer la création d’un chemin.

Si les conditions ne sont pas respectées ou que la création du chemin 
est forcée, une fenêtre s’affiche et liste tous les câbles sélectionnés, en 
ordre de séquence, commençant par le RTU.

3. Sélectionner des fibres.

Lors de l’utilisation d’une base de données géographiques d’EXFO, 
sélectionner une fibre parmi celles proposées pour chaque câble. 
Une fibre est incluse dans cette liste si :

➤ elle appartient au câble spécifié

ET

➤ elle n’est pas utilisée pour un chemin actif
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Si la base de données géographiques est propre à l’utilisateur, chaque 
fibre est entrée. Toutefois aucune liste détaillée concernant chaque 
fibre n’est incluse. Si la base de données géographiques a été fournie 
par l’utilisateur, l’information sur les câbles et les fibres est créée dans 
une base de données descriptive.

4. Appuyer sur OK pour confirmer la création du nouveau chemin.

Modification de la configuration d’un chemin
Pour modifier la configuration d’un chemin en mode de 
visualisation géographique :

1. Sélectionner au moins un segment d’un seul câble.

2. Sélectionner Edit > Path > Modify Path. Les câbles incluant les 
segments de câbles sélectionnés sont automatiquement choisis. 
Si plus d’un chemin comprend le câble sélectionné, une liste des 
chemins apparaît et permet aux utilisateurs de choisir celui à modifier. 
La fenêtre Edit Path Properties s’affiche.

3. Modifier les configurations nécessaires.

4. Appuyer sur Save pour confirmer les modifications.

Pour modifier la configuration d’un chemin en mode de visualisation 
Optical Link ou Browser :

1. Cliquer à l’aide du bouton de droite de la souris sur le chemin en mode 
de visualisation Optical Link ou Browser pour ouvrir le menu 
contextuel.

2. Sélectionner Edit properties... La fenêtre Edit Path Properties s’affiche.

3. Il est possible de changer certaines configurations dans la fenêtre Edit 
Path Properties.

4. Appuyer sur Save pour confirmer les changements.
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Suppression d’un chemin
Pour supprimer un chemin en mode de visualisation géographique :

1. Sélectionner au moins un segment d’un seul câble.

2. Sélectionner Edit > Path > Delete Path. Les câbles comprennant les 
segments de câbles sélectionnés sont automatiquement choisis. 
Si plus d’un chemin comprend le câble sélectionné, une liste des 
chemins apparaît et permet aux utilisateurs de choisir celui à 
supprimer. La fenêtre de confirmation FiberVisor s’affiche.

3. Appuyer sur OK pour confirmer la suppression du chemin sélectionné.

Pour supprimer un chemin en mode de visualisation Optical Link 
ou Browser :

1. Cliquer à l’aide du bouton de droite de la souris sur le chemin en mode 
de visualisation Optical Link ou Browser pour ouvrir le menu 
contextuel.

2. Sélectionner Delete path. Une fenêtre de confirmation 
FiberVisor s’affiche. 

3. Appuyer sur OK pour confirmer la suppression du chemin sélectionné. 

Création d’un point de mesure
Pour créer un point de mesure en mode de visualisation géographique :

1. Sélectionner un RTU.

2. Sélectionner Edit > Measurement Point > New Measurement Point.

3. Sélectionner l’endroit sur la carte géographique où se situe le point de 
mesure. Une boîte de dialogue apparaît.

4. Entrer l’information sur les nouvelles mesures, puis appuyer sur OK 
pour confirmer la création du point de mesure.
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Modification d’une configuratin d’un point 
de mesure

Pour modifier un point de mesure en mode de visualisation géographique :

1. Sélectionner un point de mesure d’un seul câble.

2. Sélectionner Edit > Measurement Point> Modify Measurement point. 
La fenêtre Edit Path Properties apparaît.

3. Modifier les configurations nécessaires.

4. Appuyer sur Modify pour confirmer les modifications.

Pour modifier un point de mesure en mode de visualisation Optical Link 
ou Browser :

1. Cliquer à l’aide du bouton de droite de la souris sur le point de mesure 
en mode de visualisation Optical Link ou Browser pour ouvrir le menu 
contextuel.

2. Sélectionner Edit properties... La fenêtre Edit Path Properties s’affiche.

3. Il est possible de changer certaines configurations dans la fenêtre 
Edit Path Properties.

4. Appuyer sur Save pour confirmer les changements.

Suppression d’un point de mesure
Pour supprimer un point de mesure en mode de 
visualisation géographique :

1. Sélectionner un point de mesure.

2. Sélectionner Edit > Measurement Point > Delete Measurement Point. 
Une fenêtre de confirmation apparaît.

3. Appuyer sur OK pour confirmer la suppression du point de 
mesure sélectionné.
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Pour supprimer un point de mesure en mode de visualisation Optical Link 
ou Browser :

1. Cliquer à l’aide du bouton de droite de la souris sur un point de mesure 
en mode de visualisation Optical Link ou Browser pour ouvrir le menu 
contextuel.

2. Sélectionner Delete measurement point. Une fenêtre de confirmation 
apparaît. 

3. Appuyer sur OK pour confirmer la suppression du chemin sélectionné. 
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16 Utilisation des infrastructures 
et des annotations

Les infrastructures sont des éléments sur le terrain qui peuvent avoir un 
impact sur le réseau de fibres (ex. : édifices, pylônes de transmission, trous 
d’homme, etc.). Il est possible d’ajouter des infrastructures sur la carte afin 
d’obtenir un meilleur aperçu du réseau et de son environnement. Les 
infrastructures ne sont pas branchées au réseau de fibres, elles sont 
seulement affichées sur la carte.

Les annotations sont des sections de textes que l’utilisateur peut ajouter à 
n’importe quel élément sur la carte, à des fins de description. Les 
annotations peuvent être liées à une entité particulière afin qu’elles soient 
automatiquement supprimées avec les éléments qui y sont associés.

Création d’une infrastructure
Pour créer une infrastructure sur la carte :

1. En mode de visualisation géographique, sélectionner Edit > Infrastructure 
> New Infrastructure. Le pointeur de la souris se transforme.

2. Appuyer sur la localisation de la nouvelle infrastructure.

3. Configurer les paramètres suivants :

➤ la description de l’infrastructure

➤ le type d’infrastructure (depuis le GIS Data Manager)

➤ les coordonnées de l’infrastructure (dans le système de 
coordonnées de FiberVisor)
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4. Appuyer sur OK pour confirmer la création d’une 
nouvelle infrastructure.

Modification d’une infrastructure
1. Sélectionner une infrastructure sur la carte. Pour plus de 

renseignements sur cette sélection, voir Sélection et désélection 
d’éléments sur la carte à la page 67.

2. Sélectionner Edit > Infrastructure > Modify Infrastructure.

3. Modifier les paramètres d’infrastructure et appuyer sur OK.

Suppression d’une infrastructure
1. Sélectionner une infrastructure sur la carte. Pour plus de 

renseignements sur cette sélection, voir Sélection et désélection 
d’éléments sur la carte à la page 67.

2. Sélectionner Edit > Infrastructure > Delete Infrastructure.

3. Appuyer sur OK pour confirmer la suppression de l’infrastructure.
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Création d’une annotation
Pour créer une annotation sur une carte :

1. Sélectionner l’élément géographique auquel ajouter une ou plusieurs 
annotations. Si aucun élément n’est sélectionné, l’annotation ne sera 
pas associée à un élément particulier (ex. : pour un logo ou une date).

2. En mode de visualisation géographique, sélectionner Edit > 
Annotation > New Annotation. Le pointeur de la souris se transforme.

Nota : Si l’utilisateur sélectionne plus d’un élément géographique, une boîte de 
dialogue permet de choisir l’élément à annoter.

3. Appuyer sur la localisation de la nouvelle annotation.

4. Dans la fenêtre New Annotation, entrer le texte de l’annotation ainsi 
que l’élément géographique décrit (couche ou nom).

Modification d’une annotation
1. Sélectionner une annotation sur la carte. L’annotation doit être localisable 

pour pouvoir être sélectionnée. Pour rendre une annotation localisable, 
voir Personnalisation de l’affichage de la légende à la page 65.

2. Sélectionner Edit > Annotation > Modify Annotation.

3. Il est seulement possible de modifier le texte de l’annotation. Appuyer 
sur OK une fois terminé.

Suppression d’une annotation
1. Sélectionner une annotation sur la carte. L’annotation doit être localisable 

pour pouvoir être sélectionnée. Pour rendre l’annotation localisable, voir 
Personnalisation de l’affichage de la légende à la page 65.

2. Sélectionner Edit > Annotation > Delete Annotation.

3. Appuyer sur OK pour confirmer la suppression de l’annotation.
Système de vérification de fibres à distance 201



Utilisation des infrastructures et des annotations
Déplacement d’une annotation

A
d

m
in

is
tr

at
eu

r

Déplacement d’une annotation
1. Sélectionner une annotation sur la carte. L’annotation doit être 

localisable pour pouvoir être sélectionnée. Pour rendre l’annotation 
localisable, voir Personnalisation de l’affichage de la légende à la 
page 65.

2. Sélectionner Edit > Annotation > Move Annotation. Le pointeur de la 
souris se transforme.

3. Appuyer sur la nouvelle localisation de l’annotation. Cette dernière est 
déplacée vers la nouvelle localisation.

Regénération des annotations sur des câbles
Cette fonction est utile si la base de données du câble n’a pas été créée 
avec FiberVisor. Il est possible de générer automatiquement des 
annotations basées sur un champ de texte prédéfini de la base de données 
externe. Ceci simplifie également le travail si plusieurs câbles ont 
été créés.

IMPORTANT
La regénération d’annotations sur des câbles supprimera toutes les 
annotations des câbles antérieures.

Pour regénérer des annotations de câbles, sélectionner Edit > Annotation 
> Generate Cable Annotation.

Chaque annotation sera positionnée au centre du premier segment 
de câble.
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17 Fonctionnement 
d’applications externes par 
des liaisons dynamiques

Une liaison dynamique (hotlink) est l’association entre un élément de la 
carte géographique et une application externe à lancer. On retrouve deux 
catégories de liaisons dynamiques : générale et spécifique. 

➤ La liaison dynamique générale lancera une application externe 
spécifique associée à un type d’élément sélectionné. Par exemple, il 
est possible de déterminer que la localisation physique de chaque RTU 
soit associée à une image en format bitmap, et de configurer une 
liaison dynamique générale pour ouvrir Microsoft Paint afin de 
visualiser ces images en format bitmap.

➤ La liaison dynamique spécifique lancera une application externe 
spécifique, mais seulement pour l’élément sélectionné. 

Pour créer une liaison dynamique spécifique pour un fichier, une liaison 
dynamique générale doit d’abord avoir été créée pour la catégorie 
d’éléments sélectionnés. 

Par exemple, si un fichier-texte contenant de l’information est attaché à 
chaque RTU et est ouvert à l’aide de Microsoft Notepad grâce à une liaison 
dynamique générale, il est possible de configurer une liaison dynamique 
spécifique pour un fichier-texte particulier plus imposant que les autres et 
de le configurer pour qu’il s’ouvre plutôt dans Microsoft Wordpad.

Il est seulement possible d’avoir une liaison dynamique générale par 
catégorie de fichier, mais autant de liaisons dynamiques spécifiques que 
désirées. Une liaison dynamique spécifique aura toujours priorité sur une 
liaison dynamique générale. Si plus d’une liaison dynamique a été créée 
pour la même entité, l’entité qui a été créée en premier a la priorité.
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Fonctionnement d’une liaison 
dynamique existante

Pour lancer une application associée à un élément particulier :

1. Dans le menu Navigate, sélectionner Run Hotlink. Le pointeur de la 
souris se transforme.

2. Sélectionner un élément sur la carte.

➤ Si une liaison dynamique est définie pour cet élément, 
l’application externe sera lancée et affichera l’élément associé.

➤ Si une liaison dynamique n’est pas définie, un message apparaîtra 
et mentionnera de le faire.

Création et suppression de 
liaisons dynamiques

Ces opérations sont accomplies dans le Data Manager du SIG, tout comme 
la création d’autres entités. Pour plus de renseignements, voir 
Configuration du SIG à l’aide du gestionnaire de données à la page 173.
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18 Configuration de 
l’acheminement des alarmes

Une copie des alarmes générées par FiberVisor est consignée en tant 
qu’événement dans le Event Log (journal d’événements) de Windows NT. 
Ce fichier journal est surveillé sur le TSC par le logiciel LogCaster de 
RippleTech, qui filtre les événements et les traite selon les résultats.

Information sur les alarmes de FiberVisor Event Log de 
Windows NT

La date et l’heure auxquelles le TSC reçoit l’alarme Date et heure

Le nom du TSC PC

Le nom de l’élément du réseau ou du TSC
comprennant le composant qui provoque l’alarme

Source

Numéro constant : 63005 No de 
l’événement

Cartographie les six niveaux de gravité du TMN en 
trois catégories :

➤ Information (supprimée, indéterminée ou 
informationelle)

➤ Avertissement (avertissement ou mineur)

➤ Erreur (majeur ou critique)

Type

Niveau de gravité du TMN Catégorie

Un message d’alarme formaté et, si l’alarme est liée à la 
surveillance de l’OTDR, le contenu du Spare Field 1, soit le 
champ disponible 1 pour les câbles défectueux

Description

Le numéro du composant du logiciel qui cause l’alarme et
le numéro de l’événement séparés par un point

Données 
brutes
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Si le logiciel LogCaster est installé correctement sur le TSC, il est possible 
de l’utiliser pour configurer les filtres et les opérations d’acheminement 
possibles. Ces tâches sont expliquées brièvement ci-dessous. Pour plus de 
renseignements, se référer à la documentation du LogCaster incluse 
avec FiberVisor.

Lancement et sortie de l’application LogCaster 
sur le ONC

LogCaster a été installé avec FiberVisor sur le TSC, mais il est possible 
d’accéder au LogCaster Console (ne pas confondre avec FiberVisor 
Console) depuis l’ONC. Pour ce faire, un compte NT de type 
« Domain Admin » est requis.

Pour lancer LogCaster depuis FiberVisor Console :

1. Dans le menu Tools, sélectionner Administration, puis Launch 
LogCaster... La fenêtre RippleTech LogCaster Login s’affiche.

2. Entrer l’information d’accès, tel qu’il est expliqué ci-dessous.

➤ Dispatcher : nom du TSC dans le panneau de configuration 
(Control Panel) de Windows.

➤ User ID and Password : utiliser la même information que pour 
l’ouverture d’une session Windows NT.
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➤ Domain : entrer le nom du domaine NT pour lequel le TSC est le 
contrôleur du domaine principal (PDC). Voir Gestion de la sécurité 
du réseau et des niveaux d’accès à la page 219.

IMPORTANT
Ne pas modifier les champs Port, VPN Key et Update Rate. Ceux-ci ne 
sont pas utilisés. Toute modification apportée à ces champs peut 
mener à des résultats imprévisibles.

IMPORTANT
Il est impossible d’accéder à LogCaster Console sur plus d’un PC à la 
fois avec le même compte utilisateur. Toutefois, différents comptes 
permettent à plusieurs utilisateurs d’accéder simultanément à 
LogCaster Console.

3. Appuyer sur Login pour valider les données entrées et accéder à la 
fenêtre principale RippleTech LogCaster Console.
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Pour quitter LogCaster et retourner à FiberVisor Console, fermer 
simplement LogCaster Console. Toutes les modifications apportées seront 
sauvegardées sur le TSC.

Définition des filtres pour l’acheminement 
d’événements

LogCaster filtre les événements dans le Event Log (journal d’événements) 
de Windows NT à l’aide d’une série de critères et traite ces événements 
selon les résultats.

Les filtres ont été prédéfinis pour le système de l’utilisateur lors de 
l’installation. Ces filtres par défaut sont appliqués séquentiellement, dans 
l’ordre établit par le tableau suivant.

Filtering Rule 
Description NT Log Name Event ID Event Type Category

FiberVisor severity = 
cleared

Application 63005 Information Cleared

FiberVisor severity = 
indeterminate

Application 63005 Information Indeterminate

FiberVisor severity = 
informational

Application 63005 Information Informational

FiberVisor severity = 
warning

Application 63005 Warning Warning

FiberVisor severity = 
minor

Application 63005 Error Minor

FiberVisor severity = 
major

Application 63005 Error Major

FiberVisor severity = 
critical

Application 63005 Error Critical
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Application Log – 
Critical
(unrelated to 
FiberVisor)

Application — Error —

System Log – Critical
(unrelated to 
FiberVisor)

System — Error —

Discard Security Log Security — — —

Discard System Log – 
Informational

System — Information —

Discard System Log – 
Warning

System — Warning —

Discard Application Log 
– Informational

Application — Information —

Discard Application Log 
– Warning

Application — Warning —

Filtering Rule 
Description NT Log Name Event ID Event Type Category
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Pour effacer des filtres par défaut ou pour en ajouter de nouveaux :

1. Dans le panneau de gauche de LogCaster, appuyer sur l’icône Event 
Watcher Config.

2. Pour créer un filtre, cliquer aléatoirement à droite dans la fenêtre Event 
Watcher Rule Description. Le nouveau filtre apparaîtra à la fin de la liste 
en tant que<User Defined Rule>.

OU

Pour modifier un filtre existant, appuyer sur le filtre désiré pour 
le sélectionner.

3. Dans la liste Rule Criteria Based On Header, sélectionner les critères à 
ajouter ou à modifier en cochant ou en décochant les cases situées à 
la gauche de la liste.

4. Dans Event Watcher Rule Options, sélectionner l’option à configurer ou 
à modifier et appuyer sur celle-ci pour faire apparaître la fenêtre de 
l’option liée. Après avoir entré ou modifié les configurations désirées, 
appuyer sur OK pour fermer la fenêtre. Appuyer sur Cancel pour 
fermer la fenêtre sans modifier les configurations.

Pour plus de renseignements sur les filtres de LogCaster, se référer à la 
documentation de LogCaster.
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Configuration de l’acheminement vers le 
téléavertisseur et le modem

Pour définir les configurations de l’acheminement vers le téléavertisseur 
ou le modem depuis la fenêtre principale de LogCaster Console :

1. Depuis la barre d’outils dans la partie gauche de la fenêtre, 
sélectionner Event Dispatcher Config. La fenêtre Event Routing Settings 
apparaît.

2. Sélectionner l’onglet Generic Dialup Pager.

3. Entrer l’information spécifiée par votre fournisseur local. Dans la liste 
COM Port, sélectionner « TAPI » pour que l’acheminement fonctionne.

4. Pour vérifier si les options de dialogue ont été configurées 
correctement, appuyer sur Test.... La fenêtre Send A Test Page apparaît.
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5. Entrer le NIP du téléavertisseur et le message à envoyer, puis appuyer 
sur Send. Le message devrait être transmis au téléavertisseur. En cas 
contraire, il est possible de consulter des fichiers journaux de 
LogCaster pour identifier la cause du problème.

Le tableau suivant indique les chemins où se trouvent les fichiers 
journaux. Ils portent tous l’extension « .log ».

6. Lorsque la communication par courriel est configurée correctement, 
appuyer sur Close dans la fenêtre Send A Test Page, puis appuyer sur 
OK dans Event Dispatcher Config.

Chemins Fichiers journaux

c:\LogCasterConsole\bin\console Console

c:\LogCasterConsole\bin\console\config DB Console

d:\LogCaster\252\bin\agent_home Server

d:\LogCaster\252\bin\eds_home\config DB Server
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Configuration de l’acheminement de courriels
Pour définir les configurations de l’acheminement de courriels, depuis la 
fenêtre principale LogCaster Console :

1. Dans la barre d’outils de la partie gauche de la fenêtre, sélectionner 
Event Dispatcher Config.

2. Sélectionner l’onglet Email.

3. Entrer l’information spécifiée par l’administrateur du réseau.

4. Pour vérifier si les options de courriel ont été configurées 
correctement, appuyer sur Test.... La fenêtre Email Route Test apparaît.
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5. Entrer le message à envoyer, puis appuyer sur Send. Le message 
devrait être transmis au destinataire du courriel. En cas contraire, il est 
possible de consulter les fichiers journaux de LogCaster pour identifier 
la cause du problème.

Le tableau suivant indique les chemins où se trouvent les fichiers 
journaux. Ils portent tous l’extension « .log ».

6. Lorsque la communication par courriel est configurée correctement, 
appuyer sur Close dans la fenêtre Send A Test Page, puis appuyer sur 
OK dans Event Dispatcher Config.

Configuration de l’acheminement des alarmes 
sur le RTU

La plupart des activités d’acheminement doivent être configurés sur le 
ONC. Toutefois, il configurera le téléavertisseur de rechange est configuré 
sur le RTU. Pour plus de renseignements sur la configuration d’un 
téléavertisseur de rechange, voir Configuration du téléavertisseur de 
rechange à la page 128.

Chemins Fichiers journaux

c:\LogCasterConsole\bin\console Console

c:\LogCasterConsole\bin\console\config DB Console

d:\LogCaster\252\bin\agent_home Server

d:\LogCaster\252\bin\eds_home\config DB Server
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19 Inventaire matériel et logiciel 
et gestion
Aperçu du Systems Management Server

Microsoft Systems Management Server (SMS) s’accompagne d’une foule 
d’outils destinés à effectuer l’inventaire détaillé des logiciels et du matériel, 
la mesure d’utilisation et la distribution des logiciels ainsi que l’installation 
de plusieurs unités à distance sans, dans ce cas, devoir quitter le TSC. 
Ainsi, il est possible d’économiser du temps et de la main-d’oeuvre en 
programmant des tâches et en les répétant pour chaque poste à distance. 
Cet ensemble permet également d’exécuter le dépannage à distance.

Pour plus renseignements sur le SMS, se référer à la documentation de 
Microsoft Systems Management Server fournie avec le système.

Collecte de l’inventaire matériel et logiciel
À des intervalles réguliers, le TSC collecte l’information suivante sur les 
ONC et les RTU :

➤ une liste des logiciels installés : système opérationnel, logiciel 
FiberVisor, autres logiciels EXFO (environnement IQ) et logiciels 
autres que ceux d’EXFO

➤ une liste des modules installés dans le RTU (type de module, numéro 
de série et emplacement IQ-203)

➤ une liste des modules branchés à distance au RTU (commutateurs 
à distance)

Cet inventaire est automatiquement recueilli par le Systems Management 
Server (SMS) de Microsoft.
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Distribution de la nouvelle version logicielle
Les nouvelles versions logicielles (RTU et ONC) sont placées dans un 
répertoire prédéfini sur le TSC par l’administrateur. Un horaire est par la 
suite défini pour distribuer les nouvelles versions. Les filtres feront le tri afin 
d’indiquer quel logiciel ira à quel emplacement.

Pour lancer la distribution de logiciels depuis le SMS :

1. Cliquer à l’aide du bouton de droite de la souris sur la localisation dans 
l’arborescence où intégrer le nouveau logiciel. Le menu contextuel 
apparaît.

2. Dans le menu contextuel, sélectionner All Tasks > Distribute Software.
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3. Depuis la fenêtre Distribute Software Wizard, sélectionner l’ensemble 
à distribuer, ou en créer un en sélectionnant l’option correspondante. 

Pour distribuer un ensemble existant, sélectionner l’ensemble 
correspondant dans la liste Packages. Appuyer sur Next pour continuer.

4. Sélectionner la base de données du site SMS à laquelle l’utilisateur 
désire se brancher en faisant défiler la liste des bases de données 
existantes du site.

OU

Sélectionner une nouvelle base de données du site en choisissant 
l’option correspondante, puis appuyer sur le bouton Browse pour 
trouver le site désiré.
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5. Déterminer entre charger tous les éléments d’arborescence de la 
console ou seulement ceux sélectionnés en choisissant l’option 
correspondante. Appuyer sur Next pour continuer.

6. Suivre les instructions à l’écran jusqu’à ce que la nouvelle version 
logicielle soit installée. 

Pour plus de renseignements sur la distribution de logiciels, se référer à la 
documentation incluse avec le System Management Server.
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20 Gestion de la sécurité du 
réseau et des niveaux d’accès
Aperçu de la sécurité du réseau de FiberVisor

La sécurité du réseau comprend les éléments suivants :

➤ Contrôleur du domaine principal (PDC, pour Primary Domain 
Controller) : premier serveur NT sur le réseau. Inclut et conserve les 
données des utilisateurs et des groupes pour ce domaine.

➤ Contrôleur du domaine de réserve (BDC, pour Backup Domain 
Controller) : contient une copie des données du PDC et peut être 
utilisé en tant qu’élément de réserve du PDC, au cas où des problèmes 
sur le système principal surviendraient.

Les PDC et les BDC peuvent être utilisés pour ouvrir une session.

➤ Domaine : application ou groupe d’objets qui peut être accédé par un 
groupe spécifique.

➤ Relation d’approbation : peut être unidirectionnelle ou 
bidirectionnelle. Par exemple, si l’utilisateur se branche à un dispositif 
A, et qu’un dispositif B a une relation d’approbation avec ce dernier, 
il est possible d’accéder au dispositif B, parce que la relation 
d’approbation considère l’utilisateur comme étant « identifié 
correctement ». La relation d’approbation n’est pas transitive, ce qui 
signifie que si les dispositifs A et B partagent une relation 
d’approbation, et que les dispositifs B et C partagent également une 
relation d’approbation, les dispositifs A et C ne partageront pas une 
relation d’approbation, à moins qu’il y en ait une directe entre eux. 
La relation d’approbation n’influence pas l’accès au domaine. Il est 
possible d’accéder au dispositif X, mais non aux domaines sur celui-ci, 
car le système d’autorisation d’accès ne le permet pas.

➤ Groupes globaux : le groupe global ne peut pas contenir d’autres 
utilisateurs ou groupes provenant d’autres domaines. Le terme global 
signifie que les privilèges attribués à ce groupe sont valides à travers 
tout le réseau.
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➤ Comptes utilisateurs globaux : proviennent d’un environnement NT. 
Les comptes utilisateurs globaux sont regroupés dans un domaine.

Groupes locaux : peuvent contenir des utilisateurs du domaine dans 
lequel le groupe local a été créé. Les groupes peuvent inclure des 
utilisateurs globaux provenant d’autres domaines approuvés par le 
domaine du groupe. Ils peuvent aussi intégrer des groupes globaux 
provenant d’autres domaines approuvés par le domaine du groupe 
local. Ces derniers se voient attribuer les mêmes privilèges que le 
groupe local, mais n’ont pas les privilèges d’autres domaines.

➤ Comptes utilisateurs locaux : proviennent de l’extérieur de 
l’environnement NT. Ils ne peuvent pas être utilisés hors du domaine 
dans lequel ils ont été créés. 

Groupes d’utilisateurs
Les groupes d’utilisateurs sont divisés en trois niveaux :

➤ RFTS_OPERATORS, regroupe les opérateurs ayant accès au système

➤ RFTS_MANAGER, regroupe les gestionnaires ayant accès au système

➤ RFTS_ADMIN, regroupe les administrateurs ayant accès au système

Nota : Seul un utilisateur de type administrateur peut accéder à la fois au réseau. 
Si un deuxième utilisateur de type administrateur essaie de lancer 
FiberVisor Console ou LogCaster, un message l’avertira qu’un 
administrateur a déjà ouvert une session et que seules des actions de 
niveau gestionnaire sont disponibles.

Un groupe est créé pour chaque RTU portant le nom du RFTSNEL en tant 
que préfixe. Un administrateur a accès à chaque RTU, indépendamment 
des groupes utilisateurs du RTU. Un gestionnaire ou un opérateur aura 
accès au RTU s’il fait partie du compte du groupe de ce RTU.
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Il y a deux niveaux d’autorisation sur le TSC :

➤ Native : fournit par NT lorsque l’utilisateur se branche au réseau.

➤ Owner : selon le type d’utilisateur, le TSC avise l’ONC des droits 
d’accès de l’utilisateur aux RTU.

Gestion des comptes utilisateurs NT
En tant qu’administrateur, il est possible de gérer des comptes utilisateurs 
NT dans un système en ajoutant, en modifiant ou en les supprimant.

Ajout d’un compte utilisateur

Pour ajouter un compte utilisateur :

1. Sélectionner le menu User.

2. Sélectionner l’option New User...

3. Entrer l’information et la confirmer.

Modification d’un compte utilisateur

Pour modifier un compte utilisateur :

1. Sélectionner un compte utilisateur.

2. Sélectionner le menu User.

3. Sélectionner l’option Properties.

4. Entre les modifications et les confirmer.

Suppression d’un compte utilisateur

Pour supprimer un compte utilisateur :

1. Sélectionner un compte utilisateur.

2. Sélectionner le menu User.

3. Sélectionner Delete.
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Ajout ou retrait de comptes depuis les listes
Lors de l’évolution du réseau, il est possible d’ajouter ou de retirer des 
comptes utilisateurs depuis les listes opérateur, gestionnaire et 
administrateur.

Pour ajouter un compte utilisateur à la liste désirée :

1. Sélectionner un compte utilisateur.

2. Sélectionner le menu User.

3. Sélectionner l’option Properties.

4. Sélectionner le bouton Groups.

5. Ajouter le compte RFTS_OPERATORS, RFTS_MANAGERS ou 
RFTS_ADMIN dans la liste member of, selon la liste à modifier.

Pour retirer un compte utilisateur depuis la liste désirée :

1. Sélectionner un compte utilisateur.

2. Sélectionner le menu User.

3. Sélectionner l’option Properties.

4. Sélectionner le bouton Groups.

5. Retirer le compte RFTS_OPERATORS, RFTS_MANAGERS ou 
RFTS_ADMIN depuis la liste member of à modifier.
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Assignation d’utilisateurs à FiberVisor et à des 
groupes de RTU spécifiques

Dans certains cas, il est possible d’assigner des utilisateurs à des 
RTU spécifiques.

Ajout d’un compte utilisateur à un RTU spécifique

Pour ajouter un compte utilisateur à la liste des utilisateurs ayant accès à 
un RTU spécifique :

1. Sélectionner un compte utilisateur.

2. Sélectionner le menu User.

3. Sélectionner l’option Properties.

4. Sélectionner le bouton Groups.

5. Ajouter un compte utilisateur à la liste RFTSNEL_*** member choisie.

Retrait d’un compte utilisateur depuis un 
RTU spécifique

Pour retirer un compte utilisateur de la liste d’utilisateurs ayant accès à un 
RTU spécifique :

1. Sélectionner un compte utilisateur.

2. Sélectionner le menu User.

3. Sélectionner l’option Properties.

4. Sélectionner le bouton Groups.

5. Supprimer le compte utilisateur de la liste RFTSNEL_*** member of 
choisie.
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Clés électroniques et gestion des licences EXFO
Le TSC est muni d’une clé électronique de type Aladdin HASP pour gérer le 
nombre de licences ONC et RTU sur le système. La clé électronique doit 
être en place sur le TSC pour que le système fonctionne correctement.

Gestion de licences ONC

Le nombre de licences ONC correspond au nombre de branchements 
simultanés au TSC (ou au nombre d’utilisateurs faisant fonctionner 
FiberVisor Console simultanément), indépendamment du nombre actuel 
de PC sur lesquels FiberVisor Console est installé.

Par exemple, si le réseau comprend dix ONC, il est possible pour 
l’utilisateur de détenir cinq licences si seulement cinq utilisateurs font 
fonctionner le FiberVisor Console simultanément.

Gestion de licences RTU

Le nombre de licences RTU correspond au nombre de RTU actifs, tel qu’il 
est défini dans la base de données du TSC. Cela signifie que tous les RTU 
peuvent être théoriquement branchés simultanément, mais il se peut que 
certains RTU ne soient pas actifs.

Un RTU peut tout de même fonctionner et accomplir une surveillance s’il 
n’est pas associé à une licence valide. Toutefois, les alarmes qu’il génère 
ne seront pas acheminées et validées.
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21 Validité de données 
et sécurité
Hébergement de contenu avec l’agent SQL

L’agent SQL est une application de Windows NT qui permet à l’utilisateur 
de programmer un serveur Windows NT pour accomplir 
automatiquement plusieurs actions spécifiques nommées tâches. 
Ces tâches, à l’exception de la vérification des alarmes, ont été 
préprogrammées pour le système FiberVisor et l’utilisateur n’a pas à 
les modifier.

Dans le tableau suivant se trouve les noms des tâches, des actions qu’elles 
accomplissent et de la cadence à laquelle elles sont accomplies.

Nom de la tâche Action accomplie Cadence

Archivage des 
alarmes

Archive (copie de sécurité et 
suppression) toutes les alarmes 
générées depuis les sept derniers jours.

Hebdomadaire

Synchronisation 
de la base de 
données

Vérifie l’intégrité de la base de 
données descriptive 
comparativement à la base de 
données géomatique.

Quotidienne

Vérification 
d’alarmes non 
confirmées

Vérifie s’il y a des alarmes non 
confirmées et envoie une notification 
s’il y a lieu.

À l’heure

Vérification du 
signal de l’activité 
du RTU

Vérifie que le RTU a envoyé des 
signaux au moins à une reprise au 
cours des dernières 24 heures. Envoie 
une alarme si ce n’est pas le cas.

Quotidienne

Vérification de 
l’espace du 
lecteur du TSC

Vérifie que l’espace des lecteurs C, D 
et E convient au minimum spécifié 
dans le système. Autrement, une 
alarme est générée pour chaque 
lecteur défectueux.

Quotidienne
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Vérification de 
l’intégrité de la 
base de données 
FiberVisor

Vérifie que la base de données de 
FiberVisor est cohérente.

Quotidienne

Vérification de 
l’intégrité de la 
base de données 
GISD20

Vérifie que la base de données 
GISD20 est cohérente.

Quotidienne

Mise à jour de 
statistiques de 
distribution de 
données 
FiberVisor

Met à jour les statistiques de 
distribution de données dans la base 
de données FiberVisor afin 
d’optimiser la performance 
de l’accès.

Quotidienne

Mise à jour de 
statistiques de 
distribution de 
données GISD20

Met à jour les statistiques de 
distribution de données dans la base 
de données GISD20 afin d’optimiser la 
performance de l’accès.

Quotidienne

Copie de sécurité 
de la base de 
données 
FiberVisor

Effectue une copie de sécurité de la 
base de données FiberVisor.

Quotidienne

Copie de sécurité 
de la base de 
données GISD20

Effectue une copie de sécurité de la 
base de données GISD20.

Quotidienne

Nettoyage du 
OFN20

Supprime la copie de sécurité la plus 
ancienne de la liste.

Quotidienne

Nettoyage du 
OFN20 et 
attribution d’un 
nouveau nom

Renomme les copies de sécurité 
restantes en ajoutant une 
incrémentation numérique.

Quotidienne

Copie de sécurité 
du OFN20

Effectue une copie de sécurité de la 
base de données OFN20.

Quotidienne

Nom de la tâche Action accomplie Cadence
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Synchronisation de données
Afin d’assurer une intégrité permanente entre les nombreuses bases de 
données, une synchronisation est effectuée au cours de la nuit.

La synchronisation des bases de données consiste en une comparaison 
des entrées incluses dans les différentes bases de données et en une 
validation de la topologie entre les nombreux éléments géométriques.

Les processus de synchronisation varient selon la configuration 
du système :

➤ Si la base de données géométrique du câble provient du client, la BDD 
est synchronisée avec la BDCG.

➤ Si la base de données géométrique du câble provient d’EXFO, la BDCG 
est synchronisée avec la BDD.

De plus, les données dans le OFN20 sont également mises à jour selon les 
modifications qui surviennent dans la BDD au cours de la journée.

Les données dans ces trois bases de données sont configurées pour être 
synchronisées. Les sources d’information primaires sont les bases de 
données du câble, puisqu’elles peuvent ne pas être modifiables. 
Il est possible de modifier des données comprises dans la base de 
données descriptive selon le contenu des bases de données du câble. Les 

Nettoyage du 
BDGC

Supprime la copie de sécurité la plus 
ancienne de la liste.

Quotidienne

Nettoyage du 
BDGC et 
attribution d’un 
nouveau nom

Renomme les copies de sécurité 
restantes en ajoutant une 
incrémentation numérique.

Quotidienne

Copie de sécurité 
du BDGC

Effectue une copie de sécurité de la 
base de données du BDGC.

Quotidienne

Nom de la tâche Action accomplie Cadence
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données incluses dans la base de données RFTS peuvent ainsi être 
modifiées selon les bases de données descriptives, si des inconsistances 
sont décelées.

Nota : Un processus de synchronisation existe pour les trois permières bases de 
données. La source d’information primaire est la base de données du 
câble, puisqu’elle peut ne pas être modifiable. Il est possible de modifier la 
base de données descriptive selon le contenu des bases de données du 
câble. La base de données RFTS peut ainsi être modifiée selon les bases de 
données descriptives, si des inconsistances sont décelées. Pour plus de 
renseignements sur la synchronisation, voir Synchronisation de données à 
la page 227.

Restructuration de données
Les données incluses dans les bases de données principales y sont 
conservées pendant une période de 365 jours. Après cette période, les 
données seront transférées des bases de données principales vers des 
bases de données secondaires en format MS-Access. 

Les bases de données contextuelles relatives aux données archivées sont 
également copiées dans des bases de données secondaires. Ces bases de 
données sont indépendantes et peuvent être visualisées et analysées dans 
d’autres environnements, tels que des logiciels bureautiques. Pour 
rallonger la période d’archivage, veuillez communiquer avec EXFO.

Copies de sécurité
Le système effectuera une copie de sécurité des données et les copiera sur 
le lecteur E. Cette opération est accomplie quotidiennement et les 
données sont conservées pendant cinq jours. Si l’utilisateur emploie une 
méthode de sauvegarde différente pour les données de sécurité, il est 
possible de la personnaliser afin que les données soient prises du lecteur E 
et copiées dans le support de stockage de réserve habituel.
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Redondance de l’unité de disque dur
Pour assurer qu’aucune donnée ne soit perdue au cas de défaillance de 
l’unité de disque dur principal, le système possède des unités de disque 
dur de sécurité (effectuant le miroitage des unités de disque dur 
actuellement utilisées).
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22 Dépannage et entretien
Dépannage

Problèmes Causes possibles Solutions proposées

Impossible de se 
brancher au 
contrôleur du 
système de test 
(TSC).

Les câbles ne sont pas 
branchés correctement.

Vérifier les connexions 
des câbles.

Le protocole TCP/IP n’est 
pas configuré 
correctement.

S’assurer que le protocole 
TCP/IP est exact.

L’adresse IP du contrôleur 
du système de test (TSC) 
est incorrecte.

S’assurer que l’adresse IP 
est exacte.

L’identification interne de 
l’unité de vérification à 
distance (RTU) est 
incorrecte dans la base de 
données.

Rafraîchir la configuration.

L’unité de vérification à 
distance (RTU) ou le 
commutateur à distance 
n’existe pas dans la base 
de données.

Utiliser la console 
FiberVisor sur un 
contrôleur du réseau 
optique (ONC) pour créer 
l’unité ou le commutateur.

Notifications de 
nouvelles alarmes, 
mais aucune 
émission sonore.

La notification sonore 
n’est pas activée.

Activer la notification 
sonore depuis le menu 
Tools/Options de la 
visualisation d’alarmes.

Les haut-parleurs ne sont 
pas activés ou le volume 
est réglé trop bas.

S’assurer que les 
haut-parleurs sont activés 
et que le volume est 
assez élevé.

Les hauts-parleurs ne sont 
pas branchés 
correctement.

Vérifier les branchements 
du câble.
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Lorsqu’un problème survient, des suggestions sont affichées dans la 
section inférieure de l’onglet Alarms. Il est recommandé de consulter tout 
d’abord la section ci-dessus pour le dépannage.

Entretien

IMPORTANT
Lorsqu’un module de test n’est pas utilisé, il est recommandé que les 
capuchons de protection soient installés sur les ports du détecteur.

Pour consulter les instructions d’entretien spécifiques à l’un des 
composants du système RFTS, se référer au manuel correspondant.

Transport et entreposage
Maintenir l’appareil à une température conforme aux spécifications durant 
le transport et l’entreposage. Une manutention inadéquate peut causer des 
dommages à l’appareil. Par conséquent, les précautions suivantes doivent 
être prises afin de réduire les risques de dommages :

➤ Remettre l’appareil dans son emballage d’origine s’il doit être expédié.

➤ Entreposer l’appareil à la température de la pièce dans un endroit 
propre et sec.

➤ Éviter d’exposer l’appareil aux rayons directs du soleil, aux chocs, à 
l’humidité ou aux grandes fluctuations de température.

Impossible de 
raccorder l’unité de 
vérification à 
distance (RTU) 
au réseau.

Toutes les licences des 
unités de vérification à 
distance (RTU) 
sont utilisées.

Supprimer une liaison 
d’un autre RTU pour 
utiliser sa licence.

Acquérir une autre licence.

Problèmes Causes possibles Solutions proposées
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Assistance téléphonique
Si un problème survient lors de l’utilisation de l’appareil, communiquer 
avec EXFO à l’un des bureaux mentionnés ci-dessous. Il est possible de 
joindre les préposés du groupe de soutien technique en Amérique du 
Nord, du lundi au vendredi, de 7 h 30 à 20 h (heure de l’Est).

EXFO Ingénierie électro-optique inc.
(Siège social)
465, avenue Godin
Vanier (Québec) G1M 3G7
CANADA

1 866 683-0155 (É.-U. et Canada)
Tél. : (418) 683-5498
Téléc. : (418) 683-2170

EXFO Europe
Le Dynasteur
10/12, rue Andras Beck
92190 Meudon la Forêt Cedex
FRANCE

Tél. : +33.1.40.83.85.85
Téléc. : +33.1.40.83.04.42
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23 Garantie
Information générale

EXFO Ingénierie électro-optique inc. (EXFO) garantit cet appareil contre 
tout défaut de fabrication et de main-d’oeuvre pendant 12 mois à partir de 
la date d’expédition initiale. EXFO garantit également que cet appareil, 
utilisé de façon normale, sera conforme aux spécifications applicables.

Dans le cas où un produit s’avérerait défectueux au cours de la période 
couverte par la garantie, EXFO procédera, selon son appréciation, à la 
réparation ou au remplacement de l’appareil ou émettra un crédit 
équivalent. La garantie couvre également, au cours des deux premières 
années, le réétalonnage de l’appareil s’il doit être réparé ou si l’étalonnage 
original est erroné.

IMPORTANT
La garantie peut être déclarée nulle et non avenue si :

➤ l’appareil a été modifié, réparé ou utilisé par une personne non 
autorisée ou non formée par EXFO,

➤ l’étiquette de garantie a été enlevée,

➤ les vis du boîtier ont été enlevées de façon non conforme aux 
procédures décrites dans le présent manuel,

➤ le boîtier de l’appareil a été ouvert de façon non conforme aux 
procédures décrites dans le présent manuel,

➤ le numéro de série de l’appareil a été modifié, effacé ou enlevé,

➤ l’appareil a fait l’objet d’un mauvais usage ou de négligence ou a été 
endommagé accidentellement.

CETTE GARANTIE ANNULE ET REMPLACE TOUTE AUTRE GARANTIE 
EXPLICITE, IMPLICITE OU STATUTAIRE, INCLUANT NOTAMMENT LES 
GARANTIES IMPLICITES DE QUALITÉ ET D’ADAPTATION À UN USAGE 
PARTICULIER. EN AUCUN CAS EXFO NE POURRAIT ÊTRE TENUE POUR 
RESPONSABLE DE DOMMAGES DÉTERMINÉS, INDIRECTS 
OU CONSÉCUTIFS.
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Responsabilité
EXFO n’est pas responsable des dommages résultant de l’utilisation de cet 
appareil. Par ailleurs, EXFO n’assume aucune responsabilité en cas de 
diminution des performances d’autres appareils auxquels l’appareil acheté 
est branché ou en cas de modification du fonctionnement d’un système ou 
d’éléments d’un système dont l’appareil acheté fait partie.

EXFO n’est pas responsable des dommages résultant d’un mauvais usage 
ou d’une modification non autorisée sur l’appareil, les accessoires qui 
l’accompagnent et le logiciel.

Exclusions
EXFO se réserve le droit de modifier en tout temps la conception ou la 
fabrication de n’importe lequel de ses produits sans obligation d’effectuer 
les modifications sur les appareils déjà vendus. Les accessoires, incluant 
notamment les fusibles, les voyants et les piles, utilisés avec les produits 
d’EXFO, ne sont pas couverts par la garantie.

Certification
EXFO certifie qu’au moment de quitter l’usine, cet appareil était conforme 
aux spécifications applicables.

Entretien et réparation
EXFO s’engage à effectuer l’entretien et la réparation de ses produits 
durant une période de cinq ans à partir de la date d’achat. Pour l’entretien 
ou la réparation d’un appareil, suivre les étapes décrites ci-dessous :

1. Communiquer avec le groupe de soutien technique d’EXFO. Un 
préposé pourra déterminer si l’appareil requiert un entretien, une 
réparation ou un étalonnage.
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2. Si l’appareil doit être retourné à EXFO ou à un centre de service 
autorisé, le préposé d’EXFO attribuera un numéro d’autorisation de 
retour (RMA) et indiquera l’adresse appropriée.

IMPORTANT
Ne jamais retourner un appareil ou un accessoire à EXFO sans numéro 
d’autorisation de retour (RMA).

3. Si l’appareil contient une unité de stockage interne, faire une copie des 
données avant de le retourner à l’usine.

4. Remettre l’appareil dans son emballage d’origine. S’assurer d’inclure 
un rapport décrivant l’état de l’appareil, le problème observé et les 
circonstances dans lesquelles il est apparu.

5. Retourner l’appareil, port payé, à l’adresse communiquée par le 
préposé d’EXFO. S’assurer d’inscrire le RMA sur le bordereau 
d’expédition. EXFO refusera et retournera tout envoi sur lequel 
n’apparaîtra pas de RMA.

Nota : Des frais seront imputés aux tests de tout appareil retourné s’ils 
démontrent que l’appareil est conforme aux spécifications applicables.

Après réparation, l’appareil sera retourné, accompagné d’un rapport de 
réparation. Si l’appareil n’est plus couvert par la garantie, le montant 
indiqué sur ce rapport sera facturé au client. Au cours de la période 
couverte par la garantie, EXFO paie les frais de retour de l’appareil au 
client. Par contre, il est du ressort du client d’assurer l’appareil contre tout 
dommage éventuel au cours de l’expédition.
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A Description des types 
d’événements OTDR
Introduction

Cette section décrit les types d’événements qui peuvent se présenter 
durant une acquisition de réflectométrie. Ces types d’événements sont 
également utilisés dans le logiciel FiberVisor Console pour localiser les 
événements sur un réseau de fibres.

Les éléments se présentent comme suit :

➤ Un numéro et un symbole sont assignés à chaque type d’événement. 
Ces indications se trouvent dans le titre de chaque événement. Le 
symbole apparaît sur le plan linéaire dans FiberVisor.

➤ Chaque graphique fournit un exemple de la trace où la puissance 
rétrodiffusée vers la source est démontrée en fonction de la distance.

➤ Une flèche pointe vers l’endroit où se situe l’événement sur la trace.

➤ La plupart des graphiques illustrent une trace entière, soit une plage 
d’acquisition complète. Par contre, certains graphiques affichent 
seulement une portion de la plage afin de permettre de visualiser de 
plus près des événements spécifiques.
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Fibre continue 

➤ Cet événement indique que la plage d’acquisition sélectionnée était 
plus courte que la longueur de la fibre.

➤ L’analyse de la fibre s’est terminée avant d’atteindre la fin de la fibre et, 
par conséquent, la fin de la fibre n’a pas été détectée.

➤ Pour résoudre ce problème, il faut configurer la portée du test à une 
valeur supérieure à la longueur de la fibre.

➤ Aucune perte ni aucune réflectance ne sont spécifiées pour les 
événements de type fibre continue.
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Fin de l’analyse  [2]

➤ La durée d’impulsion du test n’a pas produit une plage de mesure 
assez longue pour atteindre la fin de la fibre.

➤ L’analyse de la trace s’est terminée avant d’atteindre la fin de la fibre, 
car le rapport signal sur bruit était trop bas.

➤ Pour résoudre ce problème, il faut augmenter la durée d’impulsion du 
test, de façon à injecter assez d’énergie pour atteindre la fin de la fibre.

➤ Aucune perte ni aucune réflectance ne sont spécifiées pour les 
événements de type fin de l’analyse. 
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Bout non réfléchissant  [3]

➤ Un bout non réfléchissant peut signifier que la fibre est écrasée, cassée 
ou éraflée. Cet événement peut également signifier que la fibre se 
termine dans une substance adaptatrice d’indice ou par un connecteur 
de type FC/PC. Une substance adaptatrice d’indice ou un connecteur 
de type FC/PC possède un indice de réfraction proche de celui du 
coeur de la fibre, ce qui réduit la réflexion de Fresnel au minimum.

➤ La fin de la fibre apparaît habituellement comme une dépression 
brusque, ce qui indique une perte considérablement plus grande que 
l’atténuation normale du signal dans la fibre.

➤ Cette dépression brusque est souvent suivie par des pics de bruit de 
faible intensité.

➤ Aucune perte ni aucune réflectance ne sont spécifiées pour les 
événements de type bout non réfléchissant.
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Défaut non réfléchissant  [4]

➤ Un défaut non réfléchissant provoque une diminution soudaine de la 
diffusion de Rayleigh et apparaît comme une discontinuité dans la 
pente régulière descendante et linéaire du signal de la trace.

➤ Ce défaut est souvent causé par une épissure, une macrocourbure ou 
une microcourbure dans la fibre.

➤ Une perte de valeur est affichée pour les événements de type défaut 
non réfléchissant. Cependant, aucune réflectance n’est spécifiée pour 
ce type d’événement.
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Bout réfléchissant  [5]

➤ Un bout réfléchissant indique une discontinuité de l’indice de 
réfraction, normalement causée par l’interface verre/air à l’extrémité 
de la fibre.

➤ Cet événement apparaît habituellement comme un pic suivi d’une 
dépression brusque, ce qui indique une perte considérablement plus 
grande que l’atténuation normale du signal dans la fibre. Cette 
dépression brusque est souvent suivie par des pics de bruit de 
faible intensité.

➤ Une valeur de réflectance est attribuée pour les événements de type 
bout réfléchissant. Cependant, aucune perte n’est spécifiée pour ce 
type d’événement.
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Défaut réfléchissant  [6]

➤ Les défauts réfléchissants apparaissent comme un pic sur la trace.

➤ Ils sont causés par une discontinuité abrupte dans l’indice 
de réfraction.

➤ Les défauts réfléchissants produisent une réflexion vers la source 
d’une portion de l’énergie initialement injectée dans la fibre.

➤ Ils peuvent indiquer la présence d’un connecteur, d’une épissure 
mécanique ou d’une épissure par fusion de mauvaise qualité.

➤ La valeur de la perte et celle de la réflectance sont habituellement 
spécifiées pour les événements de type défaut réfléchissant.

➤ Lorsque le pic de réflexion atteint le niveau maximal, le détecteur 
devient saturé, ce qui provoque l’écrêtage du signal. Par conséquent, la 
zone morte ou la distance minimale peut être augmentée afin de 
prendre une mesure de détection ou d’atténuation entre cet 
événement et un autre situé tout près. 
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Défaut positif  [8]

➤ Un défaut indique une épissure qui produit un gain apparent 
normalement causé par la jonction de deux fibres dont le coefficient 
de diffusion de Rayleigh est différent.

➤ Une valeur de perte est spécifiée pour les événements de type défaut 
positif. Cette valeur ne correspond pas à la perte réellement causée 
par cet événement.

➤ La perte réelle peut être mesurée en effectuant une analyse de la 
trace bidirectionnelle.
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Niveau d’injection  [11]

➤ Le niveau d’injection indique la puissance du signal injecté dans 
la fibre.

➤ Le graphique ci-dessus démontre comment le niveau d’injection 
est mesuré.

➤ Une droite est tracée à partir des points de la région linéaire comprise 
entre le premier et le deuxième événement détectés, selon la 
méthode d’approximation par les moindres carrés.

➤ La droite est projetée vers l’axe vertical (dB) jusqu’à ce qu’elle le 
croise. Le point où la droite croise l’ordonnée indique le 
niveau d’injection.

➤ Le symbole  dans le tableau des événements indique que le 
niveau d’injection est trop bas.

➤ Dans le graphique ci-dessus, le nombre 24.68 représenterait le niveau 
d’injection inscrit dans le tableau des événements.
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Section de fibre  [12]

➤ Une section de fibre est une région sans événement. 

➤ La somme de toutes les sections de fibre d’une trace entière est égale 
à la longueur totale de la fibre. Les défauts détectés sont des 
événements spécifiques, même s’ils couvrent plus d’un point sur 
la trace. 

➤ Une valeur de perte est spécifiée pour les événements de type section 
de fibre. Cependant, aucune réflectance n’est spécifiée pour ce 
type d’événement.

➤ L’atténuation (dB/distance) est obtenue en divisant la perte par la 
longueur de la fibre.
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Défaut non réfléchissant fusionné  [22]

➤ Ce défaut indique un événement non réfléchissant combiné à un ou à 
plusieurs autres événements.

➤ Dans l’exemple ci-dessus, l’événement non réfléchissant est fusionné 
avec l’événement réfléchissant qui le précède. 

➤ Un événement non réfléchissant est souvent causé par une épissure, 
une macrocourbure ou une microcourbure dans la fibre.

➤ Aucune perte ni aucune réflectance ne sont spécifiées pour les 
événements de type défaut non réfléchissant fusionné.

➤ Cependant, les événements fusionnés sont suivis d’un événement de 
type total qui indique la perte totale causée par ces événements. 
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Défaut réfléchissant fusionné  [21]

➤ Ce défaut indique un événement réfléchissant combiné à un ou 
à plusieurs autres événements.

➤ Dans la figure ci-dessus, l’événement réfléchissant est fusionné avec 
un autre événement réfléchissant qui le suit.

➤ Les défauts réfléchissants peuvent indiquer la présence d’un 
connecteur, d’une épissure mécanique ou d’une épissure par fusion 
de mauvaise qualité.

➤ Une valeur de la réflectance est spécifiée pour les événements de type 
défaut réfléchissant fusionné. Cependant, aucune perte n’est spécifiée 
pour ce type d’événement.

➤ Les événements fusionnés sont suivis d’un événement de type total qui 
indique la perte totale causée par ces événements.
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Défaut positif fusionné  [16]

➤ Ce défaut indique un événement positif combiné à un ou à plusieurs 
autres événements.

➤ Dans la figure ci-dessus, l’événement positif est fusionné avec 
l’événement réfléchissant qui le précède.

➤ Ce défaut indique une épissure qui produit un gain apparent, 
normalement causé par la jonction de deux fibres dont le coefficient 
de diffusion de Rayleigh diffère.

➤ Aucune perte ni aucune réflectance ne sont spécifiées pour les 
événements de type défaut positif fusionné. Les événements fusionnés 
sont suivis d’un événement de type total, qui indique la perte totale 
causée par ces événements.
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Bout réfléchissant fusionné  [27]

➤ Ce défaut indique un bout réfléchissant combiné à un ou à plusieurs 
autres événements.

➤ Un bout réfléchissant indique une discontinuité de l’indice de 
réfraction, normalement causée par l’interface verre/air à l’extrémité 
de la fibre.

➤ Il apparaît habituellement comme un pic suivi d’une dépression 
brusque, ce qui indique une perte considérablement plus grande que 
l’atténuation normale du signal de la fibre. Cette dépression brusque 
est souvent suivie par des pics de bruit de faible intensité.

➤ La valeur de la réflectance est spécifiée pour les événements de type 
bout réfléchissant fusionné.

➤ Puisque la perte à la fin d’une fibre ne peut pas être déterminée, les 
événements qui incluent un bout réfléchissant fusionné ne sont pas 
additionnés à la perte cumulative et, par conséquent, ils ne sont pas 
suivis d’un événement de type total.
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Bout non réfléchissant fusionné  [28]

➤ Ce défaut indique un bout non réfléchissant combiné à un ou à 
plusieurs autres événements.

➤ Un bout non réfléchissant peut indiquer que la fibre est écrasée, 
cassée ou éraflée. Il peut également indiquer que la fibre se termine 
dans une substance adaptatrice d’indice ou par un connecteur de type 
FC/PC. Une substance adaptatrice d’indice ou un connecteur de type 
FC/PC possèdent un indice de réfraction proche de celui du coeur de 
la fibre, ce qui réduit la réflexion de Fresnel au minimum.

➤ Aucune perte ni aucune réflectance ne sont spécifiées pour les 
événements de type bout non réfléchissant fusionné. 

➤ Puisque la perte à la fin d’une fibre ne peut pas être déterminée, les 
événements fusionnés qui incluent un bout non réfléchissant fusionné 
ne sont pas additionnés et, par conséquent, ne sont pas non plus suivis 
d’un événement de type total.
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Total  [13]

➤ Un événement de type total indique la perte totale produite par les 
événements fusionnés qui précèdent.

➤ Dans la figure ci-dessus, deux événements sont fusionnés : un défaut 
réfléchissant et un défaut non réfléchissant.

➤ La perte totale (∆ dB) produite par ces événements est mesurée à 
partir de deux droites tracées.

➤ La première droite est tracée en plaçant, selon la méthode 
d’approximation par les moindres carrés, tous les points dans la région 
linéaire précédant le premier événement.

➤ La deuxième droite est tracée en plaçant, selon la méthode 
d’approximation par les moindres carrés, tous les points dans la région 
linéaire précédant le deuxième événement. S’il y avait plus de deux 
événements fusionnés, cette droite serait tracée dans la région linéaire 
suivant le dernier événement fusionné puis projetée vers le premier 
événement fusionné.

➤ La perte totale (∆ dB) égale la différence de puissance entre le point 
de départ du premier événement (point A) et le point de la droite situé 
juste au-dessous du premier événement (point B).
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Écho  [29]

➤ Un écho indique qu’un événement réfléchissant a été détecté après la 
fin de la fibre.

➤ Le signal injecté se rend jusqu’à la fin du connecteur et est réfléchi 
vers le réflectomètre. Puis, il atteint le deuxième connecteur et est 
réfléchi de nouveau vers le connecteur final pour être ensuite réfléchi 
vers le réflectomètre.

➤ ToolBox interprète cette nouvelle réflexion comme un écho parce que 
la distance est plus longue que le total de la longueur de la fibre.

➤ La distance entre la réflexion du deuxième connecteur et la réflexion 
du connecteur final équivaut à la distance entre la réflexion du 
connecteur final et de l’écho.

➤ Aucune perte ni réflectance ne sont spécifiées pour ce 
type d’événement.
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Bout réfléchissant (écho possible)  [30]

➤ Cet événement indique un bout de fibre réfléchissant. Toutefois, ce 
bout de fibre peut ne pas être réfléchi puisque la réflexion pourrait être 
un écho produit par une réflexion plus grande située plus près de 
la source.

➤ Dans l’exemple ci-dessus, la distance jusqu’au bout de la fibre est deux 
fois celle de la réflexion du deuxième connecteur.

➤ Le signal injecté dans la fibre est réfléchi de façon à parcourir deux fois 
l’aller-retour entre le réflectomètre et le deuxième connecteur.

➤ ToolBox interpréterait cette deuxième réflexion comme un événement 
réfléchissant situé à deux fois la distance du deuxième connecteur, 
c’est-à-dire au bout de la fibre. Ainsi, le bout pourrait ne pas être 
réfléchi puisqu’il pourrait être un écho.

➤ Une valeur de réflectance est spécifiée pour les événements de type 
bout réfléchissant (écho possible). Cependant, aucune perte n’est 
spécifiée pour ce type d’événement.
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Défaut réfléchissant (écho possible)  [31]

➤ Cet événement indique un événement réfléchissant qui peut être 
produit par une vraie réflexion ou par un écho créé par une autre 
réflexion plus forte située plus près de la source.

➤ Le signal injecté dans la fibre est réfléchi de façon à parcourir deux fois 
l’aller-retour entre le réflectomètre et le troisième connecteur.

➤ Ainsi, ToolBox détecterait un événement réfléchissant situé à deux fois 
la distance du troisième connecteur. Puisque cet événement est 
presque nul (aucune perte) et que sa distance est deux fois celle de la 
distance du troisième connecteur, ToolBox l’interpréterait comme 
un écho.

➤ Une valeur de la réflectance est spécifiée pour les événements de type 
défaut réfléchissant (écho possible).
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Défaut réfléchissant fusionné 
(écho possible) [32]

➤ Ce défaut indique un événement réfléchissant, combiné à un ou 
à plusieurs autres événements, et qui peut être produit, soit par une 
vraie réflexion, soit par une autre source de réflexion plus forte située 
plus près de la source.

➤ Le signal injecté dans la fibre est réfléchi de façon à parcourir deux fois 
l’aller-retour entre le réflectomètre et le deuxième connecteur.

➤ Ainsi, ToolBox détecterait un événement réfléchissant situé à deux fois 
la distance du deuxième connecteur et l’interpréterait comme un 
écho possible.

➤ Une valeur de la réflectance est spécifiée pour les événements de type 
défaut réfléchissant fusionné (écho possible). Cependant, aucune 
perte n’est spécifiée pour ce type d’événement. Cette perte est 
habituellement incluse dans l’événement suivant de type total.
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Bout réfléchissant fusionné (écho possible)  
[33]

➤ Cet événement indique un bout réfléchissant, combiné à un ou 
à plusieurs autres événements, et qui peut être produit, soit par une 
vraie réflexion, soit par une autre source de réflexion située plus près 
de la source.

➤ Le bout de la fibre sous test est situé à deux fois la distance de la 
réflexion du deuxième connecteur.

➤ Dans l’exemple ci-dessus, le signal injecté est réfléchi de façon à 
parcourir deux fois l’aller-retour entre le réflectomètre et le 
deuxième connecteur.

➤ ToolBox interprète la deuxième réflexion comme un événement 
réfléchissant situé à deux fois la distance du deuxième connecteur, 
soit le bout de la fibre. Pour cette raison, le bout réfléchissant pourrait 
ne pas être réfléchi et être en fait un écho.

➤ La valeur de la réflectance est indiquée pour les événements de bout 
réfléchissant fusionné (écho possible). Cependant, aucune perte n’est 
spécifiée pour ce type d’événement.
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